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1 System Description 

1.1 System Components 

The SETPOINT® system consists of these components: 

• VC-8000 rack with eSAM, UMM-CM and TMM-CM Modules 
○ Configured via VC-8000 Setup software 

 
• VCM-3 condition monitoring unit 

○ Configured via VCM-3 Editor software 
 

• BKV Collect wireless sensors connected via BKV Connect gateway 
○ Configured via BKV Beyond service 

 
• SETPOINT® CMS software, display application described in detail in this manual 
• SETPOINT® Connector software, monitoring device to PI rack interface (or SD/ PC-XC card) 

 
• PI AF Server (2012 with SP2 or later) and PI AF SQL Database (SQL EXPRESS or higher) 
• PI AF Client (2012 with SP2 or later), for the hierarchy 
• PI Server (2012 or later), for archiving data (static and dynamic) 
• PI Vision (Optional), for visualization 

 
Figure 1 shows the system components. Computers may be combined as discussed in Section 2 
depending on the number of assets and dynamic points. 

 
Figure 1:  System Components 
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1.1.1 VC-8000 

The VC-8000 is an API 670 machinery protection system that also incorporates high speed data 
acquisition for fast trending and collection of dynamic waveform data (time signals of vibration). The 
VC-8000 was designed so that the high bandwidth condition monitoring data is separated from the 
critical protection data. Referring to Figure 2, note these design concepts: 

1. A separate alarm logic bus prevents condition monitoring data from affecting inter-module 
alarm voting. 

2. A separate condition monitoring network separates high bandwidth condition monitoring 
information from other protection system access data. 

3. A proprietary network separates the protection system processor from the display and condition 
monitoring system processor. This protocol does not allow changes to critical machine 
protection parameters from the display or condition monitoring system. 

4. A separate Ethernet port connects the condition monitoring data server to the VC-8000 rack so 
that the high bandwidth condition monitoring data is separated from the critical protection data 
network. 

 

Alarm Logic Bus

UMMCM or TMMCM UMMCM or TMMCM

System Access Module 
Processor

UMMCM or TMMCM

Display and Condition 
Monitoring Data Module

System Access Module 
(SAM)

CMS (DAC) Ethernet Port

DCS  Port (Modbus)

Protection Network

Controller

PI Server
Proprietary 
Internal Protocol

Condition Monitoring Network

 
Figure 2:  SETPOINT® Separation of Protection and Management 
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1.1.2 VCM-3 

The VCM-3 is the cost effective 12 channel data acquisition hub targeted at monitoring of auxiliary 
machines, balance-of-plant (BOP) machines and less critical assets as part of enterprise Industry 4.0 
digitization efforts. Multiple VCM-3 monitors can be connected to your network with wired technology, 
providing the next generation of asset condition monitoring without batteries or spotty occasional 
monitoring provided by route based or multiplexed systems. 

1.1.3 BKV Collect Wireless Sensors via BKV Connect Gateway 

BKV Collect is a wireless battery-operated sensor for condition monitoring and predictive 
maintenance. It measures tri-axial vibration and surface temperature of rotating equipment, such as 
pumps, motors and compressors. Abnormal machine vibrations or high temperatures may give early 
signs of failure due component imbalance, misalignment, wear or improper use of equipment. 

Once BKV Collect is switched on, it starts automatically to measure and transmit data at  
pre-configured intervals. Depending on the configuration, BKV Collect sensors can send raw vibration 
data (waveforms) and pre-calculated values, such as RMS velocity, RMS acceleration and crest 
factor. 

BKV Collect sensors operate in a mesh network and transmit sensor data to a BKV Connect gateway. 
When there is a need for high density of connected devices, a mesh network is the perfect solution for 
connectivity. In a mesh network, devices transmit their own sensor data and act as a relay for other 
devices. Relays provide the best and most efficient communication path to a gateway. 

Using SETPOINT® Connector, BKV Connect gateways connect a mesh network of a few to several 
dozens of wireless devices to a backend such as AVEVA PI. BKV Connect can be connected over a 
wired Ethernet connection or wirelessly over a Wi-Fi connection. 

For more information, please refer to BKV Wireless Sensor Solution instructions (C108377). 

1.1.4 AVEVA™ PI System Components 

SETPOINT® CMS is based on the AVEVA™ PI System™ platform, often used in the industry for 
process data management. Brüel & Kjær Vibro has developed methods with AVEVA™ for storing 
waveform data into the PI Server database and for presenting standard machinery diagnostic plots for 
viewing and analyzing dynamic waveforms and transient data (such as orbit, spectrum...). This 
section contains a brief overview of the AVEVA™ PI System™ components. For more detail, refer to 
the AVEVA™ website (https://www.aveva.com/en/products/aveva-pi-system/). 

PI Asset Framework Server 
PI Asset Framework™ (PI AF) lets you define a consistent representation of your assets and provide 
a structure for your information. SETPOINT® CMS uses PI AF Server to assign VC-8000 
measurement points to your plant processes and machine trains. PI AF Server is included with  
PI Server 2012 and later and does not need to be purchased separately. 

PI Server 
PI Server is the real-time data collection, archiving and distribution engine that powers the PI System. 
Brüel & Kjær Vibro and AVEVA™ have developed interfaces for storing dynamic waveforms and 
transient machine condition data on the PI Server along with the standard process data. 

https://www.aveva.com/en/products/aveva-pi-system/
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PI Vision 
PI Vision is a web-client visualization tool for the PI System that provides secure access to PI System 
data. PI Vision can provide displays while also supporting mobile browsers and customized views for 
small screen devices. 

1.1.5 SETPOINT® Connector 

The SETPOINT® Connector is a software service that interfaces between the VC-8000 rack and the 
PI servers. The computer running the SETPOINT® Connector must also have the AVEVA™ PI AF 
Client application installed. 

 

 

NOTE! 
This component was called “Setpoint PI Adapter” in older SETPOINT® releases  
(CMS 2022 R3 and earlier). 

1.1.6 SETPOINT® CMS 

SETPOINT® CMS is a display package that processes and presents the machinery data stored in the 
PI System database in standard machinery diagnostic plots such as trends, spectra, orbits, vector 
diagrams, as well as lists of events, pages, etc.... accessible on a page customizable according to the 
expert's wishes. The data remains stored in the PI server (or in an SD card, PC-XC), the CMS 
SETPOINT® application is only a customizable drive that only stores views and their settings. An 
analogy can be made with print file readers, "reader" regardless of the original document; CMS 
SETPOINT® presents the stored CMS data in a standard format as defined in the vibration analysis 
standards and guides. The expert will be able to obtain and display the desired combination and 
correlation of data as desired, print them, or export them to a file that can be shared with other 
colleagues or higher levels for more advanced analysis. 

The computer running SETPOINT® CMS must also have the AVEVA™ PI AF Client application 
installed. 
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1.1.7 Types of Data 

VC-8000, VCM-3 and BKV Collect send several different types of data that are stored in the  
PI System database (or in an SD/HD card, PC-XC). The software uses the various data types when 
creating the plot types as shown in Table 1. 

 
Table 1:  Data Types 

Data Type Description Plot Using 

Static Processed and filtered values Trend, Shaft Centerline 

Vector Data Amplitude and Phase vector measurement at a 
specified multiple of running speed. Requires a Phase 
Trigger assignment. 

Bode, Polar, Filtered Orbit and 
Timebase 

Synchronously 
Sampled Waveforms 

Data samples are collected in evenly spaced phase 
increments according to the current running speed. 
Requires a Phase Trigger assignment. Requires the 
assignment of a phase reference. 

Orbit, Timebase, Spectrum, 
Cascade, and Waterfall (in 
Orders) 

Asynchronously 
Sampled Waveforms 

Data samples are collected at a set sample rate. Asynchronous Orbit, 
Timebase, Spectrum, 
Cascade, and Waterfall 

Speed Information on the relationship between the speed 
pulses and the synchronous waveform. 

Orbit, Timebase, Spectrum in 
Orders 

Status Alarm and OK status for each channel and 
measurement. Alarm List 
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1.1.8 Compression Algorithm 

Static data 
Static (trend/scalar) data is processed in the rack to produced derived values such as tracking filters 
and band pass measurements.  It goes through three stages of compression before it is put in a PI 
archive: 

• Signal Processing 
The firmware does the signal processing by filtering out non-machinery related data and 
deriving values (such as peak to peak amplitude).  Every 80 ms samples are published.  

• Exception Deviation 
The SETPOINT® Connector receives 80 ms data from a VC-8000 and only publishes it to the 
PI System if it has exceeded the exception deviation (also called dead band filtering) of the 
last published sample. Exception deviation is the amplitude difference between two 
samples.  When the difference exceeds the predetermined threshold, the value is sent to 
PI.  Alternatively, if the maximum time between published values has expired the sample will 
also be forwarded.  Exception deviation is intended to filter out noise and reduce network 
traffic. Each channel type uses different exception deviation values adapted to the task. 
 
When in a transient state (when speed is between the configured low and hi trigger values) 
exception deviation is changed to ¼ of the configured limits and PI compression is bypassed 
(all values exceeding the exception deviation are recorded). 
 
Exception deviation values can be viewed and edited using PI System Management Tools.  

• PI Compression (Swinging Door) 
The PI System receives the data and performs a swinging door compression algorithm to 
manage data storage. This algorithm draws a line going through the last two collected points 
and make a cone coming off the line based on the configured compression value. This value is 
stored if it exceeds the limits of the cone.  When this happens, the value exceeding the limit, 
and the value preceding it are stored into the archive.  All other samples between the stored 
values are thrown out because they are accurately represented by the stored values.  
 
(This tutorial helps visualize how exception deviation and swinging door compression 
algorithms work: https://www.youtube.com/watch?v=6-scv3oQ7Kk&feature=youtu.be) 

  

https://www.youtube.com/watch?v=6-scv3oQ7Kk&feature=youtu.be
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Dynamic data 
Dynamic data is time-based waveform data. It is sampled at a significantly higher rate to enable root 
cause analysis of machinery faults. 

There are several methods for collecting waveforms. These are processed in a chain of responsibility 
if one method is active it trumps the methods that follow. 

• Boost Mode allows contiguous waveform collection between a low and high trigger speed. 
It is designed to capture fast startups where other methods may not provide enough data.  
If boost mode is enabled and the speed is between the configured low and high speed triggers 
and the speed is changing the UMM will collect all the raw data. 

• If the speed stops changing while still in the transient range the UMM will exit boost mode until 
speed begins changing again. 

• If the buffer in the UMM fills up it will exit boost mode and resume normal collection until a 
certain percent of the buffer empties out.  Each UMM channel has roughly a buffer that can 
hold up to 2 minutes of contiguous waveform data before exiting boost mode. 

 

 

NOTE! 
Boost collection can be triggered manually from the MPS Maintenance software. 
 

 
• I-Factor 

The i-factor of a waveform is computed using multiple attributes. For a typical radial vibration 
channel with a phase trigger present, these attributes can include: 

○ Overall amplitude 
○ Amplitude of 2 user-defined bandpass regions 
○ Bias (gap) voltage 
○ Machine speed (i.e., phase trigger period) 
○ 1X, 2X, and nX filtered amplitudes 

 
When a change in any of these attributes exceeds a threshold, it triggers waveform storage. During a 
given interval, if more than one waveform has an i-factor above this threshold, the waveform with the 
largest i-factor will be saved.  Thresholds can be manually configured or computed where it is 
adjusted automatically to collect one waveform per period on average. 

• Delta RPM 
If the speed input changes more than the configured delta RPM a waveform will be published. 

• Periodic Collection 
If no waveforms have been found interesting for a configured period of time the most 
interesting waveform will be published. 

• Grouped waveform collection 
If one channel publishes a waveform then all other channels in the group also publish a 
waveform. 

Dynamic data has no exception deviation or PI compression applied. If a waveform is published from 
the rack it is stored in the PI System. 
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1.2 Operation without Connection to a PI System 

Setpoint® CMS also offers several options for collecting and viewing condition monitoring data when a 
network connection to a PI System is not available. All vibration data is still available, but these 
solutions lack the more advanced PI System features. However, you can import data from 
SETPOINT® SD, XC, or HD into a PI System to provide a highly flexible combination of on-line, 
networked condition monitoring and off-line, remote data collection. 

These solutions are useful when: 

• Network connections are unavailable 
• The machines are located where installing and maintaining server computers is not practical. 
• Event data is sent to remote experts for analysis 
• Only SETPOINT® System data is required (no PI system data correlation is needed) 

 

Refer to the sections in this manual dedicated to each of these solutions for more information. 

 
Table 2:  SETPOINT® Offline Solutions for VC-8000 

SETPOINT® System Description 

SD SD card data storage in the VC-8000. The system stores condition monitoring 
data on an SD card installed in the eSAM. Remove the card and view the 
data with SETPOINT® CMS. SETPOINT® SD is limited by the maximum SD 
card capacity of 32 GB. 

XC The SETPOINT® Connector service stores condition monitoring data in a 
folder on a PC networked to the rack. SETPOINT® XC can store larger 
amounts of data limited only by the available storage drive capacity. 

HD The eSAM stores condition monitoring data on an internal solid-state drive 
available in various sizes. View the data using SETPOINT® CMS software 
networked to the rack. 
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1.3 For more Information 

Download datasheets and other SETPOINT® information at 
https://www.bkvibro.com/en/products/setpoint-condition-monitoring-software.html. 
 

Document No. Title 
S1079330 VC-8000 Operation and Maintenance Manual Document 
S1342998 VC-8000 Reciprocating Machine Addendum Document 
S1160865 VC-8000 Hazardous Installation Manual 
S1472326 VC-8000 Calibration Interval Application Note 
S1354794 VC-8000 Functional Safety Assessment 
C107762 VCM-3 Editor Installation Manual 
C107760 VCM-3 Homepage Manual 
C108377 BKV Wireless Sensor Solution instructions 
C108376 BKV Connect 1 & 2 / BKV Collect 6 & 6 Ex Quickstart Guide 

 

Get more information on the PI System at https://www.aveva.com/. 

http://www.setpointvibration.com/
https://www.aveva.com/
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2 Planning Your System 

There are several different implementations for the SETPOINT® CMS system. Each will be discussed 
in this section: 

• Implementing a small system (< 300 Points of dynamic vibration channels). 
• Implementing a large system (> 300 Points) 
• Time Synchronization 
• Protection from Network Failures 

You can implement your SETPOINT® CMS System as part of an existing PI System or as a separate 
system. 

2.1 Small Systems 

For small systems, either a small AVEVA™ PI System (< 300 Points of dynamic vibration channels) 
or a standalone SETPOINT CMS-XC system can be used (< 100 Points of dynamic vibration 
channels). Please refer to the chapter on SETPOINT CMS-XC for more information about this topic. 

You can install all AVEVA™ PI System software components and the SETPOINT® CMS software on 
a single stand-alone computer. Refer to the PI Asset Framework Installation and Upgrade Guide for 
installation information. The SETPOINT® CMS dynamic data collection creates data much faster than 
for standard process points, so the number of dynamic data points is much lower than the number of 
standard process points that AVEVA™ specifies. Brüel & Kjær Vibro recommends a computer with a 
minimum of: 

• Windows 10, Windows 11, Windows Server 2019 or Windows Server 2022 
• .NET Framework, Version v4.8 or higher 
• Use SQL Server Express edition 2012 or higher 
• 16 GB RAM 
• 1 TB storage 
• 8 processor cores (12 recommended) 

Limit the total dynamic channel count to 300 channels or less. A dynamic channel is any channel that 
collects synchronous or asynchronous waveforms as listed in Table 1. 

2.2 Using an Existing PI Server 

If you are already using an AVEVA™ PI System, you can use your existing PI Server provided that: 

• You have PI Server version 2012 or later. 
• PI Asset Framework 2012 SP2 or later. 
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2.3 Large Systems 

For systems with more than 10,000 assets, and moderate-to-high workloads and point counts, 
AVEVA™ recommends that you:  

• Install Microsoft SQL Server on a separate computer from PI Server.  
• Install PI AF server on either the PI Server or SQL Server computer.  
• Use Microsoft SQL Server Standard or Enterprise edition instead of Express edition.  

For best performance and improved security, AVEVA™ recommends that you install SQL Server on a 
different computer from PI Server. AVEVA™ also recommends at least two physical drives on the PI 
Server computer. 

2.4 Other Installation Deployments 

The PI Asset Framework Installation and Upgrade Guide discuss other installation deployments 
including high availability designs.  

2.5 CMS Display Computer 

When running the CMS Display application on a separate computer from the servers, the computer 
should have at least 8 GB RAM and a 5th Generation Core Intel processor or equivalent.  

You also can run the CMS Display on the server computer and connect remotely. Your server will 
need a graphics card supporting Shader Model 3 and Direct X 9 to support CMS graphics. 

2.6 Uninterruptable Power Supply (UPS) 

Your PI Server must be installed with a UPS wired for graceful shutdown in the event of a main power 
loss. An unexpected loss of power can prevent the server from restarting normally when power is 
restored, resulting in data loss. 

 

 

APPLICATION ALERT! 
Unexpected loss of server power can result in loss of data. Use an uninterruptable  
power supply configured to gracefully shut down the server on power loss. 
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2.7 Time Synchronization 

SETPOINT® CMS will automatically synchronize the VC-8000 rack system time with the PI Server 
computer time. These synchronization commands occur when the SETPOINT® Connector 
communication to the rack is started and once per day after that. Synchronization is typically to within 
1 second. Alternatively, you can configure the VC-8000 rack for NTP time synchronization. Refer to 
the VC-8000 Operation and Maintenance Manual S1079330. NTP is capable of time synchronization 
to the millisecond level depending on the network architecture.  
Table 7 lists the network ports that the system uses for time synchronization. When configured for 
NTP, the VC-8000 rack will ignore time synchronization requests from the SETPOINT® Connector or 
other sources. 

2.8 Protection from Network Failures 

Referring to Figure 1 and Figure 2, the VC-8000 system has multiple levels of data buffering and 
storage to guard against data loss in the event of network interruption. 
 
Data storage can be volatile, where store information is lost on power failure or system reset, or non-
volatile where the information is stored on an SD card or Solid State Drive that will retain the data on 
a power failure or system reset. 
Table 3 lists where the data is buffered, what network interruptions are backed up, and the amount of 
data or time duration that the interruption can last before data loss. 
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Table 3: Network Data Buffering 

Buffering 
Location Description Amount 

UMM The UMM stores static and waveform data 
internally during periods of rapid machine 
changes or for protection against temporary 
communication interruption with the SAM such 
as during a SAM firmware upgrade or major 
configuration change.  Volatile 

3600 waveforms. Every 80 ms a measurement 
(static measurement data) is recorded. 
Quantity is across all channels but is not 
allocated per channel (e.g., an interesting 
channel to the I-Factor® can store more 
waveforms than non-interesting channels). 

SAM Internal data buffer used to hold data until it can 
be spooled to the PI System, XC, or the internal 
SD or HD. Provides protection against loss of 
data during short network interruptions between 
the rack and the SETPOINT® Connector or loss 
of data while changing the SD card. This module 
is available in two variants, bSAM is the "Basic" 
and eSAM the "enhanced" variant. The eSAM is 
required for condition monitoring.  Volatile. 

5 minutes typical waveform and static data 
storage. 

HD Internal solid-state drive (SSD) data storage. 
System can be configured to automatically 
backfill data from the HD to PI in the event of 
network interruption between the rack and the 
SETPOINT® Connector.  Non-Volatile. 

Depends on HD option purchased: 
32 GB, 256 GB. 

SD Data is stored on the SD card. Backfilling from 
the SD card is a manual process. SD is an 
alternative to the HD to provide protection 
against network interruption between the rack 
and SETPOINT® Connector. See Section 15.  
Non-Volatile. 

Depends on SD card size. 
Maximum is 32 GB. 

PI 
Buffering 

PI Buffering stores data in the case of 
communication loss between the SETPOINT® 
Connector and the PI Server. Recommended 
when the SETPOINT® Connector is located on a 
different computer than the PI Server. Non-
volatile for files other than the current file. 

Limited only by available space on the drive 
where the PI Buffering folder resides. 

 

 

NOTE! 
When the PI Server and SETPOINT® Connector are running on the same computer,  
PI Buffering provides no value and degrades performance. Turn off PI Buffering for this 
case. 

 

When the PI Server and SETPOINT® Connector are running on the same computer, turn off  
PI Buffering using the following instructions: 

Locate the PICLIENT.ini file. This should be located in the C:\Program Files\PIPC\dat folder 

Change the Buffering attribute value to “0” from the default value of “1”. 
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3 SETPOINT CMS Enabled Hardware 

3.1 UMMs and TMMs 

VC-8000 modules must be condition monitoring enabled in order to stream data (static and dynamic) 
to the SAM’s internal hard drive, SD card drive or PC-XC, and/or a connected AVEVA™ PI Server. 
Once the data has been stored to any of these mediums, it can be viewed with SETPOINT® CMS 
software. 

 

NOTE! 
This data stream includes both high-speed static data and dynamic (waveform) data 
and should not be confused with the low-speed static data provided to the DCS port(s) 
on the SAM. All modules provide data to the DCS NET (Ethernet) and (if present) DCS 
SER (serial) ports on the SAM. Refer to VC-8000 Operation & Maintenance Manual 
S1079330 for additional information on these DCS communication ports. 

 

CM-ENABLED modules can be identified by their front panel label and by using the VC-8000 
Maintenance software Hardware Info tab as shown in Figure 3 (Refer to VC-8000 Operation and 
Maintenance Manual, S1079330). Although it is permissible to have a rack with a mix of CM and non-
CM modules, only the CM-ENABLED UMMs and TMMs will be capable of providing any data 
(whether static or dynamic) for viewing in CMS software.  

 
Figure 3:  Identifying CM-Enabled Hardware 

If you are upgrading an existing rack to support CMS connectivity, UMM and TMM modules may be 
converted to CM-ENABLED versions in the field, without a hardware change (contact 
Brüel & Kjær Vibro Service).  

In addition to CM-ENABLED UMMs and TMMs, the rack must also have a CM-ENABLED eSAM. If 
the SAM is not CM-ENABLED, its CMS Ethernet port will be disabled, and no communications can 
occur. Nor will its SD Card slot or internal hard drive support CMS data. You cannot update a SAM to 
eSAM on site, you must return the module to the factory. 

 

NOTE! 
Even if your eSAM is CM-ENABLED, it must be using revision 3.0 firmware or higher. 
You can check your firmware revision using VC-8000 Maintenance software and apply 
newer firmware if applicable. Refer to VC-8000 Operation and Maintenance Manual 
S1079330 for additional information. 

The module is CM-Enabled 
if the CMS text is green.  
Otherwise, the module is 
not CM-Enabled. 
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3.2 Upgrading VC-8000 Hardware 

You can purchase CMS upgrades for existing hardware and install them locally or remotely. This 
section lists the basic steps to follow to obtain CMS enabler keys. 

Use the Hardware Info screen from the front panel or the VC-8000 Maintenance software: 

 
Figure 4:  Retrieving the Hardware Information 

*If the Supported Features column lists the feature but it is not green, the hardware is capable of 
supporting the feature, but it is not enabled. If the feature does not show up in the list, the hardware 
does not support the feature. 

The modules must also have the required firmware revision to support the features. Firmware 
upgrades are available at https://www.bkvibro.com/products/setpoint-machinery-protection-system-
vc-8000.html. 

UMMs and TMMs require firmware revision 3.0 or higher for CMS functions. The following table lists 
the required SAM and Front Panel firmware revision by function: 

 
Table 4:  SAM Firmware Revision for Function 

Function Required Firmware 
Revision 

CMS with PI-AF 3.0 or higher 
CMS SD 4.02 or higher 
CMS HD 5.0 or higher 
CMS XC 3.0 or higher 

 

Send the diagnostics file to Brüel & Kjær Vibro. 
Brüel & Kjær Vibro will return a .setk file with enabler keys for your hardware. 

  

1. Click Hardware Info 

2. Check the supported 
features* 

3. Save the Diagnostics File. 
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Use the VC-8000 Maintenance software on the firmware update page, to apply the enabler keys. 

 

 
 

Figure 5:  Enabling Hardware Features 

 

Navigate to the .setk file of the module to be updated and click Open. 

 

 

NOTE! 
Each set of keys is specific to a module and may not be moved between modules. 
 

 

  

From the Firmware Upgrade 
View, click the Enable Hardware 
button to open a dialog for 
selecting the enabler key file. 
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4 Software Licensing 

4.1 SETPOINT CMS Display Licensing 

SETPOINT® CMS is provided free-of-charge and may be downloaded from our website. The license 
agreement is displayed during the installation process for this application and the user must accept 
this license in order to proceed with the installation. 

4.2 SETPOINT® Connector Licensing 

The SETPOINT® Connector software converts the data stream from the CMS port on the eSAM into a 
format readable by a PI Server. It functions similar to a PI Interface. This software can be downloaded 
from our website. The license agreement is displayed during the installation process and the user 
must accept this license in order to proceed with the installation. 

4.3 AVEVA™ PI System™ Licensing 

Necessary AVEVA™ PI System™ components for SETPOINT® CMS can be obtained directly from 
AVEVA™, or from Brüel & Kjær Vibro. When purchased from Brüel & Kjær Vibro, the license 
agreement is between the end user and Brüel & Kjær Vibro and consists of doc 1313253 along with 
the Brüel & Kjær Vibro customer order number. All software support comes directly from 
Brüel & Kjær Vibro in such situations.  

When PI System components are purchased from AVEVA™ rather than from Brüel & Kjær Vibro, the 
license agreement is between the end user and AVEVA™, and document 1313253 does not apply. 
Support for the PI Server and other PI System components in this situation comes from AVEVA™. 
However, support for the SETPOINT® hardware, SETPOINT® Connector software, and SETPOINT® 
CMS comes from Brüel & Kjær Vibro. 

4.3.1 PI System Tags 

4.3.1.1 SETPOINT-supplied tags 

A single measurement variable in the PI System is known as a tag. SETPOINT UMM-CM and  
TMM-CM modules can supply multiple measurements, including waveforms, and may thus consume 
several dozen tags per channel (refer to Table 6), depending on the channel type and configuration. 
When a PI System is provided by Brüel & Kjær Vibro as part of a CMS installation, tags for each 
UMM-CM and TMM-CM module are included using SETPOINT® p/n SWT-05 for UMM-CM and  
SWT-06 for TMM-CM. These part numbers cover an entire module (not a channel or a single 
measurement variable) by providing the requisite number of tags for any possible combination of 
channel types/configurations in the module. The licensing agreement for these tags is encompassed 
by document 1313253 and the Brüel & Kjær Vibro customer order number. These tags are restricted 
to use only with SETPOINT® data streams.  

They are not to be used for measurements originating outside of your VC-8000 racks, except as 
noted in 4.3.1.2 below.  
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4.3.1.2 Process data tags 

PI Servers provided by Brüel & Kjær Vibro are licensed for an additional 250 tags beyond those 
consumed by data originating in the VC-8000 rack(s). These additional 250 tags are intended for 
process variables pertaining to the machine(s), but which do not originate in the SETPOINT rack(s).  

Examples include motor winding temperatures, generator loads, lube oil 
temperatures/flows/pressures, or compressor suction and discharge temperatures/flows/pressures 
that may come directly into a PLC or DCS. Such points can be supplied to the PI Server via a PI 
Interface using the appropriate protocol rather than via hardwiring through a VC-8000 rack. This 
licensing ensures that adequate tags are available for this supplementary machinery data, while 
restricting customers from using their Brüel & Kjær Vibro -supplied PI Servers as general-purpose 
process historians. Customers requiring more than 250 process data tags can work with AVEVA™ to 
convert their Brüel & Kjær Vibro PI Server to an “unrestricted” PI Server and secure any incremental 
necessary tags. Contact Brüel & Kjær Vibro for additional details. 

4.3.1.3 Customer-supplied tags 

When you use your existing PI Server with tags purchased directly from AVEVA™, the license 
agreement for your PI Server and tags is with AVEVA™. These tags are not restricted in how they 
may be used, except as governed by your AVEVA™ license. They can be used for SETPOINT® and 
non- SETPOINT® data streams, in any combination. However, in order to access this data once in the 
PI Server and display it with CMS Maintenance software, a PI Server Access (PSA) license is 
required as discussed in 4.3.2 

4.3.1.4 Tag Requirements 

Table 5 shows the number of tags required for SETPOINT® CMS. To calculate the total number of 
tags, use the VC-8000 Setup application and count the total number of measurements as seen on the 
Measurement View and the total number of waveforms as seen in the Waveform Configuration 
View. Then multiply these by the values shown in Table 6. 

 
Table 5:  PI System Tags Required 

Use Tags Required  Notes 

SETPOINT® Connector Service 1 One required per computer running 
SETPOINT® Connector 

Rack 1 For each rack  

Measurement and Status 2 Per measurement 

Waveform and Status 2 Per Synchronous or  
Asynchronous waveform 

Waveform Interestingness Index (I-Factor®) 1 Per channel 
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Table 6:  Tags Required by Channel Type 

Universal Monitoring Module 

Channel Type 
PI Tag Consumption Data Returned Measurements 

Available Waveform1 Non-WF 
Max Min Typical Sync Async Static2 

Accel – Std 23 4 17 ● ● ● 9 
Accel – Env 19 14 19 ● ● ● 7 
Accel – Aero 13 6 13 ● ● ● 4 
Accel – LF Intg 11 4 9 ● ● ● 3 
Accel – REB 11 8 11  ● ● 4 
Accel - REB slow 11 8 11  ● ● 4 
Acoustic 23 20 23  ● ● 10 
Axial Pos’n 9 4 7   ● ● 3 
Axial Pos’n sync 11 4 9 ● ● ● 3 
CE – Single 2 2 2     ● 1 
CE – Dual 6 6 6     ● 35 
DE 4 4 4     ● 2 
CIDE 10 10 10     ● 55 
RDE 10 10 10     ● 55 
Discrete 2 2 2     ● 1 
Dyn. Pres. 15 4 9 ● ● ● 5 
Ecc 15 10 15 ● ● ● 5 
Impact 11 6 11 ● ● ● 3 
Phase Trig 11 4 7   ● ● 4 
Process Var 4 4 4     ● 2 
REBAM 11 8 11  ● ● 4 
RV-Std 25 4 17 ● ● ● 10 
RV - Air Mach 21 8 21 ● ● ● 8 
RV – Hydro 29 20 29 ● ● ● 12 
Shaft Abs 38 12 38 ● ● ● 105 
Rev. Rot’n 20 14 20   ● ● 75 
Tachometer 4 4 4   ● 2 
Valve Pos’n 4 4 4     ● 2 
Vel – Std 23 4 17 ● ● ● 9 
Vel – Aero  11 6 11 ● ● ● 3 
Vel- Hydro 29 20 29 ● ● ● 12 
Vel – LF Intg 9 4 9 ● ● ● 2 
Zero Speed 15 10 13   ● ● 75 

Temperature Monitoring Module 
Temperature 6 2 2     ● 3 
Process Var 2 2 2     ● 1 

Rack3 
System4 
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Notes: 
1. Waveform Data Tag Consumption 
2 tags for each sync waveform per channel 
2 tags for each async waveform per channel 
1 tag for interestingness index (I-Factor®) per channel (waveform-capable channels only) 
 
2. Static Data Tag Consumption 
2 tags for each measurement (1 for value, 1 for status) 
 
3. Rack Tag Consumption 
1 tag per rack 
 
4. System Tag Consumption SETPOINT® Connector 
1 tag per computer running SETPOINT® Connector  
 
5. Denotes configuration selection that uses two sensors and consumes two UMM 

channels.  
Measurement count is combined total for channel pair. If sync and/or async waveforms are 
indicated as available, they are available from each channel individually. 
 
6. Channels Not Listed 
For channels not listed, use the VC-8000 Setup software to view the number of active 
measurements. Multiply the number of active measurements by 2 and add to total according to 
note 2. 

Example: 

A system with one SETPOINT® Connector service connected to 3 racks. Each rack is collecting 96 
measurements and 32 waveforms from 16 channels. 

Total Tags = (1 tag x 1 Service) + (1 tag x 3 Racks) + (2 tags x 96measurements x 3 racks) + (2 tags 
x 32 waveforms x 3 racks) = 772 tags  
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4.3.2 PI Server Access (PSA) License 

Brüel & Kjær Vibro - supplied PI Servers 
When a PI Server is supplied by Brüel & Kjær Vibro, it is licensed to connect to any other applications 
provided by AVEVA™, including but not limited to PI Interfaces, PI-to-PI Interfaces, PI Vision, and 
DataLink. It is also licensed to connect to SETPOINT® CMS software and the SETPOINT® Connector 
software. It is not licensed to connect to any other third-party applications. For other third-party 
applications to access the data in a Brüel & Kjær Vibro -supplied PI Server, a PSA is required. 
Contact Brüel & Kjær Vibro for additional information. 

AVEVA™-supplied PI Servers 
When a PI Server is supplied by AVEVA™, it is licensed to connect to any other AVEVA™ software. 
However, to connect to third-party applications, including SETPOINT® CMS software and the 
SETPOINT® Connector software, a PSA is required. An unrestricted PSA, encompassing any third-
party application, may be obtained directly from AVEVA™. A special SETPOINT® PSA, covering only 
SETPOINT® Connector and SETPOINT® CMS, is available from Brüel & Kjær Vibro. The SETPOINT® 
PSA is typically used when the customer wants to license one or more existing AVEVA™-supplied PI 
Servers for use with SETPOINT® data streams and SETPOINT® CMS display software. 

4.3.3 PI Asset Framework (AF) Client License 

SETPOINT® CMS requires that PI AF Client software be installed on the same computer in order to 
read data from a connected PI Server. PI AF Client is not required when CMS Display is used to open 
.cms files rather than connecting to a PI Server. During the installation of CMS Display software, the 
presence or absence of AF Client will be detected. If PI AF Client is absent, the user will only be able 
to open and view .cms files. If PI AF client is present, the user will also be able to connect to a PI 
Server containing SETPOINT® CMS data streams. 

4.4 SD Card and Internal SAM Hard Drive Installations 

When SETPOINT® data will not be streamed to a PI Server, and instead streamed to the SAM’s SD 
Card or internal hard drive, no PI System components are required, and no PI System licensing is 
necessary. The only CMS software required is the SETPOINT® CMS display software, with the 
features enabled per Section 3. 
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5 Installation 

5.1 Installing the PI System 

Installing a PI system is only required when you wish to store your data in AVEVA™ PI/AF database. 
Please skip this step if you do not want to use a PI system, or if want to make use of an already 
existing PI system. 

Refer to the AVEVA™ PI System™ installation manuals when installing the AVEVA™ PI System™ 
components. Refer to System Components for information about the minimum versions of the 
individual software components. The recommended installation order is: 

1. SQL Server (version as required by the selected PI AF Server version) 

2. PI AF Server 

3. PI Server 

4. PI AF Client 

5. Reboot the Server 

5.2 Installing SETPOINT® Connector 

The SETPOINT® Connector is required when you wish to store your VC-8000, VCM-3 and/or  
BKV Collect data in either an AVEVA™ PI/AF database or a CMS-XC database (VC-8000 only;  
cf. chapter 13, CMS-XC Data Storage on a Local Computer). 

 

 

APPLICATION ALERT! 
Server OS upgrades can cause the server to restart resulting in loss of data. Turn 
automatic updates off to prevent data loss. 

 

 

NOTE! 
To be able to write data to AVEVA™ PI/AF databases, the computer running the 
SETPOINT® Connector must also have the PI AF Client 2012 with SP2 (or higher) 
application installed. Recommended version is latest release from AVEVA™. Note that 
the SETPOINT® Connector service (cf. section 5.2.1) needs to be restarted after 
installing or updating PI AF Client. 
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Click on the Setpoint_Connector_Setup.exe to install the SETPOINT® Connector and configuration 
application. Accept the license agreement and follow the instructions shown on the screen. 

 
 

During the installation process, the language of SETPOINT® Connector can be selected. 

 
 

Note that the selected langugae selected defines both, the SETPOINT® Connector display language 
and the language of AF templates. That is, attributes within AF databases created by the SETPOINT® 
Connector will be localized to the language selected here. 

 

 

NOTE! 
AF databases created using different languages for the AF templates are incompatible. 
Do not change the language compared to previous SETPOINT® Connector installations 
if you want to continue writing data to already existing AF databases. 
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In the next step, you will be prompted to enter Service Log On Credentials for the SETPOINT® 
Connector Service, as shown in Figure 6. If SETPOINT® Connector service is installed on the same 
computer as the PI Server and PI AF Server, you can select Run service as Local System. If not, fill 
in an Administrator account and password or other user with PI AF server write access logon 
information. Click the Test Credentials button to verify the Account and Password are valid. 

 

 

NOTE! 
When setting the account and password it is best to use an account whose password 
will never change; be aware that when account passwords change, the service 
password must also be updated. 

 

 
Figure 6:  Setting the SETPOINT® Connector service Log On Credentials 

 
  



 

Page 34 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

5.2.1 Changing the SETPOINT® Connector Service Log On Credentials 

If you need to change the log on account or password, or if you move the PI Server, PI AF Server, or 
SETPOINT® Connector to a different computer and need to use different credentials, you can change 
the log on credentials using the following instructions. To change the account or password used for 
the SETPOINT® Connector service, change the Log On properties of the SETPOINT® Connector 
service. 

 

 
If the service fails to start, check the Windows Event Log for messages relating to  
SETPOINT® Connector. 

 

  

2.  Select Setpoint Connector Main 
Service from the list of services. 

3.  Right Click and select Properties. 

1.  Open Windows Services 

4.  A dialog will open where you can 
change the account and password. 
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5.3 Installing the SETPOINT® CMS Display Application 

Click on the Setpoint_CMS_Setup.exe to install the CMS application. Accept the license agreement 
and follow the instructions shown on the screen. 

 

 

NOTE! 
To be able to connect to AVEVA™ AF databases, the computer running SETPOINT® 
CMS must also have the PI AF Client 2012 with SP2 (or higher) application installed. 
Recommended version is latest release from AVEVA™. 
 

 

5.3.1 Add-ons 

During the installation, additional useful components are provided in the  
C:\Program Files (x86)\Setpoint\Addons  
folder. 

These components are located together with instructions in separate subfolders. 

Example: 
\PIVision 
Contains the manual and fragments to relaunch the CMS viewer from PI-Vision. 
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6 Security 

This section describes the minimum security configuration for SETPOINT® CMS operating with a  
PI Server. This includes: 

• Setting User Permissions 
• Opening Firewall Ports 

The PI System provides many additional security features. Refer to the OSI document PI Server 
Configuring Security. 

6.1 Setting User Permissions 

The AVEVA™ PI System™ has security methods to protect against unauthorized writing, reading, or 
changing data in the databases. You can set access permissions by user following the AVEVA™ 
procedures. If you have an existing AVEVA™ PI System™, your system administrator will need to set 
up the permissions. Brüel & Kjær Vibro Service can also provide assistance in setting up security 
access. 

Users will need Write/Change permission in order to: 

• Change Reference Data or Overlays 
• Change Bearing Clearance 
• Change Reciprocating Compressor Gas Properties 

To set user permissions for simple systems or for quick implementation, follow the instructions in this 
section. Start by opening the PI System Management Tools. 

Expand Security in the tree and select Mappings & Trusts. Assign users to the PI System database 
as shown: 

 
Figure 7:  Adding Users 

2.  Expand Security tree and select 
Mappings & Trusts. 

3.  Click New User to open the Add 
New Mapping dialog. 

1.  Connect to the Server. 
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Referring to Figure 8, fill in the Windows Account for the new user. The Windows SID will fill in 
automatically. The Description is not required and can be left blank. The PI Identity sets the access 
level for the PI Server. Consult with your PI Administrator for the appropriate PI identity for the new 
user.  

 
Figure 8:  Add New Mapping Dialog 

 

 

NOTE! 
The server computer must be connected to the same network domain as the users you 
are adding. 
 

 

 

NOTE! 
Though you can map individual users to PI identities, it is not a recommended practice. 
OSI recommends using Domain Groups to manage access. Refer to the OSI document 
PI Server 2012 Configuring Security for best practices when creating and mapping 
Domain Groups. 
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6.2 Opening the Firewall Port on the Server 

If you are running a firewall on your server, you will need to open the ports used by SETPOINT® CMS 
and/or the SETPOINT® Connector service. These ports are required: 

 
Table 7:  Communication Ports 

Port Description 

8001 Communication and time synchronization between the VC-8000 rack and the 
SETPOINT® Connector.1 

8002 Communication between the CMS Display Application and CMS-XC computer. Only 
required when using the CMS-XC option. 

8003 Communication between the CMS Display Application and the CMS-HD enabled rack. 
Only required when using the CMS-HD option.1 

8004 Communication for Remote-Access Configuration between MPS-Software and  
VC-8000 Rack. Only required when using MPS-Remote option. 

8181 Communication between VCM-3 devices and SETPOINT® Connector (inbound) 

8883 Communication between BKV Collect and SETPOINT® Connector (inbound) 

5450 PI AF Client to PI Server 

5457 PI AF Client to PI AF Server 

137, 138, 139, 88 AF Server to Domain Controller 

UDP 123 NTP Time Synchronization 

1 These ports should only be open for internal firewalls and are not intended to be open on firewalls to 
external networks. 

 

 

NOTE! 
The PI System Ports shown are defaults. Verify that you have opened the ports your  
PI System is configured to use. 
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Change the Firewall Ports from: 

Control Panel -> System and Security -> Windows Firewall as shown below. 

 
Figure 9:  Windows Firewall Configuration 

 

 
Figure 10:  Windows Firewall Advanced Security 

  

Choose Advanced settings. 

1. Click Inbound Rules. 
2. Select New Rule. 
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Figure 11:  Setting the Rule Type 

 

 
Figure 12:  Specify the Port 

 
  

Check Port. 

Check TCP. 
 
Enter the port number 
to open. 
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Figure 13:  Allow the Connection 

 

 
Figure 14:  Setting the Rule Application 

  

Check Allow the 
connection. 

Check all three. 



 

Page 42 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

 

 
Figure 15:  Setting the Port Rule Name 

 

You will need to repeat the steps in Figure 11 through Figure 15 creating Inbound and Outbound 
rules for each of the ports shown in Table 7. 
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7 VC-8000 Configuration 

You will need to configure your SETPOINT® system for proper operation. Configuration includes: 

• Configuring the SAM CMS network settings 
• Configuring the machine asset hierarchy 
• Configuring the waveform collection parameters 
• Configuring SETPOINT® Connector to connect to the VC-8000 rack and PI AF Server. 
• Configuring PI AF System Explorer 

7.1 Configuring the SAM 

Use the VC-8000 Setup software to configure the VC-8000 rack. Refer to the VC-8000 Operation and 
Maintenance Manual S1079330. 

7.1.1 Configuring the SAM Network Settings 

This section describes how to configure the SAM network settings for communication with a PI 
System. 

The SAM uses the CMS Ethernet port to communicate condition monitoring data to a PI System. You 
must set the SETPOINT® Ethernet network communication parameters to be compatible with your 
data acquisition computer and network. 

 
Figure 16:  Opening the SAM Properties 

Set the parameters below. Other parameters shown are for the SAM Modbus communication and are 
discussed in the VC-8000 Operations and Maintenance Manual.  

Highlight the SAM row and then click 
the properties tab. 

Check CMS Enabled, set the CMS 
Rack Name, and set the CMS IP 
information. 
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CMS Rack Name 
Assign a name to the VC-8000 rack. The SETPOINT® Connector uses this name when creating 
unique tags in the PI database. Each rack must have a unique name. 

 

NOTE! 
If you change the rack name, the SETPOINT® Connector will allocate new PI Tags. Use 
the Rack Alias (See Section 8.2 and 8.5) setting to avoid creating new tags if you 
change the rack name. 

 

CMS Enabled 
Check this box to turn on the CMS Ethernet port for connection to CMS (PI System or CMS-XC) 

CMS-SD Enabled 
Check this box to turn on recording to the SD card. The SAM must have been purchased with the SD 
card capability to activate this feature. 

CMS-HD Enabled 
Check this box to turn on recording to the internal drive. The SAM must have been purchased with 
the HD drive capability to activate this feature. 

CMS IP Address 
The Internet Protocol (IP) address is used by the Ethernet switching equipment to route packets. 
Each device on a network subnet must have a unique IP address. Consult your network administrator 
for a static IP address. 

The default IP address is 192.168.0.2. 

SETPOINT® only uses static IP addresses. DHCP (dynamic address assignment) is not supported. 

CMS Subnet 
The subnet mask is used to identify the IP address bits that define a subnet. Consult your network 
administrator for a valid subnet mask. 

The default subnet mask is 255.255.255.0.  

CMS Default Gateway 
The default gateway is the address used when a client resides on a different subnet. Typically, the 
default gateway is the address of a router used to route packets between the subnets. Consult your 
network administrator for a valid default gateway IP address. 

CMS Collect Diagnostics 
The SETPOINT® CMS system collects diagnostics and statistics on data storage and bandwidth 
usage. Checking this option causes the SETPOINT® Connector to create PI tags and store the 
diagnostic values in the PI system. 

 

 

NOTE! 
The diagnostics will consume 22 PI tags for each rack. Be sure you have enough  
PI tags available when selecting this option. 
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7.1.2 Configuring the SAM CMS Data Storage 

The eSAM, when licensed, can store CMS data in several different ways: 

 

• CMS SD:  Stores data on a Secure Digital (SD card) up to 32 GB 
• CMS HD:  Stores data on an internal solid state drive up to 256 GB 
• CMS XC or DAC: Spooled to an external computer for storage on an AVEVA™ PI Server  

   or on an external drive 

 
Enable these by checking the box in the SAM Properties: 

 

  
 

7.2 Configure the Machine Asset Hierarchy 

The PI Asset Framework imports your plant and machine hierarchy from the VC-8000 rack. Use the 
VC-8000 Setup software to configure the hierarchy by opening the CMS Framework View from the 
Channels View as shown in Figure 17. 

 

   
Figure 17:  Opening the CMS Framework View 

 

  

1.  Select the Channels View. 
2.  Select CMS Framework from the 
drop list. 
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Configure the parameters described below from the CMS Framework View (Figure 18). 

 

 
Figure 18:  The CMS Framework View 

 
CMS Navigation Path 
The CMS Navigation Path provides a method for creating a hierarchy (machine groups and 
measuring points) in PI AF. You can view the hierarchy using PI System Explorer as shown in  
Figure 19.  

The backslash (\) separates the asset levels. 

The asterisk (*) following a level determines where the CMS Navigation Path will be truncated when 
displayed on the home screen. 

Example: 

An CMS Navigation Path set to Alky*\Compressor 65CC201\ would create two levels:  

+ Alky 

          + CompressorCC201 

“Alky” would appear at the top asset level.  
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The hierarchy appears in the PI System Explorer, as shown in the further example below: 

 

 
Figure 19:  PI System Explorer Hierarchy 

 

In this case the CMS Navigation Path was entered as: 

Turbine\ 
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7.3 Configure Data Collection Rates 

Data collection rates are set on the CMS Framework View. This section describes how to set these 
parameters. 

7.3.1 Delta Time (Minutes) 

The Delta Time sets the maximum amount of time that can elapse between storing the most 
interesting waveform. The Delta Time ensures that waveforms are collected periodically, even when 
the machine condition is not changing enough to trigger I-Factor % threshold. 

Whenever the Delta Time elapses, SETPOINT® CMS stores the waveform that has changed the most 
during the collection interval. Worst case, the maximum time between stored waveforms can be twice 
the Delta Time. 

Setting a short Delta Time can cause the SETPOINT® CMS to collect very large amounts of data as 
shown in Table 8. SETPOINT® CMS will automatically collect and store more waveforms during 
transient conditions so the Delta Time does not need to be set low to achieve good waveform 
collection when the machine state is changing. 

 
Table 8:  Delta Time Data Storage for 2048 Sample Waveforms 

Delta Time Data Stored for 1 Channel  
over 1 Year 

Data Stored for 300 Channels  
over 1 Year 

1 minute 25.8 GB 7.7 TB 

20 minutes 1.3 GB 390 GB 

2 hours 216 MB 65 GB 

1 day 18 MB 5.4 GB 

 
 

 

NOTE! 
Data collection during transient operation can be much higher than steady state. Size 
your hard drive space accordingly. 
For reference, a machine startup collecting sixty 2048 points waveforms would require 
approximately 1.8 MB for each channel associated with a phase trigger and 0.9 MB for 
each channel not associated with a phase trigger. 
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7.3.2 I-Factor % 

The SETPOINT® monitor will freeze a dynamic waveform sample when any of the measured 
variables change by the configured % of the danger setpoint. If there is no danger alarm set, the 
monitor uses the percentage of the configured full scale.  

Example:  

The configured radial vibration danger alarm is 4 mils pp 

The current vibration level is 1.5 mils pp. 

The I-Factor % is 3% 

If the data value changes by 0.12 mils pp (3% of 4 mils pp) then the UMM will collect a dynamic 
waveform. This will occur in either direction, if the amplitude increases to 1.62 mils pp or drops to 1.38 
mils pp. 

7.3.3 Adaptive I-Factor 

Adaptive I-Factor® is a tool that learns the machine changes and automatically adjusts the I-Factor % 
Change Threshold to increase or decrease waveform collection. For example, if the system detects 
that the machine routinely changes vibration levels by 4% during normal operation, adaptive i-ness (I-
Factor®) will raise the I-Factor % threshold above 4% to prevent the system from collecting excessive 
waveforms. The adaptive (I-Factor®) process learns the operation over a period of time so that 
sudden changes will always initially be interesting and drive for high data collection. The data 
collection will gradually slow down as the condition persists. 

 

 
Figure 20:  Enabling Adaptive I-Factor 

 

Adaptive I-Factor® is enabled by default on dynamic channels and is recommended for long term data 
collection (excessive acquisition reduction, increase on too quiet a machine).  

  

Clear or check the Enable Adaptive I-
Factor® button to disable or enable the 
adaptive interestingness function. 
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7.3.4 Dynamic Collection on Speed Change (Delta RPM) 

The speed of an associated Phase Trigger is also included in the determination of when to collect 
dynamic data. Set the speed change interval on the Channel CMS Framework View as shown in  
Figure 21. You can set different delta RPM intervals regardless of whether the channels are using the 
same Phase Trigger or not. 

 

 
Figure 21:  Setting Speed Change for Dynamic Data Collection 

 
 

 

NOTE! 
The Delta RPM value causes the monitor to collect dynamic waveform data at this 
interval. Static data collection is independent. There is not a fixed ratio between static 
and dynamic data collection. 

 
  

Set the speed interval (level) for dynamic 
data collection at the Delta RPM column on 
the CMS Framework View. 
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7.4 Configuring Waveform Collection Parameters 

SETPOINT® CMS uses configuration information that is set in the VC-8000 Setup application when 
the VC-8000 is configured. 

 

 

NOTE! 
If you created your rack configuration with VC-8000 Setup software older than  
version 3.0, you would need to manually add in the waveforms. Refer to the VC-8000 
Operations and Maintenance manual for information on adding measurements. 

 

7.4.1.1 Channel Pairs for Orbits 

Channel Pairs for Orbits Channel pairs are fixed as channels 1 and 2 or channels 3 and 4 on a UMM. 
Each channel of the pair must be configured for the same channel type, associated with the same 
phase trigger, and belong to the same asset path.   

The following channel types are supported for channel pairing: 

• Radial Vibration 
• Shaft Absolute Radial Vibration 
• Hydro Radial Vibration 
• Diagnostic Proximity Channel 
• Acceleration Channel 
• Velocity Channel 

The configured transducer’s orientations determine which channel is “X” and which is “Y”. 

 

 

CAUTION! 
To define the acceleration and velocity channels as channel pair requires VC-8000 
Setup Software version MPS2019 SP1 (7.3.xxx). 
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7.4.1.2 Setting sample rates 

Follow the instructions in this section for setting the waveform sample rates. 

 

 

CAUTION! 
The VC-8000 Setup Software resets the monitors after configuration which can interrupt 
machine protection. 

 
Enter the Waveform Configuration View from the Measurements View as shown in Figure 22. 

 

 
Figure 22:  Entering the Waveform Configuration View 

  

1.  Go to Measurements View. 
2.  Select Waveform from the drop list. 
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7.4.1.3 Configuring Synchronous Waveforms 

Synchronous Waveform data collection is configured in terms of the number of samples collected per 
shaft revolution, evenly spaced in phase. Higher sample rates give better Orbit and Timebase 
resolution but more coarse resolution for spectrums displayed in orders. More samples (or 
revolutions) take longer to collect and provide greater spectrum resolution. 

Table 9:  Synchronous Sampling Configuration 

Rate Maximum 
Speed Number of 

Samples Revolutions 
Spectrum Range, 

Resolution  
(Hz, cycles / min) 

Collection time 
at 3600 rpm 

128X 12,500 rpm 

1024 8  50X, 0.125X 133 ms 
2048 16  50X, 0.0625X 267 ms 
4096 32  50x, 0.0313X 533 ms 
8192 64  50X, 0.0156X 1.06 s 

16384 128  50X, 0.0078X 2.13 s 
32768 256  50X, 0.0039X 4.25 s 

64X 25,000 rpm 

1024 16  25X, 0.0625X 267 ms 
2048 32  25X, 0.0313X 533 ms 
4096 64  25X, 0.0156X 1.06 s 
8192 128  25X, 0.0078X 2.13 s 

16384 256  25X, 0.0039X 4.25 s 
32768 512  25X, 0.002X 8.52 s 

32X 50,000 rpm 

1024 32  12.5X, 0.0313X 533 ms 
2048 64  12.5X, 0.0156X 1.06 s 
4096 128  12.5X, 0.0078X 2.13 s 
8192 256  12.5X, 0.0039X 4.25 s 

16384 512  12.5X, 0.002X 8.52 s 
32768 1024  12.5X, 0.001X 17.07 s 

16X 100,000 rpm 

1024 64  6.25X, 0.0156X 1.06 s 
2048 128  6.25X, 0.0078X 2.13 s 
4096 256  6.25X, 0.0039X 4.25 s 
8192 512  6.25X, 0.002X 8.52 s 

16384 1024  6.25X, 0.001X 17.07 s 
32768 2048  6.25X, 0.0005X 34.13 s 

 
The collection time is dependent on speed. The software shows the data collection time for a machine 
running at 60 Hz (3600 rpm). You can estimate the data collection time for your machine speed by 
multiplying the time shown by 3600 rpm and dividing by your machine speed in rpm. 

 

 

NOTE! 
Reciprocating Compressor channels support higher synchronous sample rates. Refer 
to the Reciprocating Compressor Manual. 
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7.4.1.4 Configuring Asynchronous Waveforms 

You can change the asynchronous sample rate and number of samples collected to optimize your 
spectrum display. Remember, as the number of lines increases, the amount of time it takes to collect 
the spectrum increases. If the machine speed is changing, this can cause smearing of the spectrum. 

 
Table 10:  Asynchronous Sampling Configuration 

Sample 
Rate  

Span Number of 
Samples 

Spectrum Lines Resolution 
(Hz, cycles / min) 

Time 
to 

Collect 

256 sps 100 Hz 1024 400  0.25 Hz, 15 cpm 4 s 

2048 800  0.125 Hz, 7.5 cpm 8 s 

4096 1600  0.0625 Hz, 3.75 cpm 16 s 

8192 3200  0.0313 Hz, 1.875 cpm 32 s 

16384 6400  0.0157 Hz, 0.9375 cpm 64 s 

32768 12800  0.0078 Hz, 0.4688 cpm 128 s 

512 sps 200 Hz 1024 400  0.5 Hz, 30 cpm 2 s 

2048 800  0.25 Hz, 15 cpm 4 s 

4096 1600  0.125 Hz, 7.5 cpm 8 s 

8192 3200  0.0625 Hz, 3.75 cpm 16 s 

16384 6400  0.0313 Hz, 1.875 cpm 32 s 

32768 12800  0.0156 Hz, 0.9375 cpm 64 s 

1280 sps 500 Hz 1024 400  1.25 Hz, 75 cpm 0.8 s 

2048 800  0.625 Hz, 37.5 cpm 1.6 s 

4096 1600  0.3125 Hz, 18.75 cpm 3.2 s 

8192 3200  0.1563 Hz, 9.375 cpm 6.4 s 

16384 6400  0.0781 Hz, 4.688 cpm 12.8 s 

32768 12800  0.0391 Hz, 2.344 cpm 25.6 s 

2560 sps 1000 Hz 1024 400  2.5 Hz, 150 cpm 400 ms 

2048 800  1.25 Hz, 75 cpm 800 ms 

4096 1600  0.625 Hz, 37.5 cpm 1.6 s 

8192 3200  0.3125 Hz, 18.75 cpm 3.2 s 

16384 6400  0.1563 Hz, 9.375 cpm 6.4 s 

32768 12800  0.0781 Hz, 4.688 cpm 12.8 s 
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Sample 
Rate  

Span Number of 
Samples 

Spectrum Lines Resolution 
(Hz, cycles / min) 

Time to 
Collect 

5120 sps 2000 Hz 1024 400  5 Hz, 300 cpm 200 ms 

2048 800  2.5 Hz, 150 cpm 400 ms 

4096 1600  1.25 Hz, 75 cpm 800 ms 

8192 3200  0.625 Hz, 37.5 cpm 1.6 s 

16384 6400  0.3125 Hz, 18.75 cpm 3.2 s 

32768 12800  0.1563 Hz, 9.375 cpm 6.4 s 

12800 sps 5000 Hz 1024 400  12.5 Hz, 750 cpm 80 ms 

2048 800  6.25 Hz, 375 cpm 160 ms 

4096 1600  3.125 Hz, 187.5 cpm 320 ms 

8192 3200  1.5625 Hz, 93.75 cpm 640 ms 

16384 6400  0.7813 Hz, 46.875 cpm 1.28 s 

32768 12800  0.3906 Hz, 23.438 cpm 2.56 s 

25600 sps 10000 Hz 1024 400  25 Hz, 1500 cpm 40 ms 

2048 800  12.5 Hz, 750 cpm 80 ms 

4096 1600  6.25 Hz, 37.5 cpm 160 ms 

8192 3200  3.125 Hz, 187.5 cpm 320 ms 

16384 6400 1.5625 Hz, 93.75 cpm 640 ms 

32768 12800 0.7813 Hz, 46.875 cpm 1.28 s 

51200 sps 20000 Hz 1024 400 50 Hz, 3000 cpm 20 ms 

2048 800 25 Hz, 1500 cpm 40 ms 

4096 1600 12.5 Hz, 750 cpm 80 ms 

8192 3200 6.25 Hz, 375 cpm 160 ms 

16384 6400 3.125 Hz, 187.5 cpm 320 ms 

32768 12800 1.5625 Hz, 93.75 cpm 640 ms 
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7.4.1.5 Deleting a Waveform 

By default, SETPOINT® CMS collects waveforms on all configured channels. To save space in the 
database, you may want to turn off data collection for some waveforms. Figure 23 shows how to 
remove a waveform from data collection. 

 

 
Figure 23:  Deleting a Waveform 

7.4.1.6 Adding a Waveform 

If you decide to restart waveform collection for a deleted waveform, follow the steps below to add the 
waveform to the data collection. 

To add a waveform, go to the Measurements tab, choose All in the drop-down box and click the Add 
button on the Measurement Configuration View. Click the monitor module, and then the channel. A 
list of available added measurements will appear as shown in Figure 24. 

 

 
Figure 24:  Adding Measurements 

 

The new waveform will appear in the Waveform Configuration View as shown in Figure 22. 

  

1.  Click on the left box to select the waveform    
     line. 
2.  Press the Delete button to delete the  
     waveform. 

Clicking the Add button 
opens a list of channels 
and measurements you 
can add. 
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7.5 Boost Mode and Compression Configuration 

The VC-8000 rack contains high speed memory for continuously sampling and recording dynamic 
waveform data during fast transient events. This function provides a rich dataset even for machines 
that start up or coast down in seconds and results in superior plots when compared to systems that 
take waveform snapshots during transients.  

 

 

NOTE! 
Use boost mode for machines that change speed for less than 2 minutes (not including 
soak time). For machines that ramp slower, standard sampling will provide a good data 
set. 

 

 

NOTE! 
You must assign a phase trigger to the channel to use boost mode. Channels that do 
not support phase trigger assignments currently do not support boost mode. 

 
A channel enters boost mode when the measured speed is between the high and low trigger speeds 
and the speed is changing by at least one configured delta rpm interval. A channel exits boost mode 
when the speed is outside the low and high trigger speeds, or a phase trigger speed error occurs. A 
channel will also stop boost continuously recorded data when the speed is not changing by the 
configured delta rpm interval for 10 seconds. This suspends the high speed sampling during 
temperature soak intervals. During the soak interval, SETPOINT® will continue to collect waveforms if 
an interesting event occurs. 

If the high speed memory fills before the transient event is complete, SETPOINT® will revert to 
standard sampling. 

 

 

NOTE! 
Boost mode collects a large amount of data. Transferring the data to CMS can take up 
to 45 minutes. SETPOINT® will continue to collect data using standard sampling if 
another transient event occurs before the previously recorded data is uploaded. 

 
To enable boost mode, navigate to the CMS Framework View and check the Boost Mode box as 
shown in Figure 25. Then set the Low Trigger and High Trigger values. SETPOINT® will sample the 
channel continuously when the measured speed is between the low and high trigger values until the 
internal buffers fill. 

Set the Low Trigger to a value greater than expected slow roll value. The Low Trigger turns off 
boosted data collection when the machine is on turning gear. If the machine is not slow rolled and 
stops at 0 rpm, set the Low Trigger to 10 rpm. 

Set the High Trigger to a value below steady state running speed less any normal operation speed 
fluctuations. The High Trigger turns off boosted data collection when the machine has reached 
steady state. 
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Figure 25:  Boost Mode Configuration 

 

 

NOTE! 
Even on slower starting machines, enabling boost mode and setting the high and low 
triggers around the critical speeds can provide a richer data set while the vibration is 
changing rapidly. The system will automatically revert to normal sampling if the memory 
fills. 

 
 

 

NOTE! 
If the boost Low Trigger and High Trigger are set to the same value, the system will not 
enter boost mode. 
 

 
CMS also uses the High Trigger and Low Trigger values to adjust the static data compression 
levels. When the speed is between the high and low trigger speeds, the machine is in a transient 
condition and the compression levels are reduced. When outside this range, the machine is assumed 
to be in steady state or slow-roll condition and the normal compression levels (as seen in the PI 
System Management Tools) are applied. 

  

To enable boost mode: 
1. Open the CMS Framework View. 
2. Check the Boost Mode checkbox. 
3. Set the low and high triggers. 
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7.6 Associating Vibration Channels with a Cylinder Throw 

 

NOTE! 
This section only covers the aspect of associating vibration channels with a cylinder 
throw of a reciprocating compressor for diagnostic purposes. For detailed information 
on using your device for monitoring reciprocating machinery, please refer to the  
VC-8000 Reciprocating Machine Addendum (S1342998). 

 
Acceleration and velocity channels (denoted by Recip Accel and Recip Crankcase Velocity, 
respectively) can be associated with such a cylinder throw in order to be able to plot dynamic 
vibration data as a function of the Crank Angle. This is in contrast with rod position (Recip Rod Pos) 
and cylinder pressure (Recip Cylinder Press) channels, which must always to be associated with a 
cylinder throw in the reciprocating compressor configuration. 

 

 

NOTE! 
Please make sure you are using the latest versions of VC-8000 firmware and VC-8000 
Setup software to use this feature. It is not supported in VC-8000 Setup software 
versions 7.15 (released in April 2023) and before. 

 
To associate a vibration channel with a cylinder throw using VC-8000 Setup, open the Channels tab 
and switch to the Recip  Vibration view. In the Throws table, select the cylinder throw you want to 
associate a channel with (Recip Single Cylinder Throw in the example below). The Channels table 
will then list all channels of type Recip Accel and Recip Crankcase Velocity that are either already 
associated with the selected cylinder throw (channel Recip Accel 4.1 in the example below), or not yet 
associated with any cylinder throw (channel Recip Crankcase Velocity 4.2 in the example below). 
Finally, modify the current association from the Associated Recip column of the Channels table. 
Note that a vibration channel can only be associated with a single cylinder throw. 
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8 Configure Data Collection and Storage 

The SETPOINT® Connector Setup software provides an interface for: 

• Configuring data storage locations 
• Adding new data connections (VC-8000 racks, VCM-3 devices, BKV Collect sensors) 
• Deleting data connections 
• Viewing connection status 
• Starting and stopping data collection 
• View system status logs 

 

 

NOTE! 
Configure your databases and collection options before adding racks or starting data 
collection. 

 

8.1 The SETPOINT® Connector File Tab 

From the SETPOINT® Connector, select the File tab to perform these functions: 

• Select PI AF Servers and Databases  
• Configure CMS-XC 
• Access Log Files 
• Advanced Options and Maintenance Tools 
• View the SETPOINT® Connector Version 
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8.1.1 PI AF Settings 

PI System to configure AVEVA™ PI System™ data collection. 

 
Figure 26:  SETPOINT® Connector PI System Settings 

 

 

NOTE! 
If the AF Database configured does not exist, SETPOINT® Connector will automatically 
create a new database with the configured name. 
 

 
  

Check the Collect Data checkbox 
to enable data storage in the PI 
System. 
 
Check Enable Spectral Bands... 
to enable collecting data for 
Spectral Bands. 
 
Fill in the PI Server name, the AF 
Server name and AF Database 
name. 
 
To browse for the AF Database, 
click the Browse button. 
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8.1.2 CMS-XC Settings 

CMS-XC stores static and dynamic data from the device into files on a local computer storage drive. 
CMS-XC files can be directly accessed from SETPOINT® CMS making CMS-XC files suitable for 
primary data acquisition or for backup to a PI System. XC is similar to the SD card feature but allows 
the data to be stored on a drive on any computer networked to the rack.  

Refer to Section 13 in this manual for more information on CMS-XC. 

 
Figure 27:  CMS-XC Configuration 

The Allow users to connect ... option allows other computers to view live data using SETPOINT® 
CMS. Clear the Allow users to connect ... checkbox if CMS-XC is only used for backing up data, 
otherwise check the Allow users to connect ... checkbox to allow viewing live data. When the Allow 
users to connect ... checkbox is cleared, you can upload the data to the PI System or open the XC 
database as a file and view historical data. 

 

 

IMPORTANT! 
CMS-XC will continue to store data until all available storage space is used. It will 
overwrite old data when the storage drive is full. Brüel & Kjær Vibro recommends using 
a separate partition for CMS-XC data if the computer is also performing other important 
functions. 

 
  

Choose XC storage folder location defines where CMS-XC 
will store the data.  Enter a folder name or use the Browse 
button to browse to a folder. 

Check the Collect Data checkbox to enable 
CMS-XC data storage. 
 
See notes below on Allow users to connect to 
(and view) CMS-XC data. 
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8.1.3 Options 

The Options view provides several advanced options and maintenance tools: 

 
Figure 28:  SETPOINT® Connector Options View 

8.1.3.1 Collect Support Information 

In case of problems with the functionality of SETPOINT® Connector, you can use this button to copy 
troubleshooting information to the clipboard. The copied information includes log and configuration 
files for SETPOINT® Connector. It does not include measurement data. 

Please always include this information when contacting our support. 

8.1.3.2 Show Connector Logs 

The Show Connector Logs option opens a Windows folder containing the SETPOINT® Connector 
system logs. The logged information can be used to troubleshoot general problems with the 
functionality of the service. 

8.1.3.3 Show VCM-3/BKV Collect Logs 

The Show VCM-3/BKV Collect Logs option opens a Windows folder containing additional log 
information around VCM-3 and BKV Collect devices. The logged information can be used 
troubleshoot problems related to the data acquisition from these device types. 
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8.1.3.4 Open Services Dialog 

Clicking this button opens the Windows Services dialog. You can change settings made during the 
SETPOINT® Connector installation (such as the log on account) from the Services dialog by right 
clicking the SETPOINT® Connector service and selecting Properties. 
 

 

NOTE! 
Stopping or resetting the SETPOINT® Connector service from the Windows Services 
dialog will close the SETPOINT® Connector interface and stop data storage. 
 

8.1.3.5 Updating the Units of Measure (UOM) 

The Update UOM function overwrites the PI System units of measure using the rack configuration 
and the computer location setting. Use this feature to change unit formats used in different countries. 

8.1.3.6 Exporting PI Tag Information 

Clicking the Export Tags button opens a dialog that allows selecting a location for saving a .csv file 
containing detailed information about SETPOINT® PI tag usage and settings. This file can be 
reviewed with another program like Microsoft Excel. 

8.1.3.7 Resetting PI Tag Compression Settings 

Under normal operating conditions, the SETPOINT® Connector only sets the compression levels 
when the PI System tags are first created. Later changes to the VC-8000, VCM-3 and/or BKV Collect 
channels do not change the compression such that any changes made in PI System Management 
Tools to optimize compression are not overwritten. However, when using devices with different 
machine assets, you may need to change compression settings from a previous job. Click the Reset 
Compression button to return the compression settings to the default settings. 

Reset Compression reverts the PI System compression settings back to the SETPOINT® defaults. 
This is important if you have changed channel types within the device (e.g., from displacement to 
velocity) and the compression settings need to change accordingly. 
 

 

NOTE! 
The Reset Compression function will overwrite any manual changes made to the  
PI system compression settings. 
 

8.1.3.8 Suppress AF Event Frame Creation 

If set, alarm events created by the device will not be forwarded to AF. This can be useful when device 
alarming capabilities are being used locally (e.g., on site), but AF analysis rules are used for 
centralized alarm generation and management. Note that this setting affects all devices managed by 
the present instance of the SETPOINT® Connector. 

CMS-XC connections ignore this setting. 
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8.1.3.9 Suppress Access to AF Hierarchy 

Can be used for scenarios where SETPOINT® Connector must not have write access to the target AF 
database (e.g., due to cybersecurity requirements). If set, SETPOINT® Connector will not attempt any 
changes to the AF hierarchy but continue to write data to the PI database. Note that the AF hierarchy 
needs to be established manually to enable connected systems (such as SETPOINT® CMS or PI-
Vision) to access the necessary attributes for display. 

8.1.3.10 Importing Data into the PI Database (VC-8000 only) 

Use the Import Data button to import CMS-SD, CMS-HD, or CMS-XC data into the PI System as 
discussed in Section 15. 

8.1.3.11 Enable Test Runs (VC-8000 only) 

Check Enable Test Runs if you are using the SETPOINT® CMS system with one VC-8000 rack for 
different assets as described in Section 20.3. 

8.1.3.12 Adaptive Exception Deviation (VC-8000 only) 

Adaptive exception deviation is an alternative compression algorithm for scalar data that automatically 
adjusts exception deviation thresholds based on the amount of data being historized. It is useful for 
machines where the signals vary greatly during normal operation. When active, the system will 
automatically increase the exception deviation threshold to limit the amount of data stored. 
Brüel & Kjær Vibro recommends activating this feature when using the SD card Import Data feature. 

Adaptive exception deviation targets a data rate of no more than one sample per second per scalar 
measurement. Thresholds for exception deviation are adjusted until this level is met. During machine 
startup/shutdown this functionality is disabled. Adaptive exception deviation is useful to provide high 
resolution data during transient periods but optimize data collected during steady states while 
minimizing the maintenance needed for the PI System. This compression algorithm is ideal for 
optimizing high resolution vibration data for diagnostics and long-term storage. 

8.1.3.13 Suppress Setting Rack Time (VC-8000 only) 

Please contact your Brüel & Kjær Vibro service representative before activating this option. Leave this 
cleared for normal operation. 

If the rack Time Source of a VC-8000 device is set to CMS (DAC), SETPOINT® Connector sets the 
rack time based on the SETPOINT® Connector system time. Note that, due to the transport delay, 
measured values and machine behavior are then no longer synchronized exactly. In some scenarios 
(e.g., if multiple instances of SETPOINT® Connector collect data from a single VC-8000 rack), a 
SETPOINT® Connector should not try to set the rack time, even if the rack Time Source is set to 
CMS (DAC). This can be achieved using the present setting. 
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8.1.4 About 

Click About to see the SETPOINT® Connector revision as shown in Figure 29. 

 
Figure 29:  SETPOINT® Connector Revision 
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8.2 Adding a Connection to a VC-8000 Rack 

Click Add to add a data connection to a VC-8000. 

  
Figure 30:  Adding a VC-8000 Rack in SETPOINT® Connector 

In the dialog shown shown in Figure 31, set the Connection Type to “VC-8000”. 

 

 
Figure 31:  Settings for a VC-8000 Data Connection 

Set the rack IP Address as set in Section 7.1.1. The Port field is for information only and is fixed at 
8001. The CMS-XC Database Name will cause the system to create new database files using this 
name at the location specified in the CMS-XC configuration (Section 8.1.2). More information about 
these settings is given in Table 12. 

Click OK to complete the process of adding a data connection. 

 
Table 11:  VC-8000 Data Connection Configuration Parameters 

Setting Description 

IP Address 
 

The VC-8000 System Access Module (SAM) IP Address configured for the SAM 
CMS Ethernet connection. 

Port 
 

The communication port is the Ethernet communication port that CMS is using. 
The port must be opened through firewalls between the VC-8000 rack and the 
SETPOINT® Connector. Normally you will not change this from the default value. 

CMS-XC Database Name  
 

Specifies the folder name where SETPOINT® Connector will store the XC file data. 

Click the Add button to add a new connection. 
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The Advanced tab shown in Figure 32 contains less frequently used configuration options. 

 
Figure 32:  Advanced Settings for a VC-8000 Data Connection 

 

See descriptions of these fields in Table 12. 
Table 12:  VC-8000 Data Connection Configuration Parameters 

Setting Description 

PI Server The PI Server network name or IP Address. Manually editing this field is only 
required if the PI Server for this data connection differs from the global PI AF 
Settings. Leave this field blank if you are only using CMS-XC. 

AF Root Path SETPOINT® Connector appends each channel’s asset path to the root path when 
building the PI AF Hierarchy (see Section 7.2). Use the AF Root Path when the 
same VC-8000 rack is used with different assets such as in test stand or portable 
diagnostic applications. 

PI/AF Rack Alias The Rack Alias is used when creating PI Tags. PI tags are created using the 
pattern Rack Alias/Slot/Channel. If the Rack Alias is not specified, SETPOINT® 
Connector will create new tags using the Rack Name. You can use the Rack Alias 
to change the rack name without creating new PI tags. 

Backfill into PI System Refer to Section 14.4 for information on PI Backfilling. 

 

 

NOTE! 
SETPOINT® Connector can resolve PI servers by name (DNS) or by IP Address.  
PI AF client must be installed on the service computer and the service started before 
configuring SETPOINT® Connector. 
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8.3 Adding a Connection to VCM-3 and/or BKV Collect Devices 

 

NOTE! 
Data collection from VCM-3 and BKV Collect devices is supported for the destination 
PI/AF only. CMS-XC storage is supported for VC-8000 only. 
 

 
It is important to note that all VCM-3 and BKV Collect devices are managed within a single data 
connection. Click Add to add such a data connection. 

  
Figure 33:  Adding a Connection to VCM-3 and/or BKV Collect Devices in SETPOINT® Connector 

In the dialog shown shown in Figure 34, set the Connection Type to ”VCM-3 and/or BKV Collect”. 

 
Figure 34:  Settings for a Data Connection to VCM-3 and/or BKV Collect Devices 

Only a single such entry needs to be configured per SETPOINT® Connector Setup installation. This 
entry can support multiple VCM-3 and BKV Collect devices. The corresponding entry on the main 
SETPOINT® Connector Setup screen always shows IP address 127.0.0.1 (cf. Figure 33). 

Click Manage License and Configuration to manage individual VCM-3 and BKV Collect devices 
that are sending data to SETPOINT® Connector. The corresponding steps are described in detail in 
the following sections. 

The Advanced tab contains less frequently used configuration options. More information about these 
settings is given in Table 12 (see previous section). 

Click OK to complete the process of adding the data connection. 

Click the Add button to add a new connection. 
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8.3.1 Activity Panel for VCM-3 and BKV Collect Devices 

Status information about licensing, configuration and communication of individual devices is shown in 
the Activity Panel for VCM-3 and BKV Collect. 

 

 
Figure 35:  Activity Panel for VCM-3 and BKV Collect 

The corresponding dialog window (see Figure 35) contains four tabs: 

• VCM-3 devices: Shows connection and license information for each individual VCM-3 device. 
When working with VCM-3 devices, use this tab to initially load the license file (.lic) that lists 
the serial numbers of VCM-3 devices that are licensed connecting to SETPOINT® Connector. 
See Section 8.3.2 for more details. 

• BKV Collect: Shows connection and configuration information for each individual BKV Collect 
device. When working with BKV Collect devices, use this tab to initially load the SETPOINT® 
configuration exported from BKV Ignite. See Section 8.3.3 for more details. 

• Latest Activity: Shows information about messages received from VCM-3 and BKV Collect 
devices. Mainly used for investigating device connection problems. 

• Process Information: Shows information about individual services related to communication 
with VCM-3 and BKV Collect devices. Mainly used for troubleshooting. 
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8.3.2 Managing VCM-3 Devices 

The VCM-3 Devices tab (see Figure 36) shows connection and license status information for each 
individual VCM-3 device. Licensed devices are shown with a green tick. If a licensed device has 
never reported to SETPOINT® Connector, a warning is shown (cf. example below). Use the Refresh 
button to update the display. 

 

 
Figure 36:  VCM-3 Devices Tab 

To enable a VCM-3 device to send data to a SETPOINT® Connector you have to: 

• Assign a unique device number to the device (see 8.3.2.1) 
• Setup time synchronization on the device (see 8.3.2.2) 
• Configure the device to send (“push”) data to SETPOINT® Connector (see 8.3.2.3) 
• Add a license file (see 8.3.2.4) 

Some of the above settings have to applied from the VCM-3 device homepage. Please refer to the 
VCM-3 Homepage Manual (C107760) for more information about accessing and using the VCM-3 
device homepage. In case of problems with any of the below steps, please refer to the VCM-3 
Troubleshooting Guide (C108291). 

8.3.2.1 Assign a VCM-3 Device Number 

The VCM-3 device number is required to uniquely identify data collected by VCM-3 devices, 
independently of the device serial number. The VCM-3 device number defines the data storage 
location (PI Tag Name) for all data recorded by a particular device. For example, given a VCM-3 with 
a device number 'VCM3North', all created PI Tags will follow the pattern 'Setpoint 
Connector.VCM3North.*'. 

 

NOTE! 
The VCM-3 device number must be unique across all VCM-3 devices that store data to 
the same PI server. Otherwise, measurement data may be lost or compromised. 
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NOTE! 
Changing the VCM-3 device number of device for which data collection has already 
been started in SETPOINT® Connector will cause data to be stored in new PI Tags. 
Historical data stored in the original PI Tags will not be deleted but will become 
inaccessible from within your SETPOINT® solution. 

 

 

NOTE! 
To perform an in-place replacement of a VCM-3 device (reusing the existing PI tags 
and thus retaining historical data), transfer the VCM-3 device number of the old device 
to the new device. Note that we strongly recommend disconnecting the old before 
performing this action. Moreover, please note that the license file will need to be 
updated such that it includes the serial number of the new VCM-3 device (see 8.3.2.4). 

 
The VCM-3 device number can be configured via the Commissioning - Configuration section of the 
VCM-3 device homepage, using the field Number. 

 
 

 

NOTE! 
The VCM-3 device number may only contain the following characters: 0-9, a-z, A-Z. 
Please be aware that the VCM-3 device homepage does not validate this restriction. 
However, data collection from SETPOINT® Connector will fail if the VCM-3 device 
number is undefined or contains invalid characters. 

 

 

NOTE! 
In previous releases of SETPOINT® Connector, the VCM-3 device number was 
restricted to integer numbers (numerals 0-9). Please use a compatible version of 
SETPOINT® Connector (CMS 2022 R3 or newer) when using non-integer VCM-3 
device numbers. 

00 
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8.3.2.2 Setup Time Synchronization on the Device 

It is highly recommended to activate time synchronization via NTP on the VCM-3 device. Please 
make sure that PI/AF server, the SETPOINT® Connector machine, and the VCM-3 use synchronized 
time sources to avoid time differences. In the extreme, the PI/AF server may discard measurement 
values that are considered to be too far in the future from its point of view. 

 

NOTE! 
The internal clock of VCM-3 devices is reset at each reboot. Until proper time 
synchronization has been re-established, a corresponding device will mark recorded 
data samples as invalid to ensure that only consistent data is being historized. 

 
NTP can be configured via the Commissioning - Services section of the VCM-3 device homepage: 

 
 

When NTP has been set up correctly, the Operational Status section of the device homepage will 
show the message Time: Synchronized: 
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8.3.2.3 Configure VCM-3 to Send Data to SETPOINT® Connector 

Use the VCM-3 Editor to configure the VCM-3 device. Within the VCM-3 Editor, navigate to the  
Data Collection tab and set the Web API Destination to the IP address of the system where the 
SETPOINT® Connector is installed. Make sure Use Secure Connection is set to Yes. Please refer to 
VCM-3 Editor Installation Manual (C107762) for more detailed information. 

 

 
 

 

NOTE! 
VCM-3 devices publish recorded data via the Web API at regular intervals (cf. Scalar 
Update Rate (s) and Waveform Update Rate (s) above). It may thus take several 
minutes until a VCM-3 device first establishes a connection with SETPOINT® 
Connector. 

8.3.2.4 Add a License File 

To successfully forward data to the PI/AF database, you need a license file that contains entries for all 
VCM-3 devices to be connected. You have received this license file with your order. The license file is 
created based on the VCM-3 device serial numbers. This serial number is located on the device and 
can also be viewed on the VCM-3 device homepage. If you want to include additional VCM-3 devices 
in the condition monitoring system, please request an updated license from your sales representative, 
stating the serial numbers of all devices to be connected to this SETPOINT® Connector instance. 

To import a license file click Set License and select the (.lic) file provided by your sales 
representative. Confirm by clicking Open. 
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8.3.3 Managing BKV Collect Devices 

The BKV Collect tab (see Figure 36) shows configuration and status information for each individual 
BKV Collect device. If a configured device has never reported to SETPOINT® Connector, a warning is 
shown (cf. second entry in the example below). Use the Refresh button to update the display. 

 

 
Figure 37:  BKV Collect Tab 

 

NOTE! 
Access to the BKV Beyond platform is required to be able to use BKV Beyond Ignite 
and BKV Deploy mentioned below. Please contact your sales representative for further 
information on obtaining the corresponding credentials. 

 

 

NOTE! 
The following steps assume that the basic condition monitoring configuration (including 
plants, areas, assets, measuring points and sensors) has already been setup in  
BKV Beyond Ignite, and that a corresponding installation project for BKV Deploy has 
already been created. For more information about these topics in general, please refer 
to the BKV Connect 1 & 2 / BKV Collect 6 & 6 Ex Quickstart Guide (C108376) and  
BKV Wireless Sensor Solution instructions (C108377). 

 

To enable a BKV Collect device to send data to a SETPOINT® Connector you have to: 

• During gateway commissioning, use BKV Deploy to configure network settings and to setup 
time synchronization on the BKV Connect gateway (see 8.3.3.1) 

• During gateway commissioning, use BKV Deploy to setup the BKV Connect gateway for 
communication with SETPOINT® Connector (see 8.3.3.2) 

• Load a SETPOINT® configuration file exported from BKV Beyond Ignite (see 8.3.3.3) 
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8.3.3.1 Setup Network Settings and Time Synchronization on the BKV Connect Gateway 

To change network and time synchronization settings of a gateway during commissioning using  
BKV Deploy, open the Registration & Configuration screen and follow the instructions to connect 
to the gateway in configuration mode. Then use the Launch admin app button (see Figure 38) to 
open the corresponding configuration screen. 

 
Figure 38:  Launch Admin App for Configuration of Time Synchronization Settings 

Within the admin app, navigate to the network settings to configure network settings, device time and 
time synchronization settings. 

It is highly recommended to activate time synchronization via NTP on the BKV Connect gateway. 
Please make sure that PI/AF server, the SETPOINT® Connector machine, and the BKV Connect 
gateway use synchronized time sources to avoid time differences. In the extreme, the PI/AF server 
may discard measurement values that are considered to be too far in the future from its point of view. 

 

NOTE! 
Communication between the BKV Connect gateway and SETPOINT® Connector will 
fail if BKV Connect device time is not set correctly. Please set the BKV Connect device 
time (either manually or, preferably, via NTP). 

 
BKV Connect gateways that are connected to the public internet are configured such that they use a 
publicly available NTP time source by default. Gateways not connected to the public internet and 
gateways that shall use a different time source need to be re-configured during the commissioning 
process. 

 

NOTE! 
When using NTP, please make sure your firewall is configured to allow connections 
from the BKV Connect gateway to NTP server via port 123. 
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8.3.3.2 Setup BKV Connect Gateway for Communication with SETPOINT® Connector 

To configure a BKV Connect gateway for SETPOINT® communication during commissioning using 
BKV Deploy, open the Registration & Configuration screen and follow the instructions to connect 
to the gateway in configuration mode. Then use the Enter IP address button (see Figure 39) to set 
the IP address of the computer where SETPOINT® Connector is running. 

 

 
Figure 39:  Configuration of SETPOINT® Connector IP Address in BKV Deploy 

 

NOTE! 
Please make sure your firewall is configured to allow connections from the  
BKV Connect gateway to SETPOINT® Connector via port 8883. 

8.3.3.3 Load a SETPOINT® configuration file exported from BKV Beyond Ignite 

The configuration defined in BKV Beyond Ignite defines the structure of plants, areas, assets and 
measuring points, and thus forms the basis of the integration of BKV Collect sensors into your 
condition monitoring solution. SETPOINT® Connector will use this information to create PI tags and 
the initial structure of the AF database. Additionally, this configuration defines the measurement 
profiles of the individual sensors. SETPOINT® Connector will forward these sensors configuration 
settings to the individual BKV Collect devices once they connect for the first time. 

 

 

NOTE! 
Using the default sensor configuration, 31 PI tags will be created for each BKV Collect 
sensor. The actual number of PI tags being consumed depends on the sensor 
configuration defined in BKV Beyond Ignite. 
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Export the configuration from BKV Beyond Ignite using the SETPOINT CONFIGURATION button 
from the plant overview (see Figure 40). 

 
Figure 40:  Exporting a Configuration File for SETPOINT® Connector from BKV Beyond Ignite 

This will open a screen where the assets to be included in this exported configuration can be selected 
(see Figure 41). Please select all assets whose data shall be collected using the present installation 
of SETPOINT® Connector. In most cases, a single of SETPOINT® Connector installation, so all assets 
can be selected. Complete the export by clicking EXPORT CONFIGURATION. 

 

 
Figure 41:  Selecting Assets to be Exported 

The generated configuration file (.json) will automatically be downloaded onto your computer. Use the 
Load Configuration button on the BKV Collect tab (see Figure 42) to import the configuration into 
SETPOINT® Connector. 

 
Figure 42:  Loading a Configuration File into SETPOINT® Connector from the BKV Collect Tab 
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After loading the configuration, the BKV Collect tab will list all measuring points and, if defined, 
associated BKV Collect sensors (see Figure 43). 

 
Figure 43:  BKV Collect Tab Display after Loading a Configuration File into SETPOINT® Connector 

The values displayed in the columns Last Contact and via BKV Connect will update as soon as the 
configured BKV Collect sensors establish a connection to SETPOINT® Connector via one of the 
BKV Connect gateways configured in the previous sections. 

 

NOTE! 
To update the SETPOINT® Connector configuration after making changes in 
BKV Beyond Ignite or via BKV Deploy, repeat the steps discussed above. The new 
configuration file will replace the existing configuration thile retaining existing data 
stored in AF and PI. 

 

 

NOTE! 
To perform an in-place replacement of a BKV Collect sensor (reusing the existing PI 
tags, and thus retaining historical data), use BKV Deploy to register the new sensor at 
the corresponding measuring point (replacing the registration of the old sensor). After 
synchronizing this information with the BKV Beyond platform, re-export the 
corresponding SETPOINT® configuration file and load it into SETPOINT® Connector 
following the steps described above. 
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8.4 Deleting a Data Connection 

Follow these steps to delete a data source. 

 

8.5 Editing Data Connection Settings 

Follow these steps to change rack information. 

 
The Edit Rack Settings dialog will open as shown in Figure 31 and Figure 32. 

8.6 Checking Data Connections 

To check security and network settings for XC, PI/AF, and rack connections, please use the Check 
Connections button from the Home tab of SETPOINT® Connector. 

 
 

 

Click the rack to highlight it. Then click the Delete 
button. 

Click the rack to highlight it. Then click the Edit 
button. 
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The number of entries in the dialog window depends on the number of rack connections and the 
number database targets that are selected for data collection (CMX-XC and/or PI/AF). In the above 
example, no racks where configured, the CMS-XC connection was valid, the Service started and was 
running correctly but the client login credentials for the AF server were invalid. If the AF database 
does not exist, the check will verify that the user has permission to create the database. 

In the following example all connections and parameters are valid: 

 
 

 

NOTE! 
When using VCM-3 and/or BKV Collect devices, Check Connections validates the 
internal communication with auxiliary services running to the same machine as 
SETPOINT® Connector. An error message refering to Network access available within 
the VCM-3 and BKV Collect [127.0.0.1] group thus indicates a problem with respect to 
the Mosquitto Broker service instead of a network problem. In this case, (re)start the 
Mosquitto Broker service from the Windows Services control pane, and re-run Check 
Connections. Please contact your Brüel & Kjær Vibro service representative if the 
problem persists. 
 

  

If the connection fails, click the expander to 
see the failure details. 
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8.7 Viewing Connection Status 

The main SETPOINT® Connector Setup screen shows the configured data connection and their 
connection statuses as shown in Figure 44. The rack name that shows is set in the rack 
configuration. 

 
Figure 44:  Main screen of SETPOINT® Connector Setup 

 

 
Table 13:  SETPOINT® Connector Status 

 
Status Description 

  Configuring 
The service is starting up or checking data connection 
configuration changes. If the configuration has changed, the 
service builds the PI AF hierarchy from the device configuration, 
allocating tags, and loading the hierarchy into the PI/AF server. 

  Collecting 
The service is running and collecting data from the listed  
data connection. 

  No Status shown. The service is stopped and is not collecting data from the listed 
device connection. The Action button will change to the record 
button. 

SETPOINT® Connector Setup shows the data 
connection names and the connection status to PI-
AF and CMS-XC (if configured) 

The Status indicates the connection state 
according to Table 13. 
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Figure 45:  Connection Information 

8.8 Starting and Stopping Data Collection 

 
Figure 46:  Starting and Stopping Data Collection 

 
Table 14:  SETPOINT® Connector Actions 

Status Description 

 The connection is not collecting data. Click the record button to 
start data collection. 

 The service is running and collecting data from the listed input data 
source. Click the button to stop data collection. 

 
  

Hover the cursor over the status to see more information. 

Click the recording button to toggle between Stopped and Recording. 
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8.9 Configure PI Database 

The SETPOINT® CMS system can create very large amounts of data depending on how often the 
machine conditions change. You can configure the PI database to use: A) a fixed number of archive 
files and overwrite, or B) to create new archive files until the storage space fills and then stop. For 
more information on these, refer to the AVEVA™ PI database manuals and tutorial videos. This 
section gives a brief overview of the storage modes and how they impact SETPOINT® CMS data 
collection. 

8.9.1 Automatic archive creation 

Automatic archive creation is the default with newer versions of the AVEVA™ PI database. As archive 
files fill, the PI system will continue to create new archives of the same size as the primary archive 
until the disk is full. Default operation is to stop data collection when all storage space is used. If the 
tuning parameter Archive_AutoArchiveFileRoot shows a path, the system is in automatic archive 
creation mode. If this parameter is blank, the system is in archive shift mode (see Section 8.9.2). 

You can set the PI System to overwrite data (Auto Shift) when the storage space is full by setting the 
tuning parameter Archive_OverwriteDataOnAutoShiftFailure to 1 as shown in Figure 47. 

 

 
Figure 47:  PI Database Tuning Parameters 



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 85 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

 

NOTE! 
No machine data is saved when all archives are filled and the overwrite parameter is 
off. To avoid missing critical machine data, set the system to overwrite or periodically 
monitor the available storage space. 

 
 

 

NOTE! 
The database can overwrite important machine reference data unless configured 
otherwise. Monitor storage space to prevent database wrapping or mark reference 
archives to prevent overwriting. 

 

8.9.2 Archive shift 

In archive shift mode you set up a fixed number of archive files to fill the allocated storage space. For 
example, if you allocated 10 GB for PI system data, create 100 archives of 100 MB each. After filling 
all the available archives, the PI System will overwrite the oldest archives.  

 

 

NOTE! 
The database can overwrite important machine reference data unless configured 
otherwise. Monitor storage space to prevent database wrapping or mark reference 
archives to prevent overwriting. 
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9 Spectral Bands and Statistical Calculations for 
Hydroelectric Generators 

Spectral Bands and Statistical Calculations for Hydroelectric Generators are two sets of additional 
measurements that can be computed by the SETPOINT® Connector. 

A dedicated service calculates the corresponding measurement values from dynamic waveform data 
in the SETPOINT® Connector process. You can enable this feature by by checking File -> PI System 
Settings -> Enable spectral bands and statistical calculations for hydro generators. 

 
 

 

NOTE! 
Spectral Bands and Statistical Calculations for Hydroelectric Generators are only 
available for AF databases. Other storage options like SD, HD and XC are not 
supported. SETPOINT® Connector requires PI AF Client (version 2.10.5 or higher) to 
be installed. Spectral Band measurements and Statistical Calculations can be exported 
to a CMS file. 
 

 

 

NOTE! 
Spectral Bands and Statistical Calculations for Hydroelectric Generators require 
additional PI Tags to store measurement data. Please make sure SETPOINT® 
Connector has sufficient permissions, and that the corresponding license covers the 
creation of additional PI Tags. In case of problems, please refer to the Troubleshooting 
section. 
 

 
Note that it is possible to enable this feature without configuring racks for data recording. In this 
dedicated mode, a SETPOINT® Connector can perform calculations on data recorded by one or 
multiple SETPOINT® Connector instances running on different servers. 
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9.1 Spectral Bands 

A Spectral Band measures signal energy on a frequency range of interest. It may be trended like 
other scalar firmware measurements such as Direct, Bandpass, 1X, 2X and nX. Every recorded 
waveform, starting from the time of Spectral Band creation, is the basis of a new measurement value. 
A Spectral Band measurement has the timestamp of the last sample of the waveform. 

To use Spectral Bands, follow these steps 

• Enable Spectral Bands calculations in SETPOINT® Connector (see above) 
• Add Spectral Band measurement(s) using Spectrum Plot in SETPOINT® CMS 

9.1.1 Add a Spectral Band 

Use the Spectrum plot to add new Spectral Band measurements for the selected assets. 

• Right-Click to open the context menu and choose 'Add Spectral Band'. 
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• Specify its name and frequency range and confirm with Apply. 

 
 
 

To activate a Spectral Band, select the desired asset in the Navigation. The created Spectral Band 
will then appear in the Attributes pane. 

• Click (activate) Spectral Band. 
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Now the Spectral Band is generated for all future measurements and can be viewed in the Timeline 
and Trend Plot. 

 
 
 

 

NOTE! 
To store the computed measurement values, this feature requires one additional  
PI tag per Spectral Band. These PI tags will be created automatically by SETPOINT® 
Connector. Please make sure you have sufficient PI tags available before adding a 
Spectral Band measurement. 

 

 

NOTE! 
A Spectral Band measurement on a full spectrum is not supported. 
 

 

 

NOTE! 
Notice that only RMS subunits are supported. 
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9.1.2 Edit a Spectral Band 

Use PI System Explorer to make necessary changes. Stop SETPOINT® Connector service while 
making changes to AF. 

 

 

NOTE! 
When frequency range of a Spectral Band is changed its existing values are not 
invalidated and they are not recalculated using the new frequency range! 
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9.1.3 Remove a Spectral Band 

To stop computing Spectral Band measurement values use PI System Explorer to remove the 
Spectral Band attribute. Stop SETPOINT® Connector service while making changes to AF. 

 

 
 

Use PI System Management Tool to remove the corresponding PI tag and associated data set if 
necessary. 
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9.1.4 Trending Spectral Bands 

Spectral Bands are represented as Attributes that can be presented on the Trend plot in  
SETPOINT® CMS. Note that spectral bands are not visualized on Spectrum plots. 
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9.2 Statistical Calculations for Hydroelectric Generators 

Large Hydroelectric Generators typically are typically equipped with four or more Air Gap sensors to 
monitor the rotor and the stator for common failure conditions. In particular, Rotor Profile waveforms 
collected by a VC-8000 rack for individual Air Gap channels contain detailed information about the 
condition of individual rotor poles and stator sections. These can be used for root cause analysis, for 
example using the Unrolled Rotor Profile Plot, the Unrolled Stator Profile Plot, and the Circular Rotor 
Profile Plot. 

On the other hand, statistical data computed from this detailed information is highly useful for 
detecting changes in the machine behavior without requiring manual analysis of the individual 
channel data sets. SETPOINT® Connector can thus compute three statistical measurements across 
the Rotor Profile waveforms of all Air Gap channels associated with a particular Hydroelectric 
Generators: 

• Air Gap Minimum: The minimum air gap value measured across all poles and channels 
• Air Gap Maximum: The maximum air gap value measured across all poles and channels 
• Air Gap Average: The averege of all air gap values measured across all poles and channels 

These three measurements can then be monitored for changes, thus yielding a simple early 
warnining indicator for subtle deformations of rotor and/or stator. 

To use Statistical Calculations for Hydroelectric Generators, follow these steps: 

• Configure the Hydroelectric Generator in the VC-8000, see section 9.2.1 
• Enable Spectral Bands calculations in SETPOINT® Connector, see beginning of chapter 9 
• Access the statistical data, see section 9.2.2 

 

 

NOTE! 
Statistical Calculations for Hydroelectric Generators are only supported for VC-8000 
racks. 

 

 

NOTE! 
For storing calculation results and status information for the three abovementioned 
measurements, 6 additional PI Tags are required per Hydroelectric Generator. 
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9.2.1 Hydroelectric Generator Setup 

 

NOTE! 
This section only covers the aspects of the VC-8000 configuration that are relevant for 
Statistical Calculations for Hydroelectric Generators. Please refer to the VC-8000 
Operation and Maintenance Manual S1079330 for additional information on setting up 
your device monitoring of this type of machine. 

 
Statistical Calculations for Hydroelectric Generators are based on all Rotor Profile waveforms from 
all Air Gap channels associated with a particular Hydro Generator within the rack configuration.In 
the example below, four Air Gap channels have been associated with a Hydro Generator with the 
user-defined name „Demo Hydro Generator“. Note that this Hydro Generator name will be used 
when initially placing the additional measurements in the AF hierarchy (cf. following section 9.2.2). 

 
 

Here, the three statistical measurements will thus be calculated across 240 per pole values (60 pole 
values as recorded in Rotor Profile waveforms four individual channels). Note that this requires 
synchronized waveform collection, which is why the Group Channels option must be selected for all 
relevant channels: 
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9.2.2 Storage und Usage of the Statistical Data 

After configuring the VC-8000 rack and enabling the statistical calculations, SETPOINT® Connector 
will create 

• 6 PI Tags to hold the computed measurement data as well as status information 
• An additional Hydro Generator node in the AF hierarchy, as a sibling of the associated Air 

Gap channels 
• Three additional Measurement nodes (Air Gap Minimum, Air Gap Maximum, and Air Gap 

Average) as children of the Hydro Generator node 

The initial name of the newly created Hydro Generator node will be based on the name defined in 
the rack configuration (cf. previous section). For example, if the name „Demo Hydro Generator“ has 
been assigned in the VC-8000 configuration, then the Hydro Generator node will be created with the 
name “Demo Hydro Generator Statistics”: 

 
 

Note that users are free to rename the Hydro Generator node and/or move it to another location in 
the AF hierarchy. 

From within SETPOINT® CMS, the statistical measurements can easily be trended by selecting the 
corresponding entry in the Point Navigation. 
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9.3 Troubleshooting 

Please make sure correct permissions are assigned when using Spectral Bands and/or Statistical 
Calculations for Hydroelectric Generators. Full rights must be granted so that the corresponding user 
can create new PI Tags for storing measurement values. 

 

  

Spectrum plot context menu has an option 'Add Spectral Band’, but it is disabled 
 

 

NOTE! 
“Spectral Band data collection must be enabled to configure and trend in CMS” in 
Section 9.1.4 

 

SETPOINT® Connector Setup -> File -> PI System has no checkbox 'Enable Spectral 
Bands' 

 

 

NOTE! 
PI AF Client 2.10.5 or higher on the system running SETPOINT® Connector in  
Section Error! Reference source not found. 

 

Spectral Bands are enabled but Spectrum plots still has a disabled option 'Add 
Spectral Band' 

• Establish a new connection with the AF database so the change can be detected. 

  



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 97 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

Spectrum plot says the minimum bandwidth is 7.5 Hz, but I need a Spectral Band with 
4 Hz bandwidth 
 

 
 

 The ratio of sample rate and number of samples determines minimum bandwidth  
 of a Spectral Band: 

  minimum bandwidth = 3 * sample rate / number of samples 

 

 Assuming an acceleration channel with default waveform parameters we get 

  minimum bandwidth = 3 * 5120 / 2048 = 7.5 Hz 

 

 Use VC-8000 Rack Setup to change either of these waveform parameters in order to a get  
 the desired minimum bandwidth (e. g decrease the sample rate) 

  minimum bandwidth = 3 * 2560 / 2048 = 3.75 Hz 
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10 CMS Display Software Features 

This section provides an overview of the CMS Display software layout and functions. 

 

Quick Access Toolbar 
The Quick Access Toolbar at the top of the screen provides direct access to commonly used 
functions.

 
  

Quick Access Toolbar Ribbon Tabs Active Ribbon 

Plot Area 

Playback Control 
Time Readout and 
Cursor Control Page navigation 

Auto Scale Plots Filter 

Compensate 

Overlay 

Manual Scale Number of Plots Shown 
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You can customize the Quick Access Toolbar using the drop arrow on the right: 

 
Here, you can hide or show buttons, or move the Quick Access Toolbar to below the ribbon. 

 

Ribbon Tabs 
Using default settings, SETPOINT CMS has seven main tabs: 

 
• File Tab 
• Home Tab 
• Trend Tab 
• Timebase Tab 
• Transient Tab 
• Spectrum Tab 
• Advanced Tab 

Use the links above to find information on each tab function. 

The Home Tab provides access to the features commonly used at each step of the data analysis 
process, whereas the Advanced Tab contains less commonly used features. 

The remaining tabs are centered around plot groups and their corresponding options. Optionally, 
three more such tabs can be activated using Start Here: 

• Recip Tab 
• Hydro Tab 
• Compressor Map Tab 

  

Click the down arrow to 
customize the Quick 
Access Toolbar 
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Active Ribbon 
You can hide or show the ribbon to increase the plot area. The default is to show the ribbon. To hide 
the ribbon, click the icon at the right side of the display. 

 

 
 

When the ribbon is hidden, the icon changes to a down arrow. Click the arrow to show the ribbon. 

 
You can also show or hide the ribbons by double-clicking on the tab name. 

Plot Area 
Plots for analyzing the data are placed in the plot area. After configuring your data, you can increase 
the plot area for analysis. 

Panes 
Panes provide access to detailed information and are opened and closed as you perform certain 
operations. You can show or hide panes to increase the plot area. 

• Navigation Pane 
• Pages Pane 
• Scales Pane 
• Reference Data Pane 
• Attributes Pane 
• Events Pane  

Time Readout and Cursor Control 
The time readout information and cursor controls are shown at the bottom of the screen. Using these 
controls, you can move to the current time or synchronize cursors. 

Playback Control 
Use the playback controls to replay recorded data or to view live data (a bit like a recorder, with an 
accelerated function).  
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10.1 The File Tab 

Navigate to the data you need to analyze using the File tab. 

 

 
 

From the File tab, you can 

• Connect to a PI Server database 
• Set a default database 
• Open a saved .cms file 
• Open a bookmarked dataset 
• Save a .cms file 
• Bookmarks  
• Export plots and reports 
• Set default units 
• Change the screen colors 
• View the software revision  

 
Go to Home Tab 
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10.1.1 Open a Data Source 

Connect to a database using the Open Database button on the File Tab. You can connect to PI AF 
databases, CMS-XC computers, or directly to racks with internal storage (CMS-HD). 

10.1.1.1 Connecting to a Recent PI AF Database, CMS-XC Computer or Rack 

If you have connected to the server before, the server will appear in the list of recent items. Clicking 
on the server name and asset name will connect SETPOINT® CMS to that server and asset. 

 

 
 

 

NOTE! 
If the CMS-XC computer or Rack was configured with a password, you will be 
prompted to enter your password. 
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10.1.1.2 Removing a Database 

To remove a database, click on the database name and then click the Remove Database button. 

 

 
 

 

NOTE! 
If you delete the currently open database and do not open another database before 
closing CMS, the next time you open CMS, CMS will restore the deleted database. 
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10.1.1.3 Connecting to a New PI AF Database 

If you are connecting to a new server, select Add Database then click the Add AF Database button. 

 

 
 

The Select Database window will open: 

  
 

  

1. Click the arrow to get a 
drop list of the available 
PI AF Servers. 

2. Click the Connect button 
to establish the 
connection with the PI AF 
Server.  Note:  If you are 
already connected to that 
server, the Connect 
button will be disabled.   

3. Select your machine 
database from the list of 
databases shown. 

4. Click OK. 
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10.1.1.4 Connecting to a Rack 

If you are connecting directly to a rack with CMS-HD capability, select Add Database and then click 
the Add Setpoint Rack button. 

 

 
 

Enter the rack IP Address and password as set in the SAM network configuration. 

 

 
 

Click OK to establish the connection. 
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10.1.1.5 Connecting to a CMS-XC Computer 

If you are connecting to a new CMS-XC computer, select Add Database then click the Add CMS-XC 
button. 

 

 
 

A dialog opens where you enter the CMS-XC computer network name. 

 
 

The software will show a dialog indicating if the connection was successful or failed. 

  

Check the Specify Account button 
if the computer security settings 
require a specific User Name and 
password must be specified. 
Click OK to finish the connection 
and return to CMS. 
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10.1.1.6 Setting Default Database 

A CMS user can set a global default database so that any user logging onto the CMS computer will 
default to the global database. To set the default database, click on the recently opened database 
that you want to set as the default and click the Set Default Database button. 

 

 
 

A pop-up box opens indicating that the default database has been set to the currently open database. 
Click OK to return to CMS. 
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10.1.1.7 Opening Saved Data from a .cms or cmssd File 

Follow the instructions in this section to open and view data saved from SETPOINT® CMS or saved 
on an SD card installed in the VC-8000 rack. You can use any computer that meets the SETPOINT® 
CMS computer requirements. You do not need the AVEVA™ AF Client installed when viewing saved 
data. 

 

  
 

When opening data stored from an SD card, the file type will be CMSSD. Data saved from the 
SETPOINT® CMS program will be a .cms file type. 

The assets in the imported file will show up in the Navigation Pane. Since SETPOINT® CMS then 
expects to be viewing offline saved files, CMS closes any display connections to an online database. 

When viewing saved data, all controls are active. Note that the timeline data only shows the data in 
the time range set at the time the data was saved. 

 

 

NOTE! 
When using SETPOINT® CMS version 2017 or later you can double click a .cms file to 
open CMS using that file. 
 

 
  

Click Open File to open 
saved .cms files, .cmssd 
SD card data, or cmsdb 
database files.  The 
software will open an 
explorer window to select 
the file to open.  
 
You can also select a file 
from the Recent Files list. 
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10.1.2 Adding a Bookmark 

You can bookmark a time range and set of plots for quick access in the future. Use the bookmark 
feature to mark times of specific machine events you want to return to or to create plot arrangements 
that you want to reuse. 

 

 

10.1.3 Using Bookmarks 

 
  

From the File Tab, click Bookmarks then 
Add Bookmark to set a bookmark for the 
selected plots and time range.  You will be 
prompted for a bookmark name.  After 
entering a name, CMS will return to the main 
view. 

Click the bookmark name to navigate to the 
bookmark plots selected when the bookmark 
was created.  The timeline is not changed. 

Click the bookmark clock icon to navigate to 
the bookmark time but keeping the currently 
selected points and plots open. 
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NOTE! 
Clicking on a bookmark opens the saved view. All plots with a pin are displayed, even if 
this plot is not set in the Home tab. Remove the pin in the plot display to remove a 
single plot or use the Clear Pins button (in the View tab) to remove all placed pins. 
 

 
 

 
 
  

Click the edit button to change the bookmark 
name.  
Click the button again to exit edit mode. 

To delete a bookmark, hover over the name 
until the “X” appears.  Click the “X” to delete 
the bookmark. 
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10.1.4 Saving a Data File 

The SETPOINT® CMS data file Save/Open functions allows you to save a range of data in a file. You 
can then open this file directly into SETPOINT® CMS for viewing the data on a computer not 
connected to the PI System database or SD card files. 

Data Save/Open is useful for: 

• Sending data to Machinery Diagnostic Engineers who do not have network access to your 
database. 

• Archiving a specific range of data to document an event. 
• Saving information for review by Brüel & Kjær Vibro Services. 

The Save As function exports all the database data in the set time range for the selected asset.   

After selecting the data points and time range, 

 
 

 

IMPORTANT! 
The save data function only exports data for the selected asset and points. Be sure that 
all points you want data for are selected before saving. 

 

 

NOTE! 
A large dataset can take a long time to save. Select only the time range and points you 
need. 

 

When the file creation starts, CMS shows a progress dialog. 

From the File Tab, Click Save As. 
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10.1.5 Export 

See Section 11.4 Documenting for information on the Export functions. The Export menu provides 
overviews of the different formats you can export the data as: 
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10.1.6 Setting Units and Spectrum Subunits 

The default units apply to all plots. After changing units, all open plots will redraw using the new units 
and subunits. New plots will open using the current unit settings. 

 

 
 

Spectrum processing can present the spectrum scaled in peak, peak to peak, or RMS. Generally, you 
will set the spectrum subunits (or detector) the same as the direct measurement for comparison 
between the spectrum and trend plots. 

  

From the File Tab click Options to 
set the default units for each 
measurement type. 
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10.1.7 Changing Display and Trace Colors 

SETPOINT® CMS has two separate color palettes for use with dark or light backgrounds highlighted 
(lights off) in a dimmed control room for example, or with a normally illuminated light screen. 

The listed colors apply in order to the channels placed on the plot. 

  
 
With the palette above, the first trace plotted will be Blue, the second trace Dark Blue, etc.  
The following figure shows an example of the dark palette: 

 

From the File Tab click Options 
to change the background and 
trace color. 
Activating the Lights changes 
the background from dark to 
light. 
 
When the button is light, the 
system will use the “light” 
palette.  When dark, the “dark” 
palette. 



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 115 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

10.1.8 View the Software Revision 

From the File Tab click About. The software revision will display: 
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10.2 The Home Tab 

The Home tab shown below is where you make choices on what data to analyze and what plots to 
present. 

 
 

From the Home tab, you can: 

• Customize CMS using Start Here 
• Activate the Point Navigation (Navigation Pane) 
• Show or hide Data Table 
• Change the desired Point Order 
• Show or hide the Timeline 
• Manually set the dynamic cursor time 
• Zoom the selected time range in or out 
• Set the time range size 
• Playback or View Live Data 
• Select number of plots to be displayed per page 
• Control and navigate plot pages 
• Control auto scaling 
• Control manual scaling 
• Create a reference sample 
• Manage reference data 
• Select whether to compensate data 
• Show or hide overlay data 

 

Go to Trend Tab 
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10.2.1 Start Here 

Click the Start Here button on the Home Tab 

 
 

to open the corresponding dialog box: 

 
 

This dialog is intended for initially setting up SETPOINT CMS according to your personal preferences 
and requirements. 

Language Preference 
Allows users to select their preferred display language. A restart of SETPOINT CMS is required 
before changing this setting has an effect. 

Units of measure 
This section allows users to reset all display units to the two most common choices. Further 
adjustments can be made from the Changes Scales pane. 
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Plot groups (ribbons) that will be displayed 
SETPOINT CMS includes four optional ribbon tabs (Transient, Recip, Hydro and Compressor Map) 
that are centered around plot types for specific purposes. By default, only the Transient tab is 
activated. Users can change this selection to show or hide plot groups such that SETPOINT CMS 
shows exactly the plots and options that are required at a particular installation. 

Hiding a plot group will hide: 

• the corresponding ribbon tab 
• corresponding plots from the Quick Access Toolbar 
• related entries from the Changes Scales pane 

Note that hidden plot groups can easily be restored from that dialog, and that all corresponding 
settings will be retained by SETPOINT CMS. 

Background 
See Changing Display and Trace Colors. 

10.2.2 Point Navigation (Navigation Pane) 

 
 

Click the Point Naivgation button on the Home Tab to open the Navigation Pane, which consists of 
three main parts (from top to bottom): 
The Point Hierarchy (Tree View), the Quick Views area (AF only) and the Selected area 
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10.2.2.1 Point Hierarchy (Tree View) 

The upper part of the Navigation Pane shows a hierarchical view on all Points within the current 
database. It allows you to quickly select and edit which points for analysis. 

 
 

In the above example, the point “TIB” has been selected, which implies that all its child nodes (“TIBX 
63VE2902B” and “TIBY 63VE2902A”) are selected. As “TIBX 63VE2902B” and “TIBY 63VE2902A” 
are channels (indicated by the blue sensor icon), the corresponding data will be displayed in all 
relevant parts of SETPOINT CMS. 

Note that each channel contains a list of measurements, and that SETPOINT CMS will automatically 
select a suitable measurement to be displayed in a plot. Users thus rarely need to interact with 
individual measurements, except in advanced scenarios like working with Attributes. 

 

 

NOTE! 
If the Navigation Pane is blank, verify that you have configured an asset path in the 
configuration. 
 

10.2.2.2 Focused Point 

 
 

Clicking the name of a point in the navigation pane will make it the Focused Point. In the above 
example, the Focused Point is “TIBX 63VE2902B”. The following actions depend on the Focused 
Point: 

• Elements listed in the Quick Views Area section will update when the Focused Point changes. 
• Newly created Quick Views will be associated with the Focused Point. 
• The Attributes Pane always shows the attributes of the Focused Point. 

 

  

Use the “+” and the “-“ 
icons and expand or 
collapse all entries up 
to the channel level. 

Use the checkboxes 
to select (sets of) 
channels for analysis. 

Use the triangles to 
expand or collapse 
individual parts of 
tree. 

Click on the name of a 
point to make it the 
Focused Point 
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10.2.2.3 Quick Views Area 

The Quick Views area lists all Quick Views that have been defined for the Focused Point. 

 

NOTE! 
This area will be hidden if you are not connected to PI AF database. 

In the following example, the Focused Point is “rotorkit”, which has a single Quick View called  
“Drive end bearing”. 

 

10.2.2.4 Selected Area 

All checked points are selected for display and are thus listed in the Selected section of the 
navigation pane. This may include channels (most common), measurements or even individual 
Attributes. 

In the example below, a single channel is selected: “Shaft DE Y”. 

 

Element selected (highlighted) in the tree 
defines the Focused Point. 

All Quick Views associated with the 
Focused Point are listed here. 
Clicking an entry will load the pre-defined 
Quick View. 
Hover an entry and click “x” to delete it. 

The Selected area lists all elements 
(channels, measurements, or attributes) 
that are select for analysis. 
To remove a point from the Selected list, 
clear the checkbox, or hover the cursor 
over the point in the Selected list and click 
the “x” on the right. 

Click Clear All to deselect all elements. 
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10.2.3 Show or Hide the Data Table 

 
Shows or hides the Data Table. 

10.2.4 Sort Plots, Traces and Data Table Entries using Point Order 

 
The Point Order combo box provides the user three options to change the order of 

• Plots of the same type in main plot area 
• traces on Small Trend and Large Trend 
• entries in the Data Table 

By default, the Point Order follows the Asset Display Order defined by the VC-8000 device. With this 
setting, channels will appear in the same order as they appear on the VC-8000 front panel display. 
Alternatively, points can be sorted alphabetically (Channel Name), or by their physical location on the 
device (Rack/Slot/Channel). 

 

10.2.5 Show or Hide the Timeline 

 
The Timeline button controls visibility of the Timeline at bottom of the screen. It provides an overview 
of the data. The Timeline Pane shows trend data for the first Selected Point, and, if applicable, its 
associated speed. You can use the Timeline Pane to select the time range of data you want to 
analysis. Note that Timeline always shows a larger time range, where the selected time range 
demarcated by the time start and time end sliders. 

 
 
To see which data points are shown in the timeline, hover over the timeline trace: 
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To select the active trace to plot, right click on the timeline. 

 

10.2.6 Manually Set the Dynamic Cursor Time using Go To 

 
 

You can quickly navigate to a time instant by manually setting the date and time of the Dynamic 
Cursor. The selected time range will be centered around the set time. 

  

10.2.7 Zoom the Selected Time Range In or Out 

 
 

Clicking the Zoom In button halves the selected time range. The Zoom Out button doubles the 
selected time range. Note that both zoom functions are anchored at the end time range. In the 
example, below the selected time range ends at 03:35:59 PM and the duration is 1 hour, 0 minutes. 

 
  

Set the date on the calendar 
and the cursor time.  Then click 
OK to move to the set time. 
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Clicking the Zoom In button reduces the duration to 30 minutes. The time range end remains the 
same: 

 
 

Clicking the Zoom Out button from the original 1 hour selected time range increases the selected 
time range to 2 hours. 

 
 

10.2.8 Set the Time Range Size 

 
 

The time range size buttons set the selected time range duration in the timeline. The end time 
remains constant. The begin time moves in time to set the duration. 

Button Duration Timeline Length 

1 w 1 week 13 weeks 

1 d 1 day 14 days 

1 h 1 hour 8 hours 

10.2.9 Playback or View Live Data 

 
 

Please refer Playback Function and View Live Data, respectively.  
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10.2.10 Select Number of Plots to be Displayed per Page 

 
 

Defines how many plots are displayed (at maximum) in the main plot area. Options are One Plot, 
Horizontal Pair (two plots side by side), Vertical Pair (two plots stacked vertically), and Four Plots 
(in a two-by-two grid). 

For more information on this topic, see Paging Plots. 

10.2.11 Select Page (Pages Pane) 

 
 

Depending on the number of points and graphs selected, and the number of graphs per page, 
SETPOINT CMS will automatically create and adjust the number of pages required. Open the Pages 
Pane for selecting the plots shown by clicking the Select Page. 

 
 

For more information on this topic, see Paging Plots. 

  

The Pages Pane groups the plots by 
the selected number of plots per page.  
The current page is highlighted. 

Plot types are indicated by the small 
icon in front of the plots 
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10.2.12 Auto Scale 

 
 
You can scale plots automatically according to the data using the Auto Scale button. Auto Scale 
selects the best full scale to optimize the data presentation for the plots. It can either scale each plot 
independently (Normal) or all plots of the same type together (Compare Plots).  

When scaling in Compare Plots mode, the scale will automatically adjust to the size of the largest 
values viewed across all visible plots of the same type using the same unit (e.g., all visible Spectrum 
plots in acceleration units). When paging plots or moving the dynamic cursor, the scale will stay at the 
largest value seen. To reset the scale in Compare Plots to the data that is currently on screen, use 
the Reset button. 

Disable Auto Scale to scale plots manually. For more information on plot scaling, please refer to 
Scaling Plots. 

10.2.13 Change Scales (Manual Scales Pane) 

 
 
Click the Change Scales button to open the Scales Pane. Use the Scales Pane to manually scale 
plots of a particular type, or to change the display unit. 

For more information on plot scaling, please refer to Scaling Plots. 

10.2.14 Create a Reference Sample 

 
 
Reference data marks a data set at a specific time for use in compensation or for comparison. 

To add a new reference data set, set the dynamic cursor to the time of the desired reference data 
then click the Create Reference button. The References pane will show the new sample. 

10.2.15 Manage Reference Data (References Pane) 

 
 
Click the Manage References button on the Home Tab to open the References pane. The reference 
data pane opens on the right side of the screen. 

You can use different reference samples for slow roll compensation, waveform compensation, and 
gap compensation or for overlaying.  
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Reference Type Description Applicable Plots 

Slow Roll 

 

Vector compensation. The Slow Roll 
compensation vector is subtracted from 
the plotted vectors. 

Filtered Orbit.  
Filtered Timebase.  
Bode 
Polar 

Waveform 

 

Waveform compensation. The reference 
synchronous waveform is subtracted from 
the data waveform before plotting. 

Unfiltered Synchronous Orbit. 
Unfiltered Synchronous Timebase. 
Spectrum, Cascade, Waterfall plots when 
plotted in orders of running speed. 

Gap 

 

Sets the gap at the starting position to the 
selected reference gap. 

Shaft Centerline 

Overlay 

 

Sets the sample to overlay on plots along 
with the current data. 

Orbit, Timebase, Spectrum overlay the 
waveform at the reference sample time.  
Bode, Polar, and Shaft Centerline plots 
overlay data from the selected time range 
when the reference sample was created. 

 
The highlighted compensation shown with the symbol above indicates that CMS is using the 
reference sample for that function. The following picture shows a sample used for all functions: 

 
 

The example below shows various changes you can make from the References pane. 

 

 
  

Click the tag to open the Reference 
Data Table showing the 
compensation vectors. 

Highlighted options indicates that the 
given reference tag is selected to be 
used for a particular purpose (Slow 
Roll Reference, Gap Reference, 
Waveform Reference, or Overlay 
Reference). 

Click on the reference data 
timestamp to navigate to that time. 

Click “X” to delete a reference data 
entry. 
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NOTE! 
You cannot change reference data when viewing live data. 
 

 
 

 

NOTE! 
CMS-HD, CMS-SD und CMS file store reference data at the rack level. When using 
OSI PI-AF and CMS-XC you can store reference data at the asset level. 
 

 

10.2.15.1 Renaming a Reference Sample 

You can change the reference data sample name in the Reference Data Table. 

 

10.2.15.2 Manually Entering a Compensation Vector 

Manually enter a compensation vector from the Reference Data Table. 

Click on the name and type in a new name 
to change the reference sample name. 
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10.2.15.3 Locking a Reference Data Archive 

To avoid overwriting reference data, you can mark specific archive files to prevent overwrites. Use the 
PI System Management Tools, navigate to Operation -> Archives. Right click the archive you want to 
prevent from overwriting and select “Make Non-shiftable” as shown below. 

 
 
  

To manually adjust a reference sample, 
Click on a vector cell and type in a new 
value.  Press Enter. 

To stop using a manually entered reference 
value and revert to the original value, click 
the X next to the manually set value. 

Clearing the check box at the beginning of a line changes the 
reference data for that point to the dynamic cursor time.  Use this if 
you want to use data from a different time for some points.  Recheck 
the box to lock the data after setting. 
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10.2.16 Activating Compensation 

 
 

Click the Compensate button to activate Compensation. 

 
 
 

 

NOTE! 
If you have not yet selected a reference tag, the plot will show an error message. 

10.2.17 Showing and Hiding Overlays 

 
 

Click the Overlay button to overlay reference data on supported plot types. Please refer to  
Using overlays for more information. 

The Compensation source is 
highlighted in the header. 
If the plot cannot be compensated, 
there will be no compensation 
source shown. 
The amplitude readout shows the 
compensated value. 



 

Page 130 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

10.2.18 Open the Manual 

 
 

Use the Help button to quickly open the present document in your default PDF viewer. 
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10.3 The Trend Tab 

The Trend tab contains configuration for how Trend type plots are displayed. 

 
 

From the Trend tab, you can: 

• Show or hide the Small Trend (Navigation Trend) 
• Show or hide the Large Trend 
• Select primary and secondary measurements to be displayed on trends 
• Show or hide waveform tick marks 
• Show or hide data annotations 

 
Go to Timebase Tab 

 

10.3.1 Show or Hide the Small Trend 

 
 

The Small Trend button controls the visibility of the Small Trend pane at to be lower part of screen 
(above the Timeline). 

 
 

The Small Trend pane shows the time range that is currently selected for analysis. It is a trend plot 
that remains visible on any plot page, thus providing context about the data that is currently being 
analyzed in the main plot area. Traces will be added for each selected channel. The default selection 
of measurements per channel to be shown can be customized. 

The cursor position on the Small Trend defines the Dynamic Cursor Time.  

You can show or hide traces and rubber band zoom the selected time region in the same manner as 
on the Large Trend plot. 
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10.3.2 Show or Hide the Large Trend 

 
 

The Large Trend button controls the visibility of the Large Trend plot. Traces will be added for each 
selected channel. The default selection of measurements per channel to be shown can be 
customized. 

10.3.3 Select Primary and Secondary Measurements to be Displayed on Trends 

 
 

You can define the measurements to be displayed on Small Trend and Large Trend plots from the 
Primary & Secondary Measurements section of the Trend ribbon.  

 

 
 

Options Direct/Primary and Add Speed should be activated for most uses cases. Direct/Primary 
ensures that the most important (primary) measurements are being trended for all selected channels. 
The Add Speed option, on the ther hand, additionally adds a trend of the speed measured by phase 
triggers associated with at least one of the currently selected channels. 

Additional measurements can be added by checking the corresponding options. For example, if you 
want to only see 1X vector measurements, check the 1X box. The following tables show the 
association of the measurements to the options available in the Primary & Secondary 
Measurements section. 
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Channel 
Type 

Measurements Trend Group 

Acceleration Direct (primary) Direct/Primary 
Bias Gap 

1X Amplitude 
and Phase 

1X, 1X Phase 

2X Amplitude 
and Phase 

2X, 2X Phase 

Bandpass Accel Bandpass 
nX nX, nX Phase 

Accel Slow 
RMS 

Direct (primary) Direct/Primary 
Bias Gap 

Acoustic Direct (primary) Direct 

Bias Gap 

Band-pass filters 
1 to 8 

Bandpass 

Aero Accel Aero 1X 
Tracking Filter 

(primary) 

Direct/Primary 

Band-pass 1 Bandpass 
Band-pass 2 Bandpass 

Bias Gap 

Aero 
Velocity 
Tracking 

1X Tracking 
Filter 

Direct/Primary 

Band-pass Bandpass 
Bias Gap 

Aero 
Velocity 

Bandpass 

Primary Band-
pass 

Direct/Primary 

Added Band-
pass 

Bandpass 

Bias Gap 

Axial 
Position, 

Axial 
Position w/ 

sync 

Axial Position Direct/Primary 
Gap Gap 

Axial Vibration Bandpass 

Case 
Expansion 

Direct Direct/Primary 

Case 
Expansion 

(2 ch) 

Differential Case 
Expansion 

Direct/Primary 

Direct 1 Other 
Direct 2 Other 

 
 

Channel 
Type 

Measurements Trend Group 

Diagnostic 
Acceleration 

Direct (primary) Direct/Primary 
Bias Gap 

1X Amplitude and 
Phase 

1X, 1X Phase 

2X Amplitude and 
Phase 

2X, 2X Phase 

nX Amplitude and 
phase 

nX, nX Phase 

Diagnostic 
Proximity 

Direct Direct/Primary 
Gap Gap 

1X amplitude and 
phase 

1X, 1X Phase 

2X amplitude and 
phase 

2X, 2X Phase 

nX amplitude and 
phase 

nX, nX Phase 

Diagnostic 
Velocity 

Direct Direct/Primary 
Bias Gap 

1X amplitude and 
phase 

1X, 1X Phase 

2X amplitude and 
phase 

2X, 2X Phase 

nX amplitude and 
phase 

nX, nX Phase 

Diff Exp 
Single Probe 

Direct Direct/Primary 
Gap Gap 

Diff Exp Comp 
Input 

Composite Direct/Primary 
Direct 1 Other 
Direct 2 Other 
Gap 1 Gap 
Gap 2 Gap 

Diff Exp Dual 
Ramp 

Composite Direct/Primary 
Direct 1 Other 
Direct 2 Other 
Gap 1 Gap 
Gap 2 Gap 

Diff Exp 
Single Ramp 

Composite Direct/Primary 
Direct 1 Other 
Direct 2 Other 
Gap 1 Gap 
Gap 2 Gap 
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Channel 
Type 

Measurements Trend Group 

Discrete 
Input 

Digital State Direct/Primary 

Dynamic 
Pressure 

Direct Direct/Primary 
Bias Gap 

Pressure Band-
pass 1 

Bandpass 

Pressure Band-
pass 2 

Bandpass 

Pressure Band-
pass 3 

Bandpass 

Eccentricity PP Eccentricity Direct/Primary 
Gap Gap 
Min Other 
Max Other 

Ecc Position Other 

Enveloped 
Acceleration 

Direct Direct/Primary 
Bias Gap 
Cage Bandpass 
IRBP Bandpass 
ORBP Bandpass 

Ball Spin Bandpass 
2X Ball Spin Bandpass 

Hydro 
Radial 

Vibration 

Direct Direct/Primary 
Gap Gap 

1X Amplitude 1X 
2X Amplitude 2X 
Bandpass 1 Bandpass 
Bandpass 2 Bandpass 
Bandpass 3 Bandpass 
Bandpass 4 Bandpass 
Bandpass 5 Bandpass 
Bandpass 6 Bandpass 
Bandpass 7 Bandpass 
Bandpass 8 Bandpass 

 
 
 
 
 
 
 

Channel 
Type 

Measurements Trend Group 

Hydro 
Velocity 

Direct Direct/Primary 
Bias Gap 

1X Amplitude 1X 
2X Amplitude 2X 
Bandpass 1 Bandpass 
Bandpass 2 Bandpass 
Bandpass 3 Bandpass 
Bandpass 4 Bandpass 
Bandpass 5 Bandpass 
Bandpass 6 Bandpass 
Bandpass 7 Bandpass 
Bandpass 8 Bandpass 

Low 
Frequency 

Acceleration 

Direct Direct/Primary 
Bandpass Bandpass 

Bias Gap 

Low 
Frequency 

Velocity 

Direct Direct/Primary 
Bias Gap 

Phase 
Trigger 

Speed Direct/Primary 
Gap Gap 

Rotor 
Acceleration 

Other 

Peak Speed Other 

Process 
Variable 

Direct Direct/Primary 
Bias Gap 

Radial 
Vibration 

Direct Direct/Primary 
Gap Gap 

1X amplitude 
and phase 

1X, 1X Phase 

2X amplitude 
and phase 

2X, 2X Phase 

nX  nX, nX Phase 
Band-pass 1 Bandpass 
Band-pass 2 Bandpass 
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Channel 
Type 

Measurements Trend Group 

Radial 
Vibration Air 

Machine 

Direct Direct/Primary 
Gap Gap 

1X Amplitude 1X 
2X Amplitude 2X 
3X Amplitude nX 
4X Amplitude nX 

Bearing, 
Resonance, 

Resonance (2nd) 

Bandpass 

Radial 
Vibration 

with Smax 

Smax Direct/Primary 
Direct Direct/Primary 
Gap Gap 

1X amplitude 
and phase 

1X, 1X Phase 

2X amplitude 
and phase 

2X, 2X Phase 

REBAM 
Channel 

Direct Direct/Primary 
Gap Gap 

Rotor Region Bandpass 
Prime Spike Bandpass 

REB 
Acceleration 

& REB 
Acceleration 

(Slow) 

Overall Direct/Primary 
Prime Spike Bandpass 

HF 
Demodulated 

Bandpass 

Bias Gap 

Recip 
Crankcase 

Velocity 
 
 

Direct Direct/Primary 

1X amplitude 
and phase 

1X, 1X Phase 

2X amplitude 
and phase 

2X, 2X Phase 

Bias Gap 

Recip 
Impact 

Impact Count Direct/Primary 
Maximum Direct/Primary 

Bias Gap 

 
 
 
 
 
 
 
 

Channel 
Type 

Measurements Trend Group 

Recip 
Cylinder 
Pressure 

Discharge 
Pressure 

Direct/Primary 

Suction 
Pressure  

Direct/Primary 

Compression 
Ratio 

Other 

Maximum 
Pressure 

Other 

Minimum 
Pressure 

Other 

Peak Rod 
Compression 

Other 

Peak Rod 
Tension 

Other 

Rod Reversal 
Degrees 

Other 

Recip Rod 
Drop 

Average Piston 
Position 

Direct/Primary 

Rod Runout Other 
Average Gap Gap 

Triggered Piston 
Position 

Other 

Triggered Gap Other 

Recip Rod 
Position 

Direct PP Direct/Primary 
Gap Gap 

1X amplitude 
and phase 

1X, 1X Phase 

Crank Angle Other 
Rod Pos 

Magnitude 
Other 

Rod Pos Phase Other 

Reverse 
Rotation 

Rev Speed Other 
Num Rev 
Rotations 

Other 

Rev Peak Speed Other 
Forward Speed  Other 

Gap 1 Gap 
Gap 2 Gap 

Shaft 
Absolute RV 

Shaft Abs Direct Direct/Primary 
Direct Direct/Primary 
Gap Gap 

1X amplitude 
and phase 

1X, 1X Phase 
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Channel 
Type 

Measurements Trend Group 

Shaft 
Absolute Vel 

Velocity Direct Direct/Primary 
Intg Direct Bandpass 

Bias Gap 
1X amplitude 

and phase 
1X, 1X Phase 

2X amplitude 
and phase 

2X, 2X Phase 

Simulated 
Phase 
Trigger 

Speed Direct/Primary 

Tachometer Speed Direct/Primary 
Gap A Gap 

Tracking 
REB 

Acceleration 

Overall Direct/Primary 
1X amplitude 

and phase 
1X, 1X Phase 

Bias Gap 
Ball Spin Bandpass 

2X Ball Spin Bandpass 
Cage Bandpass 
HF 

Demodulated 
Bandpass 

IRBP Bandpass 
ORBP Bandpass 

Valve 
Position  

Direct Direct/Primary 
Bias Gap 

Velocity Direct Direct/Primary 
Bias Gap 

1X amplitude 
and phase 

1X, 1X Phase 

2X amplitude 
and phase 

2X, 2X Phase 

nX amplitude 
and phase  

nX, nX Phase  

Bandpass Bandpass 

Zero Speed Zero Speed Direct/Primary 
Speed Direct/Primary 
Gap Gap 

Peak Speed Other 
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10.3.4 Show or Hide Waveform Tick Marks 

 
 

The Waveform Ticks button controls whether waveform collection times will be indicated by dashes 
(ticks) on Small Trend and Large Trend. 

 

The vertical position of the tick mark visualizes the interestingness of the waveform. Typically, many 
waveforms will be recorded during transient phases or unusual events. You can change the axis 
scale from the % setting in the Change Scales pane. 

10.3.5 Show or Hide Data Annotations 

 
 

The Data Annotations button controls the visibility of annotations (Alarm Markers and State Markers) 
on Small Trend and Large Trend. 

  

With activated Waveform Ticks, 
waveform collection times will be 
indicated on Small Trend and 
Large Trend. 
 
More interesting waveforms will be 
shown closer to the top of the plot. 
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10.4 The Timebase Tab 

The Timebase tab contains configuration for how Orbit, Timebase, and Orbit/Timebase plots are 
displayed. 

 
 

From the Timebase tab, you can: 

• Show or hide the Orbit, Timebase, or combined Orbit/Timebase plot 
• Enable and adjust filtering 
• Adjust the Number of Revolutions for Synchronous Waveforms 
• Adjust the Number of Seconds for Asynchronous Waveforms 
• Show or Hide Asynchronous Orbit, Timebase, and Orbit/Timebase plots 

 
Go to Transient Tab 
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10.4.1 Show or Hide the Orbit, Timebase, and Orbit/Timebase Plot 

 
 

The Orbit and Time buttons control the visibility of Orbit and Timebase plots. Note that, if Orbit and 
Time are activated simultaneously, a combined Orbit/Timebase plot will be shown for suitable 
channel pairs. 

10.4.2 Enable and Adjust Filtering 

 
 

Filtering applies to the Orbit, Timebase, and Orbit/Timebase plots. When filtering is enabled, these 
plots will visualize the 1X, 2X, or nX vector as waveforms instead of showing the unfiltered waveform. 
Here, “nX” denotes the user-defined multiple of the running speed that has been configured in the 
device (for example, 0.5X or 3X). 

 

 

 

NOTE! 
To show filtered data, the UMM must be configured to measure the 1X, 2X, or nX 
vector. Missing vector data cannot be by SETPOINT CMS. 

 
 

 

NOTE! 
If the vectors are integrated, the filtered waveform will also be integrated. 

 
  

To filter Orbit, Timebase, or Orbit/Timebase 
plots to a specific vector: 

1. Click the Enable Filter button. 

2. Select the multiple of the running 
speed to visualize. 
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10.4.3 Adjust the Number of Revolutions for Synchronous Waveforms 

 
 

You can change the number of shaft revolutions shown on Orbit, Timebase, and Orbit/Timebase plots 
from the default value of 8 revolutions. Note that this feature only applies to Synchronous waveforms. 
For the asynchronous case, please refer to Adjust the Number of Seconds for Asynchronous 
Waveforms. 

For example, changing Number of Revolutions to 16 results in the Orbit with 16 revolutions plotted: 

 
 

 
 

The maximum Number of Revolutions shown is limited by the dataset. Boost mode data supports 
much higher numbers of revolutions. The following table illustrates the number of revolutions 
collected (when not in boost mode) when using the example of the default setting of 2048 samples 
per waveform. Note that 1024X and 512X sample rates are only available for reciprocating 
compressor channel types. 

Sample Rate  Revolutions 

1024X 2 

512X 4 

128X 16 

64X 32 

32X 64 

16X 128 

  



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 141 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

10.4.4 Adjust the Number of Seconds for Asynchronous Waveforms 

 
 

You can change the displayed length of a waveform shown on Orbit, Timebase, and Orbit/Timebase 
plots from the default value of 1 second. Note that this feature only applies to Asynchronous 
waveforms. For the synchronous case, please refer to Adjust the Number of Revolutions for 
Synchronous Waveforms. 

For example, changing the Number of Seconds to 2 will result in a time range of 2 seconds on 
asynchronous Timebase plots: 

 
 

 
 

The maximum Number of Seconds shown is limited by the dataset. Boost mode data supports much 
longer waveforms. 

By default, SETPOINT CMS will only show the Synchronous Waveform where applicable. Please 
refer to Show or Hide Asynchronous Orbit/Timebase for changing this setting. 
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10.4.5 Show or Hide Asynchronous Orbit, Timebase, and Orbit/Timebase plots 

 
 

By default, SETPOINT CMS will preferentially show Orbit, Timebase, and Orbit/Timebase plots based 
on the synchronously sampled waveform. That is, if both types of waveforms have been recorded for 
a particular channel, only the synchronous waveform plot will be displayed. To additionally view the 
asynchronously sampled waveform asynchronous data, check the Asynchronous Orbit/Timebase 
checkbox. 

For example, activating Time and Asynchronous Orbit/Timebase for a standard Radial Vibration 
channel will lead to the following display: 

 

 
 

 
 

  

Both types of waveforms are being 
shown. 
The header indicates the respective 
waveform type. 
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Asynchronous Orbit, Timebase, and Orbit/Timebase plots will not have phase trigger marks and 
cannot be filtered or compensated. The synchronous waveform always shows the number of 
configured shaft revolutions. The temporal waveform length thus varies when the machine speed 
changes. The asynchronous waveform, on the other hand, will show fewer revolutions at low speed 
and more at higher speeds, where the temporal length of the waveform is constant. 

The following example illustrates these differences by comparing the same pair of plots (synchronous 
in the left column, asynchronous in the right) at a low running speed (top row) and a high running 
speed (bottom row): 

 

 
 

 

 
  

High speed 

Low speed 

Same number of 
revolutions but 
different time length. 

Varying number of 
revolutions but same 
time length. 
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10.5 The Transient Tab (optional) 

The Transient tab contains configuration for how Bode, Polar, and Shaft Centerline plots are 
displayed. 

Note that the Transient tab is visible by default but can be hidden from the Start Here dialog. 

 
 

From the Transient tab, you can: 

• Show or hide the Bode and the Polar plot 
• Select vector measurements to be displayed on Bode and Polar plots 
• Show or hide Direct measurements on Bode plots 
• Use time labels instead of speed labels on Polar plots 
• Show or hide the Shaft Centerline plot 
• Use time labels instead of speed labels on Shaft Centerline plots 

 
Go to Spectrum Tab 
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10.5.1 Show or Hide the Bode and the Polar Plot 

 
 

The Bode and Polar buttons control the visibility of Bode and Polar plots. 

10.5.2 Select Vector Measurements to be Displayed on Bode and Polar Plots 

 
 

Choose which vector data values to plot on the Bode and Polar plots. By default, these plots will show 
1X amplitude and phase only. Activate 2X and/or nX to compare different sets of vector data. Here, 
nX denotes the user-defined multiple of the running speed that has been configured in the device (for 
example, 0.5X or 3X). 

 

 

NOTE! 
If Bode or Polar plots are activated with no vector selected, the Bode plot will open 
showing the 1X vector. 

 

When activating multiple sets of vector data, Bode plots will show multiple traces (one per selected 
vector data) within a single plot: 
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Polar plots, on the other hand, will show each set of vector data in a separate plot: 

 
 

10.5.3 Show or Hide Direct Measurements on Bode Plots 

 
 

In addition to vector measurement data, Direct (overall) data can be overlaid on the amplitude part of 
Bode plots using the Direct (Bode) checkbox. This allows users to quickly determine how the 
individual vector data sets influence the Direct (overall) measurement. 
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10.5.4 Use Time Labels instead of Speed Labels on Polar Plots 

 
 

The Show Time (Polar) checkbox labels Polar plots with the sample time. When the Show Time 
(Polar) checkbox is cleared (default), the points are labelled with the speed. 

 

10.5.5 Show or Hide the Shaft Centerline Plot 

 
 

The Shaft Centerline button controls the visibility of Shaft Centerline plots. 

10.5.6 Use Time Labels instead of Speed Labels on Shaft Centerline Plots 

 
 

Similar to the equivalent functionality for Polar plots, the Show Time checkbox labels Shaft Centerline 
plots with the sample time. When the Show Time checkbox is cleared (default), the points are 
labelled with the speed. 

  

    Points labelled with speed                                                  Points labelled with time 
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10.6 The Spectrum Tab 

The Spectrum tab contains configuration for how Spectrum, Waterfall, and Cascade plots are 
displayed. 

 
 

From the Spectrum tab, you can: 

• Show or hide the Spectrum, the Waterfall and the Cascade plot 
• Enable the Order Spectrum 
• Adjust the Number of Spectral Lines 
• Select the Spectrum Window Type 
• Enable Integration 
• Enable the Full Spectrum 
• Select the 3D Cursor 
• Select the Default 3D View 
• Adjust the number of Displayed Waveforms 
• Enable 3D Plot Walls 
• Enable Bearing Cursors 

 
Go to Recip Tab 
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10.6.1 Show or Hide the Spectrum, the Waterfall and the Cascade Plot 

 
 
The Spectrum, Waterfall and Cascade buttons control the visibility of Spectrum, Waterfall, and 
Cascade plots. 

10.6.2 Enable the Order Spectrum 

 
 
The Order Spectrum option controls whether the X axis of Spectrum, Waterfall, and Cascade will be 
in frequency (Order Spectrum deactivated) units or multiples of running speed (Order Spectrum 
activated), denoted by “X”. Select this option to generate the spectrum data from the synchronously 
sampled waveform. 

10.6.3 Adjust the Number of Spectral Lines 

 
 
Allows you to adjust the spectral resolution of Spectrum, Waterfall, and Cascade plots. Increasing the 
Spectral Lines will reduce the width of peaks the plot, which is beneficial when identifying and 
discriminating specific fault frequencies. 
 

 
 

NOTE! 
When using many Spectral Lines, the time range covered by the analyzed waveform 
can increase significantly. This can affect the quality of the spectrum data if the 
machine conditions change significantly across this time range. Most significantly, 
significant changes of the machine speed can have a severe impact on Spectrum, 
Waterfall, and Cascade plots that are not order-normalized. Please consider using an 
Order Spectrum in this case. 

 

If the selected number of Spectral Lines exceeds the maximum allowed by the sampling 
configuration defined in the device, SETPOINT CMS will limit the Spectral Lines such that no 
interpolation occurs. The plot header shows the actual number of Spectral Lines being used. 
 

 

NOTE! 
Waterfall and Cascade plots limit the actual Spectral Lines to 800 for performance 
reasons. 
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10.6.4 Select the Spectrum Window Type 

 
 

Windowing enhances the spectrum display with respect to amplitude and frequency accuracy. The 
Window type applies to all open Spectrum, Waterfall, and Cascade plots. The default setting 
(Hanning) is suitable for most applications. 

The following examples illustrate the effects of the various window types. 

 

  

  

No window (None) applied. 
Notice the skirting around the peak 
components.  The skirting is not real 
machine data – it is caused by the spectrum 
Fast Fourier Transform processing. 

Hanning window applied. 
Notice the skirting around the peak 
components is reduced.  The energy moves 
to the fundamental which increased from 
0.34 to 0.4 by applying the Hanning window. 

Blackman window applied. 
Similar to Hanning, the Blackman window 
reduces skirting and brings the peak closer 
to the actual value. 
Some consider Blackman to be a superior 
window to Hanning. 
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10.6.5 Enable Integration 

 
 

Click the Integrate button to integrate Spectrum, Waterfall, and Cascade plots from user-defined 

• acceleration units to velocity units, and 
• from velocity units to displacement units. 

 

 

NOTE! 
On Spectrum, Waterfall, and Cascade plots, spectral components below 1/T Hz (T is the 
waveform duration) are set to zero as even minimal numerical rounding errors will be 
amplified significantly due to the high integration gain at low frequencies. 
 

 
 

 

NOTE! 
Integration is only available on Spectrum, Waterfall, and Cascade plots. Orbit and 
Timebase plots cannot be integrated. 

 
  

Hamming window applied 
Similar to Hanning, the Hamming window 
reduces skirting and brings the peak closer 
to the actual value. 
In general, the Hanning and Blackman 
windows are superior to the Hamming 
window.  The Hamming window is provided 
for comparison with other tools using the 
Hamming window. 
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10.6.6 Enable the Full Spectrum 

 
 

SETPOINT CMS generates the full Spectrum, Waterfall, or Cascade from a XY probe pairs. The 
resulting Full Spectrum is the spectrum of the shaft orbit, with forward and reverse vectors that 
define the orbit. 

Full Spectrum plots can be displayed in frequency units as well as in orders of running speed (Order 
Spectrum). On plots showing a Full Spectrum, the X-Axis extends in the positive and the negative 
direction. Full spectrum plot cursors show both, forward and reverse precessing values for the 
selected frequency or order. Here, we use the example of a Full Spectrum in frequency units: 

 

10.6.7 Select the 3D Cursor 

 
 

The 3D Cursor control applies to Cascade and Waterfall plots only. Standard mode causes the 
cursors to track the X-Axis point when using the Up/Down arrow keys to move between spectrums. 
Track Orders causes the cursor to follow the current order. For example, if you click on the 1X 
harmonic component in Track Orders mode and then use the arrow keys to move to the next 
spectrum, the cursor will move to the 1X harmonic regardless of the speed. 

  

Header shows Full Spectrum 
indicator when a full spectrum is 
plotted. 

Forward precessing components  Reverse precessing components  

X-Axis origin 
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10.6.8 Select the Default 3D View 

 
 

You can rotate the Cascade and Waterfall plots to different viewing angles to better see the harmonic 
content. The default 3D view sets the way a new Cascade or Waterfall plot will open. Options are 
South East (SE), South South West (SSW), South West (SW), and Top Down. 

10.6.9 Adjust the Number of Displayed Waveforms 

 
 

Displayed Waveforms applies only to Cascade and Waterfall plots. This is the maximum number of 
spectrums that CMS will display on these plots based on the signal samples. A large spectral display 
limit provides more detail but takes longer to load. 

10.6.10 Enable 3D Plot Walls 

 
 

You can display or hide the Y axis scales and back wall on the Cascade and Waterfall plots. 

 

  

3D Plot Walls active shows the wall on the 
back of the plot and the Y axis scale at the 
front. 
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10.6.11 Enable Bearing Cursors 

 
 

If bearing frequencies are assigned to the point (reference REB Solutions Manual S000002001), 
checking Bearings will display the bearing frequency cursors on the spectrum plot. The bearing 
frequency cursors are shown on the plot and the cursor names and amplitudes are shown on the 
right. 
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10.7 The Recip Tab (optional) 

The Recip tab contains configuration for how Crank Angle, Displaced Volume and X Y Rod Position 
plots are displayed. 

Note that the Recip tab is hidden by default but can be activated from the Start Here dialog. 

 
 

From the Recip tab, you can: 

• Show or hide the Crank Angle, Displaced Volume, and X Y Rod Position plot 
• Show or hide Gas Force, Inertial Force and/or Rod Load on Crank Angle plots 
• Adjust the Number of Revolutions displayed on Crank Angle plots 
• Show or hide the Adiabatic Curve on Displaced Volume plots 

 

Go to Hydro Tab 
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10.7.1 Show or Hide the Crank Angle, Displaced Volume, and X Y Rod Position Plot 

 
 

The Crank Angle, Displaced Volume, and X Y Rod Position buttons control the visibility of  
Crank Angle, Displaced Volume and X Y Rod Position plots. 

10.7.2 Show or Hide Gas Force, Inertial Force and/or Rod Load on Crank Angle Plot 

 
 

By default, the Crank Angle plot shows vibration and pressure data only.  
Use the Gas Force, Inertial Force and/or Rod Load checkboxes to additionally show the 
corresponding data on Crank Angle plots with at least one pressure trace. 

Note that Rod Load Reversal Points will only be displayed if the Rod Load option is checked. 
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10.7.3 Adjust the Number of Revolutions 

 
 

Change the Number of Revolutions to see a data sample plotted over more or fewer revolutions on 
the Crank Angle plot. 

 

10.7.4 Show or Hide the Adiabatic Curve 

 
 

The Adiabatic Curve checkbox controls the visibility of the theoretical pressure curve in  
Displaced Volume plots. Note that the Isentropic Exponent of the compressed gas and the physical 
Cylinder Clearance of the cylinder need to be configured to get meaningful results  
(cf. section 11.2.13.1). 
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10.8 The Hydro Tab (optional) 

The Hydro tab contains configuration for how Unrolled Rotor Profile, Unrolled Stator Profile, and 
Circular Rotor Profile plots are displayed. 

Note that the Hydro tab is hidden by default but can be activated from the Start Here dialog. 

 
 

From the Hydro tab, you can: 

• Show or Hide the Unrolled Rotor Profile, Unrolled Stator Profile, and Circular Rotor Profile Plot 
 

Go to Compressor Map Tab 

 

10.8.1 Show or Hide the Unrolled Rotor Profile, Unrolled Stator Profile, and Circular 
Rotor Profile Plot 

 
 

The Unrolled Rotor Profile, Unrolled Stator Profile, and Circular Rotor Profile buttons control the 
visibility of Unrolled Rotor Profile, Unrolled Stator Profile, and Circular Rotor Profile plots. 
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10.9 The Compressor Map Tab (optional) 

The Compressor Map tab contains configuration for how Compressor Map plots are displayed. 

Note that the Compressor Map tab is hidden by default but can be activated from the Start Here 
dialog. 

 
 

From the Compressor Map tab, you can: 

• Show or hide the Compressor Map plot 
 

Go to Advanced Tab 

 

10.9.1 Show or Hide the Compressor Map Plot 

 
 

The Compressor Map button controls the visibility of Compressor Map plots. 

  



 

Page 160 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

10.10 The Advanced Tab 

The Advanced tab contains features of SETPOINT CMS that are typically used by advanced users, 
or that are limited to special applications. 

 
 

The Advanced tab contains configuration for how CMS will show your plots. 

• Show the Attributes Pane 
• Show and filter events on the Events Pane 
• Enable state-based displays 
• Select a state filter 
• Create a Quick View 
• Clear pinned or time-locked plots 
• Show or hide a custom plot title in plot headers 
• Show or hide custom notes in plot headers 
• Show or hide the Asset Path in plot headers 
• Show or hide the time range on plots  
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10.10.1 Attributes (The Attributes Pane) 

 
 

Most points and assets have additional attributes that are stored in the database. Attributes can 
include configuration values, alarm limits, or PI AF analysis results. If Attributes are activated, all 
attributes of the Focused Point are displayed in the corresponding pane on the right. 

In the example below, Attributes of a channel called “Shaft DE Y” are displayed. 

 
 

Attributes may or may not be editable, depending on the type of setting and, in case of an PI/AF 
database, access rights. 

10.10.1.1 Trending Attribute Values 

You can plot Attributes preceded by a checkbox. Checking the box adds the attribute to the Selected 
list. 

 

 

 

 

NOTE! 
If the firmware supports state-dependent alarm limits, these are displayed in the Trend 
as a function of the active machine state. Otherwise, the attribute is displayed as a 
static, unchangeable value. 
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10.10.1.2 Editing Channel Names 

In a CMS file, channel names can be edited to make them clearer when diagnosing machines. 

 

10.10.2 Show and Filter Events (The Events Pane) 

 
 
Click the Events button to open the Events Pane. The Events Pane shows alarm, state and system 
events that occurred within the time range displayed in the Timeline. Note that this time is larger than 
the time range currently selected for analysis. 

You can navigate directly to points and time ranges corresponding to the events directly from these 
lists. 

 

From the Advanced Tab, clicking the 
Events button opens the Events Pane. 
Events will be selected for display based on 
which points are selected. 
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You can filter the event list to only show Danger, Alert, or System events by clicking the buttons 
shown. 

 
All events are shown if no buttons are active. 

 

 

NOTE! 
The Events list is filtered to show events for the selected points. The list will also 
include top level system events. 
 

10.10.3 Enable State Based Displays 

 
 

The State Based button controls whether state-based coloring of analysis plots is activated. Please 
refer to Using Machine States and Manual States for more information. 

10.10.4 Select a State Filter 

 
 

When using Machine States, users can filter the data displayed on the Small Trend and the Large 
Trend using a State Filter. Please refer to Using Machine States and Manual States for more 
information. 
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10.10.5 Create a Quick View 

 
 

Quick views provide a display that is accessible to external applications and systems. Third-party 
applications such as PI Vision or a web page can link to CMS through a URL. Clicking the Quick 
View button will create such a display based on the current state of SETPOINT CMS. 

 

 

NOTE! 
Quick View is only available for AF database and requires the privilege to change  
AF elements attributes. 

10.10.5.1 Creating a Quick View 

Select points and plots needed for your analysis. Click an entry of the Navigation Pane to make it the 
Focused Point. The newly created Quick View will be associated with this element. Finally, click on 
Quick View to open a dialog where an expressive name can be assigned to the Quick View: 

 
 

Click OK. Upon success you will be informed that a Quick View URL has been created and copied to 
your clipboard. 

 
 

Now, you can paste URL from your clipboard into Attribute <Quick View> of the Asset in PI System 
Explorer and this Attribute can later be used to launch the SETPOINT® CMS application and restore 
your original analysis view. 

 
Refer to Section 20.1 for instructions on integrating with PI Vision. 
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10.10.5.2 Export Quick Views to CSV 

From the file menu select Export and the Export Quick Views button to export all quick views to a 
CSV file. 

 
 

A standard file Save dialog prompts you to name the export file. Upon success the CSV file will be 
opened in Excel. 

 

10.10.5.3 Using Quick Views from within SETPOINT CMS 

Quick Views are automatically associated with an entry of the Navigation Pane. You can thus restore 
the display defined by the Quick View from the Quick Views Area of the Navigation Pane. 

Note that plots restored by selecting a Quick View will be pinned. When you are done with working 
with a particular Quick View, you can either select a different Quick or use Clear Pins to remove all 
pinned plots. 
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10.10.6 Clear Pins and Clear Locks 

 
 

The Clear Pins button un-pins all plots that are currently pinned. 

Similarly, the Clear Locks button un-locks all plots that are currently time-locked. 

10.10.7 Show or Hide a Custom Plot Title in Plot Headers 

 
 

The plot title controls allow you to annotate analysis plots with a custom Title that is shown in the plot 
header. This is useful for annotating reports, but you may want to hide this information during analysis 
using the Show Title checkbox to maximize the available plot area. 

 
 
  

Checking Show Title checkbox shows the 
custom Title (“Company: BK Vibro”, in this 
example) in the header of all plots. 
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10.10.8 Show or Hide Custom Notes in Plot Headers 

 
 

Users can add notes to individual plots via the plot settings dialog: 

 
 

The Show Notes checkbox controls whether these annotations are displayed in the plot header. This 
is useful for annotating reports, but you may want to hide this information during analysis to maximize 
the available plot area. 

 

  

Checking Show Notes checkbox 
displays the note defined in the plot 
settings.  Notes are set individually for 
each plot. 
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10.10.9 Show or Hide the Asset Path in Plot Headers 

 
 
By default, SETPOINT CMS will only show the names of the channels that are displayed in the 
individual plots. Select Show Asset Path to display the full asset path instead: 

 

10.10.10 Show or Hide the Time Range 

 
When Show Time Range is active, the plot time range displayed by the plot is displayed near the 
bottom of each plot. 

 
 

Note that this setting does not apply Orbit, Timebase, Orbit/Timebase and Spectrum plots.  

Checking Show Asset Path checkbox 
shows the full asset path in the header 
of all plots. 

 

Checking Show Time Range displays 
the plot time range near the bottom of 
all applicable plots. 
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11 Using the CMS Display Software  

This section lists the basic flow for using the SETPOINT CMS Display Software and discusses typical 
ways to perform tasks. 

The basic flow consists of: 

• First time use: Setting up SETPOINT CMS using Start Here 
• Opening a data source 
• Selecting points for analysis using the Navigation Pane 
• Selecting the data time range 
• Choosing and configuring plots 
• Analyzing the data  
• Documenting your work by creating a report 
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11.1 Setting the Global Time Range and Dynamic Cursor 

CMS uses two key global time parameters for plotting data: 

Selected Time Range:  
Selects a set of data between the Begin Time and the End Time. The Selected Time Range 
sets the data shown in Small Trend, Large Trend, Bode, Polar, Shaft Centerline, Waterfall, and 
Cascade plots. 
 

Dynamic Cursor:  
A specific point in time. SETPOINT CMS uses the Dynamic Cursor time when selecting the 
static data sample for Data Table, filtered Orbit, and filtered Timebase plots. Moreover, 
SETPOINT CMS uses the Dynamic Cursor time when selecting the dynamic (waveform) data 
for Orbit, Timebase, Spectrum Plot, Crank Angle, Displaced Volume, X Y Rod Position, 
Unrolled Rotor Profile, Unrolled Stator Profile, and Circular Rotor Profile plots. Navigating to a 
time from the Events Pane or Reference Data Pane sets the Dynamic Cursor to the event or 
reference time. 

 

You can use the Timeline Pane to select the time range of data you want to analysis. 

 
The Dynamic Cursor can most easily be set from the Small Trend plot, which shows the  
Selected Time Range: 

 

Selected Time Range 

Begin Time readout Duration  Dynamic Cursor         End Time readout 

Begin Time End Time Selected Time Range 

Dynamic Cursor 
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The following options for setting the global time range are supported by SETPOINT CMS: 

• Move to current time or most recent time 
• View data from a specific time range 
• View data around an event or state change 
• Zoom in on selected data 
• Move selected range from the Timeline 

 

 

NOTE! 
SETPOINT® CMS shows date and time in the regional format according to the 
Windows regional settings (Control Panel -> Region -> Formats) 
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11.1.1 Move to Current Time or Most Recent Time 

Click the clock icon to move the selected time range such that the End Time coincides with the most 
recent time available in the selected data source. For online data sources (AF PI, CMS-XC,  
CMS-HD), the most recent time available time is the current time. For offline data sources (CMS-File, 
CMS-SD), the most recent time available is the last data sample within the current database. 

 

11.1.2 View Data from a Specific Time Range 

When you know the time of a machine event you want to analyze, such as a machine startup at  
12 pm on December 1, 2015, use Go To on the Home to navigate directly to that time. 

 

11.1.3 View Data around an Event or State Change 

When you are looking for an event or state change, such as an alarm or machine startup, you can 
automatically set the point and time range from the Events Pane. 

  
  

Clicking on the point name in the event will 
change to that point in the Navigation Pane. 

Clicking on the event time centers 
the Selected Time Range 
around the event time. 
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11.1.4 Zoom in on Selected Data 

Once the selected time range includes the data you want to analyze, there are several ways to zoom 
in or out to see more detail or data before or after the event. 

Using the Zoom In and Zoom Out buttons 
You can also use the Zoom In and Zoom Out buttons to adjust the time range. 

Move the Timeline Handles 

 

Zoom in the Small Trend 
Open the Small Trend from the Trend Tab. Drag the mouse across the Small Trend to rubber-band 
zoom on a section of data. 

 
  

Click either the Begin Time or End Time and 
drag to adjust the selected time. 

Zoom in further on a specific time range by 
rubber band zooming in the Small Trend. 
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Zoom on the Large Trend 
Open the Large Trend from the Trend Tab. Drag the mouse across the Large Trend to rubber-band 
zoom on a section of data. 

 

11.1.5 Move Selected Range from the Timeline 

If the data of interest is shown in the Timeline, but not Selected, you can use the time slider control to 
adjust the Begin Time and the End Time simultaneously. 

 
 

 
Alternatively, you can increase the selected time range by any of the methods discussed in the 
previous sections. 

Zoom in on a specific time range by rubber 
band zooming on the Large Trend plot. This 
set the global time range to the selected 
region. 

The machine startup data you want is visible 
in the Timeline, but is not in the selected 
region.  You need to change the selected 
time range to include the startup. 

Click on the slider control and drag the selected 
time window to the left.  This changes the Begin 
Time but keeps the duration the same. 
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11.1.6 Discover Data not Shown in the Timeline 

In the example below, the Timeline is not showing the shutdown that occurred several days before 
the current period of non-operation: 

 
 

 

Increasing the time range size will show more days in the timeline: 

 
 

Alternatively, slide the time range control all the way to the left or right to view data from an older or 
newer time period. 
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11.2 Plots 

After navigating to a point, clicking the plot buttons the respective ribbon tab open that plot type for 
the selected points. 

The plot buttons and their location are shown below, followed by descriptions of each available plot 
type. 

Plot Ribbon Tab 
Location 

Description 

 

Home The Data Table displays static measurement values in a tabular view. 

 

Trend The Large Trend plot shows static measurement values as a function of time. 

 

Timebase The Orbit plot is a two-dimensional path of shaft centerline motion as viewed from 
an orthogonal transducer pair (XY). 

 

Timebase The Timebase plot is the instantaneous amplitude plotted as a function of time. 
Single or multiple channels can be displayed simultaneously, whether from the 
same bearing or multiple bearings. 

 

Timebase Selecting the Orbit and Time buttons simultaneously will show a combined 
Orbit/Timebase plot that shows the orbit and the corresponding waveforms side by 
side. 

 

Transient The Bode plot allows you to view the 1X, 2X, or nX forward vector amplitude and 
phase as a function of shaft rotational speed. 

 

Transient The Polar plot shows vector amplitude and phase data plotted on polar 
coordinates. 

 

Transient The Shaft Centerline plot shows the movement of the shaft average centerline 
position over time, which is useful in particular in the transitional phases). 

 

Spectrum The Spectrum Plot allows you to view the vibration amplitude as a function of 
frequency in either half or full spectrum formats which displays the precession. 

 

Spectrum The Waterfall plot shows spectrums collected over a period of time as a function 
of time (it will be used on nominal statements instead). 

 

Spectrum The Cascade plot shows spectrums collected as a function of speed, (it will be 
used instead for transient states). 
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Plot Ribbon Tab 
Location 

Description 

 

Recip The Crank Angle button plots reciprocating compressor measurements as a 
function of the compressor crank angle position. 

 

Recip The Displaced Volume plot displays reciprocating compressor measurements as a 
function of the compressor cylinder displaced (swept) volume. 

 

Recip The X Y Rod Position plot shows reciprocating compressor X-Y rod position. 

 

Hydro The Unrolled Rotor Profile plot displays the profile of the rotor of a hydroelectric 
generator based on the data from a single Air Gap sensor. Measurements are 
evaluated by the distance (gap) between rotor and stator and are plotted versus 
pole numbers. 

 

Hydro The Unrolled Stator Profile visualizes deviations of the stator of a hydroelectric 
generator from a perfectly circular shape. To this end, it displays the distance 
(gap) of multiple Air Gap sensors to a reference rotor pole. 

 

Hydro The Circular Rotor Profile plot displays the profile of the rotor based on the data 
from one or multiple connected Air Gap sensors. Measurements are evaluated by 
the distance (gap) between rotor and stator. 

 

Compressor 
Map 

The Compressor Map plot shows the operating point, surge control line, and surge 
limit line for a centrifugal or axial compressor. 
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11.2.1 Large Trend 

The Large Trend plot shows static values plotted against time. 

 

 

When analyzing a trend plot you can: 

• Change the time range 
• Auto Scale the Y axis 
• Manually scale the Y axis 
• Zoom in on a section of data 
• Use cursors to see the values 
• Show when signals entered and 

exited alarms 

• Visualize state changes/markers 
• Change which channels show 
• Change which measurements show 
• Plot alarm set points on the Trend 
• Change the sequence of traces 

 

 

 

NOTE! 
You can also quickly hide or show Trend traces. Click on the trace name in the legend 
to hide the trace. The trace name will be greyed out. Click it again to show the trace. 

 
Go to Plots overview 

  

Begin Time End Time 

Alarm annotations 

Points and values 
at the cursor time 

Cursor and 
cursor time 



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 179 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

11.2.1.1 Selection of Primary and Secondary Scales 

The Large Trend plot can combine data with different scale types (such as Displacement and Speed), 
and thus contains three types of Y-Axis scales (cf. screenshot above): 

• The primary Y-Axis is displayed on the left. It preferentially shows the range of vibration data if 
present 

• If data with least two different units is currently visible, the secondary Y-Axis is displayed on 
the right. It preferentially shows the speed range of the selected data if present 

• If data with more than two different scale types is visible, one or multiple tertiary Y-Axis scales 
are diplayed. For these, only the minimum and maximum scale value is shown as an overlay 
on the plot. 

SETPOINT CMS allows users to customize the Y-Axis selection using the Set Left Axis and Set 
Right Axis commands. These options are available from the plot context menu that can be accessed 
by right-clicking the plot, or by clicking on the ellipsis in the upper right plot corner. The currently 
selected Left/Right Axis is marked by a checkmark. Click on another entry to change the selection. 

 
 

In the following example, °F (Temperature) has been set as Left Axis, and mil pp has been set as 
Right Axis. The RPM Speed range has thus been auto-selected as a tertiary scale. 
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11.2.2 Data Table 

The data table shows the measurement numerical values (all) for the selected points at the dynamic 
cursor position. 

It also displays the status of alarms are enabled. The order of the traces shown in the table can be 
changed by the Point Order combo box on the Home tab. 

 
 

Go to Plots overview 
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11.2.3 Orbit Plot 

The Orbit Plot shows the dynamic shaft motion (waveform) in relation to a pair of orthogonal 
transducers. 

 
You can adjust your Orbit plot using these options: 

• Filtering to 1X, 2X or nX components 
• Compensate 
• Adjusting the number of Revolutions 

shown 
• Show asynchronous data 

• Manually scale the X and Y axis 
• Auto Scale 
• Change the Machine Orientation 
• Overlay Data

 
Go to Plots overview 

 

 

NOTE! 
If only one channel of an XY Pair is selected, CMS will find the paired sensor and plot 
the Orbit. 

Probe Locations 

Rotation Direction 

Blank-Bright indicates 
phase trigger marks and 
shows the direction of 
precession. 

Machine 
Orientation 
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11.2.4 Timebase Plot 

The Timebase plot shows the dynamic transducer signal (waveform) plotted against time similar to 
the presentation that would be seen on an oscilloscope. 

 
 

You can adjust your Timebase plot using these options: 

• Filtering to 1X, 2X or nX components 
• Compensate 
• Adjusting the number of Revolutions 

shown 
• Show asynchronous data 

• Manually Scale the Y-Axis 
• Auto Scale 
• Zoom in on a section of the plot 
• Overlay Data 

 
Go to Plots overview  

Speed, probe orientation, amplitude, time and 
date when the data was stored. 

Blank-Bright indicates 
phase trigger marks. 
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11.2.5 Orbit/Timebase Plot 

The Orbit/Timebase plot shows both the Orbit and Timebase plots for the XY channel pair. 

 
You can adjust your Orbit/Timebase plot using these options: 

• Filtering to 1X, 2X or nX 
components 

• Compensate 
• Adjusting the number of 

Revolutions shown 
• Show asynchronous data 

• Manual Scale 
• Auto Scale 
• Change the Machine Orientation 

Reference 
• Overlay Data 

 
Go to Plots overview  

Channel amplitudes, if 
filtered, vectors. 
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11.2.6 Bode Plot 

The Bode plot shows 1X, 2X, or nX vector amplitude and phase as a function of shaft rotational 
speed. 

 
 

When analyzing a Bode Plot, you can: 

• Show 1X, 2X, and/or nX data 
• Show Direct data 
• Compensate 
• Auto Scale the speed and amplitude axis 
• Manually set the speed and amplitude axis 
• Overlay Data 

 

 

NOTE! 
You can also quickly hide or show Bode traces. Click on the trace name in the legend 
to hide the trace. The trace name will be greyed out. Click it again to show the trace. 
 

 
Go to Plots overview  

Speed and Cursor Time 
Point name and orientation 
Measurements and overlays, with values at cursor time. 
 

Phase Lag 

Amplitude 
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11.2.7 Polar Plot 

The Polar plot shows vector amplitude and phase data plotted on polar coordinates. 

 
When analyzing Polar plots, you can: 

• Show 1X, 2X, or nX data 
• Compensate 
• Auto Scale the speed and amplitude axis 
• Manually set the speed and amplitude axis 
• Overlay Data 
• Label points with speed or time 

 
Go to Plots overview  

Speed and Time at cursor 
Point name, orientation 
Amplitude and Phase at cursor 

Compensation 
vector applied 

Rotation 
Direction 

Begin Time                                                                        End Time 

Phase Trigger 
Orientation 

Machine Speed 
at point 
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11.2.8 Shaft Centerline Plot 

The Shaft Centerline plot shows the movement of the average shaft centerline position over time, or 
shaft rotational speed. The average centerline position is determined from XY displacement probe DC 
gap voltages. 

     
 

The Shaft Centerline plot requires configuration of the: 

• plot start point (initial gap) 
• clearance boundary 
• shaft reference location 

 

When analyzing a Shaft Centerline plot, you can: 

• Machine Orientation 
• Overlay Data 
• Label points with speed or time 

 
Go to Plots overview 

  

Probe Locations 

Rotation of 
Direction 

Speed and positions 
at the cursor time 

Plot Unit 

Speed (or sample 
time) bubbles 

Bearing clearance 
circle/ellipse 
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11.2.8.1 Setting the Start Reference (Initial Gap) 

The Shaft Centerline plot will default to setting the first sample in the time range to the plot zero 
location. Alternatively, you can plot the data with the zero position at a set gap reference location. 

To set a starting reference: 

1. Set a reference sample for the dataset. 

2. Choose the reference sample as the “gap” reference. 

3. CMS will draw the shaft absolute plot starting at the gap value of the selected reference 
sample. 

11.2.8.2 Setting the Shaft Reference Location 

The shaft reference location (or start position) sets where to begin plotting the shaft centerline 
movement and represents the plot origin (0,0). Set the start position from the Plot Settings Pane. 
Typical options for exemplary machine orientations are given in the table below. 

 

Machine Orientation Typical Shaft Reference Location 

Horizontal Bottom 

Vertical Center 

Overhung Rotor Top 
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Bottom: 

 

Top: 

 
 

Center: 

 
 

 

NOTE! 
Autoscaling the shaft absolute plot can cause the bearing clearance to be outside the 
plot scales and to not be shown. 
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11.2.9 Spectrum Plot 

This screen allows you to view the vibration amplitude as a function of frequency (FFT: Fast Fourier 
Transform), in either half or full spectrum formats in a pair of X-Y channels. 

Example here: Full-Spectrum 

 
The Spectrum plot allows the configuration of the following elements: 

• Change the number of spectral lines shown 
• Change the windowing 
• Show data in orders of running speed or frequency 
• Show the full spectrum 
• Integrate velocity or acceleration spectra 
• Overlay Data 
• Show Bearing Cursors 
• Configure Spectral Bands 

 
The X axis scaling always uses the manual scales. You can auto scale or manually scale the Y axis. 

 
Go to Plots overview  

Plot Speed and Time 
Channel Names, Cursor X position 
resolution, Windowing 
Data values at cursor 
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11.2.10 Waterfall Plot 

The waterfall plot shows spectrums collected over a period of time as a function of time (Z-Axis). 

Example here is a Waterfall using Full Spectrum: 

   

 

 

NOTE! 
The Waterfall plot is limited to 3200 lines. 
 

 
When analyzing waterfall plots, you can: 

• Change the spectrum resolution 
• Change the maximum number of 

spectrums shown 
• Apply windowing 
• Plot with the x axis in orders or 

frequency 
• Plot full or half spectrum 
• Show plot walls 

• Integrate velocity spectrums to 
displacement or acceleration 
spectrums to velocity 

• Auto or manual scale 
• Rotate the plot 
• Enlarge or shrink the plot 
• Reset the plot to the default view

 
Go to Plots overview  

Z-Axis: Time 

Plot Speed and Time 
 
Channel Names, Cursor X 
position resolution, Windowing 
 
Data values at cursor 
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11.2.11 Cascade Plot 

The Cascade plot shows spectrums (half or full) collected over a certain time period depending on 
changes in speed (Z-Axis). 

Example here is a Cascade using Full Spectrum: 

 

 

 

NOTE! 
The Cascade plot is limited to 3200 lines. 
 

 
When analyzing Cascade plots, you can: 

• Change the spectrum resolution 
• Change the maximum number of 

spectrums shown 
• Apply windowing 
• Plot with the x axis in orders or 

frequency 
• Plot full or half spectrum 
• Show plot walls 

• Integrate velocity spectrums to 
displacement or acceleration 
spectrums to velocity 

• Auto or manual scale 
• Rotate the plot 
• Enlarge or shrink the plot 
• Reset the plot to the default view

 
Go to Plots overview

Plot Speed and Time 
 
Channel Names, Cursor X position 
resolution, Windowing 
 
Data values at cursor 

Z axis: Rotational speed 
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11.2.12 Crank Angle Plot 

The Crank Angle plot shows vibration and pressure data as a function of the degrees of rotation of the 
crankshaft (Crank Angle) of a recipocrating compressor. An angle of 0° is defined as the Top Dead 
Center (TDC) position of the piston inside the given cylinder, whereas 180° corresponds to the 
Bottom Dead Center (BDC). 

When selecting vibration channels associated with a cylinder throw (cf. section 7.6), one Crank Angle 
plot per vibration channel will be created, where the upper part displays segmented vibration data 
(see next page). 

 

 
With the Crank Angle plot, you can: 

• Adjust the number of revolutions shown 
• Show or Hide Gas Force, Inertial Force and/or Rod Load 
• Manual Scale 
• Auto Scale 
• Overlay Data 

 
Go to Plots overview  

Segmented vibration data 

Dynamic vibration and pressure 
data versus Crank Angle, starting 
at the TDC of the piston. 
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11.2.12.1 Segmented Vibration Data 

When selecting vibration channels associated with a cylinder throw, segmented vibration data can be 
plotted versus Crank Angle segments. 

 

 

NOTE! 
Please refer to section 7.6 for advice on setting up your VC-8000 for analysing data 
from reciprocating machinery. Vibration data will not be visible on the Crank Angle plot 
when not configured accordingly. 

 
For acceleration and velocity data, 36 segment values per revolution are calculated from the 
waveform data. Each segment value is then given by the the root mean square (with respect to the 
segmentwise average) over 10° of crank rotation. For rod position data, 8 segment values per rotation 
are calculated. Each segment value is then given by the maximum peak-to-peak distance over 45° of 
crank rotation. 

 

 

NOTE! 
Segmented data displayed on the Crank Angle plot is computed from the unfiltered 
synchronus waveform. This allows for a detailed analysis of the condition of 
reciprocating machinery. For machine protection, on the other hand, segmented 
measurements must be based on filtered synchronous data in order to avoid spurious 
machine shutdowns. Segmented measurement data provided by the VC-8000 may 
thus be lower than corresponding values displayed in the Crank Angle plot. 
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11.2.13 Displaced Volume Plot 

The Displaced Volume plot shows pressure data as a function of displaced (swept) cylinder volume, 
given in percent. A volume percentage of 0% is defined as the Top Dead Center (TDC) position of the 
piston inside the given cylinder, whereas 100% corresponds to the Bottom Dead Center (BDC) 
position. 

Optionally, dynamic pressure data can be compared to the theoretical pressure curve assuming 
adiabatic conditions. The theoretical curve is a useful tool when diagnosing compressor faults. Note 
that the Isentropic Exponent of the compressed gas and the physical Cylinder Clearance of the 
cylinder need to be configured to get meaningful results (see next page). 

 

 

 
With the Displaced Volume plot, you can: 

• Show or hide the adiabatic curve 
• Manual Scale 
• Auto Scale 
• Overlay Data 

 
Go to Plots overview  

Optional theoretical pressure 
curve for reference. 

Dynamic pressure data versus 
percentage of displaced volume. 
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11.2.13.1 Configuring the Adiabatic Curve 

In order to use the adiabatic curve as a tool for analysis, you must configure the Isentropic 
Exponent of the compressed gas mixture. Use an Equation of State solver (purchased or available 
on the Internet) to calculate the isentropic exponent for the head and crank chambers. 

Moreover, the physical Cylinder Clearance has to be defined. This value is expressed as a 
percentage defined by the ratio of the unswept cylinder volume (also called clearance volume) to the 
swept cylinder volume. 

Both values can most easily modified from the Plot Settings of a Crank Angle plot: 
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11.2.14 X Y Rod Position Plot 

The X Y Rod Position plot visualizes the absolute movement of the piston rod connected to a cylinder 
within a recipocrating compressor. For that purpose, it makes use of data from an orthogonal pair of 
rod position channels (one horizontal, one vertical). 

 

 

NOTE! 
If only one channel of a rod position channel is selected, CMS will find the paired 
sensor and create the X Y Rod Position plot. 

 
With the X Y Rod Position plot, you can: 

• Adjusting the number of Revolutions shown 
• Show Alarm Limits 
• Manual Scale 
• Auto Scale 
• Overlay Data 

 
Go to Plots overview  

Horizontal Channel 

Danger Setpoint Alert Setpoint 

Rod Position 

Vertical Channel 
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11.2.15 Unrolled Rotor Profile Plot 

The Unrolled Rotor Profile plot displays the physical gap between the rotor and the stator of a 
hydroelectric generator, based on the rotor profile waveform of a single Air Gap channel.  

 

The plot is thus very similar to a Timebase Plot of the same data, with two important differences: 

• The X-Axis is given in terms of rotor poles, starting from pole 1 
• If the rotor profile waveform contains two or more revolutions, the minimum gap value per pole 

across all revolutions is shown 

You can adjust your plot using these options: 

• Manually Scale the Y-Axis 
• Auto Scale 
• Zoom in on a section of the plot 
• Overlay Data 

 
Go to Plots overview 

  

Pole Axis 

Per pole air gap data as recorded 
in the rotor profile waveform 

Speed, timestamp, 
and cursor value 
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11.2.16 Unrolled Stator Profile Plot 

The Unrolled Stator Profile plot visualizes the shape of the stator of a hydroelectric generator by 
combining rotor profile waveform data from multiple Air Gap sensors. In particular, the pole 1 gap for 
the individual sensors is plotted as a bargraph, where the X-Axis location is given by the angle of 
rotation of this pole as it passes a given sensor. As a result, the differences in the pole 1 gap 
measured by different sensors can be compared at a glance. 

 

If the individual rotor profile waveforms contain two or more revolutions, the minimum pole 1 gap 
value per sensor across all revolutions is shown. 

You can adjust your plot using these options: 

• Manually Scale the Y-Axis 
• Auto Scale 
• Overlay Data 

 
Go to Plots overview  

Angle between phase trigger and 
sensor mounting location, 
measured in direction of rotation 

Pole 1 air gap as recorded in the 
rotor profile waveforms for the 
individual sensors 

Speed, timestamp, sensor 
name and cursor value 
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11.2.17 Circular Rotor Profile Plot 

The Circular Rotor Profile plot presents the physical gap between the rotor and the stator of a 
hydroelectric generator on a circular canvas. It makes use of the rotor profile waveforms of one or 
multiple Air Gap channels. Minimum and maximum poles are highlighted on the rotor profiles. Sensor 
locations are marked around the outer circle. The order of the displayed angles (outside of the circle) 
and pole numbers (drawn within the plot) follow from the configured rotation direction and pole 
number direction. 

The following plot shows an example where the rotation is clockwise, and the pole numbering is 
counterclockwise: 

 
Alert and danger limits are drawn on the plot to visually track how close a pole is to a setpoint.  

While moving the mouse from pole to pole, each area is highlighted. When selecting a pole, the 
following readout is presented on the right or the top pane of the plot: 

• Rotating speed and timestamp 
• The gap values of each sensor at the selected pole. If the rotor profile waveforms contain two 

or more revolutions, the minimum gap value per pole across all revolutions is shown 
• Selected pole index and the number of total poles (example 1/24) 
• Alarm limits which are defined by the Minimum Air Gap under same Air Gap channel 

You can adjust your plot using these options: 

• Manually Scale the Y-Axis 
• Auto Scale 
• Overlay Data 

 
Go to Plots overview  

Sensor 
Marker 

Angle 

Pole 
Readout 

Min/Max 
Pole 

Danger/Alert Limit 

Selected 
Pole 
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11.2.18 Compressor Map Plot 

The Compressor Map plot shows the operating point, surge control line, and surge limit line for a 
centrifugal or axial compressor. 

 
 

 

 

NOTE! 
Using Compressor Map plots required a specialized setup. Please contact your  
Brüel & Kjær Vibro service representative if you are interested in using this plot type. 
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11.3 Analyzing the Data 

This section describes various tasks you can perform while analyzing your data. These include: 

• Scaling Plots automatically or manually 
• Paging through plots 
• Zooming in on a plot 
• Maximizing the plot area 
• Popping out a plot to a full screen window 
• Rotating and Sizing Waterfall and Cascade Plots 
• Using cursors 
• Using overlays 
• Viewing live data 
• Playing back recorded data 
• Changing plot settings 
• Viewing alarm markers 
• Displaying alarm levels on Trend plots 
• Adapting the channel ordering 
• Compensating the data 
• Selecting a compensation sample 
• Pining plots 
• Time-locking plots 
• Using machine states and manual states 
• Resolving error messages 
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11.3.1 Scaling Plots 

SETPOINT CMS can scale plots automatically or manually. 

Auto Scale 
When using Auto Scale, SETPOINT CMS selects the best axis scales to optimize the data 
presentation for the plots. This is recommended for most applications. Automatic scaling is available 
for the Y-Axis of all plot types and units. Note, however, that the X-Axis of Spectrum, Waterfall, and 
Cascade plots is always scaled manually. 

SETPOINT CMS can scale each plot independently (Normal) or all plots of the same type together 
(Compare Plots). When scaling in Compare Plots mode, the scale will automatically adjust to the 
size of the largest values viewed in the plot. 

Manual Scale 
When Auto Scale is deactivated, SETPOINT CMS defaults to the global manual scale limits defined in 
the Manual Scales pane. Here, manual limits can be defined per plot type and per scale type (e.g., 
Acceleration, or Speed): 

 

 

Note that SETPOINT CMS can handle measurement data in units that are not listed in the 
Manual Scales pane. Corresponding traces will always be scaled automatically. 

  

You can set the Maximum for each 
plot type and each scale type.  When 
Auto Scale is turned off, plots using 
the given unit will scale to the set value. 
 
Minimum values are used only on the 
Trend and Reciprocating Compressor 
plots. Unused Minimum cells will be 
disabled. 
 
Some plots like Orbit/Timebase, Shaft 
Centerline, Rod Position use Range 
instead of Maximum. 
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Individual plots, on the other hand, can be scaled manually (Per Plot Scaling) from the plot settings 
dialog: 

 
 

Note that this option is only available when Auto Scale is turned off. 

 

 

NOTE! 
Per plot scaling is not supported on Large Trend, Crank Angle and Displaced Volume 
plots. 
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11.3.2 Paging Plots 

This section describes the ways to page through the plots. 

For an overview over existing pages, open the Pages pane. You can also page plots or open the 
Pages pane using the controls at the lower left of the screen as shown below. 

 

11.3.2.1 Paging through Plot Types for a Group of Channels 

Follow these instructions when you want to view the same plot type for several channels. 

 

 
1) Select the plot types you want to compare. 

2) Set the number of plots shown on a page to 2 or 4. 

3) Use the Pages Pane to page through the plots. 

  

Click on the right or left arrows at the bottom of the screen to page 
to the next or previous plot. The arrows are not active if there is 
only one plot page. You can also use the Alt key and the left and 
right arrow keys to page plots. 

Click on “Page” to open up the Pages Pane. The Pages Pane 
shown below gives a preview of the plots on each page and allows 
quick navigation between pages. 

Select the points or bearings that you want to 
view using the Navigation Pane. 
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11.3.2.2 Paging through different plots for a channel or bearing 

To page through the various plot types for a single channel or bearing follow the links for these steps: 

 
1) Select the channel or bearing using the Navigation Pane. 

2) Activate the desired plots. 

3) Use the Pages Pane or the page arrows to page through the plots. 

 

11.3.2.3 Get Two Plots Next to Each Other for Comparison 

There are several ways to get two plots next to each other for comparison. 

If the plot types are different but are on the same channel, you can remove unwanted channels from 
the selected data.  

Example: Put Orbit/Timebase and full spectrum side by side for a bearing: 

1) Use the Navigation Pane to select the bearing and remove other points from the selected 
data list. 

2) Select two plots per page. 

3) Turn on Orbit, Timebase, and Spectrum plots and turn the other plots off. 

4) Set the spectrum for Full Spectrum. 

If the plots are the same type but on different channels: 

1) Use the Navigation Pane to select the desired channels and remove other points from the 
selected data list. 

2) Select two plots per page. 

3) Turn on the plot type you want and turn the others off. 

If the plots are of different types and on different channels: 

1) Pin the plots that you want to compare. 

2) Select two plots per page. 

3) Turn off all plot types so only the pinned plots display. 
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11.3.3 Zooming in on a Plot 

You can rubber-band zoom on the Timebase, Shaft Centerline, and Spectrum plots as shown: 

 
 

Alternatively, you can use the mouse scroll wheel to zoom in or out on these plot types. 

  

Drag the cursor 
across the plot to 
select an area to 
zoom in on. 
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11.3.4 Increasing the Plot Area 

You can increase the area available for viewing plots by: 

• Collapsing the ribbon 
• Hiding panes, e.g., the Navigation Pane 
• Hiding the Timeline 
• Hiding the Small Trend 

 

The following figure shows the plot area maximized: 

 
 

Alternatively, you can display a single plot in a separate, full screen window. 
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11.3.5 Popping Out a Plot to a Full Screen Window 

You can quickly expand a plot to fill the full screen by clicking the full screen icon. Hover the cursor 
over the plot to show the plot controls in the plot upper right corner. Then click the Pop Out Plot 
button: 

 
 

The newly created window can be moved and resized: 

 
 

If full screen window has already been opened, popping out another plot will replace the currently 
displayed. 

Press the Escape (ESC) key to exit full screen mode. 
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11.3.6 Rotating and Sizing Waterfall and Cascade Plots 

You can rotate and size the Waterfall and Cascade 3D plots, which first load in the selected  
default view. 

 

 

To restore a 3D plot to the default rotation, hover the cursor over the plot to show the plot controls in 
the plot upper right corner. Then click Reset Zoom. 

 
 

To change the size of the plot, click Zoom In or Zoom Out in the same menu. Alternatively, use the 
mouse scroll wheel. 

  

To rotate a plot, click outside the plot 
area and move the mouse. 
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11.3.7 Using Cursors 

Cursors provide you with a numerical readout of the value at a specific point on the plot. Click on plot 
to activate a Single cursor. This type of cursor is available on all plot types. 

Use the right/left arrow keys to move the cursors to the right or left. Hold down the arrow key to move 
the cursor faster. 

Each plot in the main plot area has individual cursor that generally point to different points in time, 
speeds, or frequencies. You can synchronize the cursors time with other plots in two ways: 

Synchronizing Cursors using Set Cursors 
Click the Set Cursors button at the bottom of the screen to move the cursor on Large Trend, Bode, 
Polar, Shaft Centerline, Waterfall, and Cascade plots to the dynamic cursor time. 

 

Synchronizing Cursors from a Plot Header 
You can synchronize the cursor times of all active Large Trend, Bode, Polar, Shaft Centerline, 
Waterfall, and Cascade plots by clicking on the time readout in the plot header: 

 
 

Note that this will also move the dynamic cursor time to the same position. 
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11.3.7.1 Difference Cursors 

Difference Cursors are supported on Large Trend, Timebase and Spectrum plots. To activate the 
Difference Cursor, click on the corresponding entry in the plot context menu: 

 
 

This will add a secondary cursor line and a corresponding readout to the plot: 

 
 

The secondary line maintains its distance to the primary cursor line when being move. Grab the 
secondary cursor line and move it to change the distance between the cursor lines. 

  

Primary cursor line (red) 

Secondary cursor line 

Extended cursor readout including the difference 
between the values at the individual cursor lines. 
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11.3.7.2 Harmonic and Sideband Cursor 

Harmonic and Sideband Cursors are supported on Spectrum plots only. To activate the Harmonic 
Cursor or the Sideband Cursor, click on the corresponding entry in the plot context menu: 

 
In both cases, cursor readouts will be presented in a side pane. Grab individual cursor lines to change 
the cursor position and the distances between the cursor lines. 

Harmonic Cursor 

 

Sideband Cursor 
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11.3.8 Using Overlays 

You can overlay a selected data set on the plot along with the currently selected data. The overlay 
function uses reference data samples. To overlay data: 

 

1. Add a reference data sample for the data you wish to overlay. 

2. Select the reference data sample you want to overlay. 

3. Activate Overlay. 

 

 

 

  

Selected Overlay reference 
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When Overlay is active, the waveform from the selected reference time will be plotted along with the 
current waveform: 

 
 

You can activate overlays simultaneously to viewing live data. This is very useful with Bode, Polar, 
and Shaft Centerline plots for comparing the current live values with a reference: 

 

 
  

Header shows data for both current 
and reference waveforms. 
 
Hover over a trace to identify current 
and overlay waveforms. 
 
Current waveform. 
 
Reference waveform. 

Cursor shows values for both current 
and overlay waveform. 

Current live data. 
 
Reference data. 
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11.3.9 Viewing Live Data 

Clicking the Running Man button at the bottom of the screen causes all of the plots to update 
automatically as new data is loaded into an online database (AF PI, CMS-XC, or CMS-HD). 

 
 

Click the square Stop button to stop live mode. 

 
 
 

 

NOTE! 
When viewing live data, plots are updated every 2 seconds. If the data is changing 
rapidly, when you exit live mode, you will see additional information filled in from the 
historical database. 
 

 
 

 

NOTE! 
In live mode, Cascade and Waterfall plots will stop updating when they reach the 
displayed waveform limit. Increase the number of displayed waveforms or decrease the 
selected time range to resume updates. 
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11.3.10 Playback Function 

In playback mode, the software takes the selected time range and plays the data back from dynamic 
cursor time to end time. To start playback, click on the Play button at the bottom of the screen. 

 
 

You can speed up the playback by repetitively clicking the playback button. The playback button 
changes to indicate the playback rate: 

Icon Description 

 
Data plays back in real time. 

 
Playback is sped up by a factor of 4. 

 
Playback is sped up by a factor of 16. 

 

Playback starts from the dynamic cursor location. Click the square Stop button to stop playback 
mode. 
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11.3.11 Changing Plot Settings 

SETPOINT CMS requires various pieces of information about a point to correctly display and 
annotate plots. For example, the Shaft Centerline plot requires bearing clearances in order to place 
them on the plot. SETPOINT CMS stores this information within the active database. 

The Plot Settings dialog can be opened by right clicking a plot, or by clicking on the ellipsis in the 
upper right corner of a plot (only displayed when hovering the plot). The icon is grayed out if there are 
no configurable settings for this particular plot. 

 

 
An exemplary Plot Settings dialog looks as follows: 

 
 

The Plot Scales setting can be used for Per Plot Scaling. 

  

To edit plot settings, hover over the plot 
until the icons appear in the upper right 
plot corner and click the ellipsis icon. 
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Which settings are available from this dialog depends on the individual plot types and, if applicable, 
on the configuration of the AF-PI database. Typical settings include: 

Setting Description Applicable Plot 
Type 

Horizontal Bearing Clearance The bearing clearance in the horizontal direction. Shaft Centerline 

Vertical Bearing Clearance The bearing clearance in the vertical direction. Shaft Centerline 

Shaft Reference Location The location in the bearing where the shaft is when the 
machine is at rest: Top, Bottom, or Center. Shaft Centerline 

Machine Orientation 

Provides a reference designation to where 0 degrees is. 
For a horizontal machine this will typically be “Up”. 
However, for a vertical machine the orientation may be 
another designation such as “North”. 

Shaft Centerline, 
Orbit 

Alert Level Plots a circular region corresponding to the entered 
alert level. Rod Position 

Danger Level Plots a circular region corresponding to the entered 
danger level. Rod Position 

Notes Free text field for plotting a note on the plots. The notes 
are unique for each plot. All 
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11.3.12 Viewing Alarm Markers 

You can view measurement alarm status using markers on the Trend plot or using the Data Table. 

 
 

Activate Data Annotations to show markers on Small Trend and Large Trend plots that show a 
change in the measurement alarm status. This is a powerful tool that graphically shows which 
channels entered alarm first (First Out) and the following alarm sequencing. 

 
 
 

 

NOTE! 
The markers are only shown if there are alarms configured for the measurements used 
by the plot and Data Annotations are active. For example, the Trend plot showing only 
1X amplitude and phase and will only show alarm markers if there are 1X amplitude or 
phase alarms configured. 

 

 

NOTE! 
If multiple alarms occur at the same time (for example, a rapidly increasing vibration 
exceeds the alert and danger setpoints simultaneously) only the most severe status is 
shown. 

 

Markers in the data table cells indicate 
the alarm status. 

Yellow: Entered Alert State.  

Yellow: Exited Danger State 
(Re-entered Alert State) 
 
Green: Entered Normal State 
(Exited Alert State) 

Red: Entered Danger State 
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NOTE! 
Alarm markers include the configured alarm time delay. If a machine transitions rapidly 
from no alarm through both alert and danger levels, danger may be indicated before 
alert (if alert has a longer configured time delay). 

 
The Data Annotations setting also controls whether state markers are displayed on Small Trend and 
Large Trend. 
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11.3.13 Plot Alarm Levels on Trend 

You can plot alarm limits on Small Trend and Large Trend plots. 

To add an alarm level to a plot, open the Attributes Pane. In the Navigation Pane, expand the  
asset path until you get to the measurement where the alarm levels are set. Click the alarm levels to 
select them. 

The following example shows how to add traces representing the configured Alert Over and  
Danger Over limits to the plot: 

 

 

 

The figure below shows that the defined alarm limits are presented on the plot. In this example, the 
alarm limits for the blue measurement are displayed. This measurement does not exceed the alarm 
limits, so no alarm is marked here for this trace. 

  
  

Danger Level 
Alert Level 
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11.3.14 Adapting Channel Ordering in the Navigation Pane 

The Point Order setting defines how plots and Data Table entries are sorted. However, this setting 
does not influence the order of points in the Navigation Pane. This is due to the hierarchical nature of 
tree display which requires more information to sort entries and sub-trees properly. 

As a result, SETPOINT CMS orders Navigation Pane entries alphabetically based on the Description 
field. By default, CMS loads the Description field with the point name such that the default point 
order is alphabetical by point name. You can change the point order by prepending a numerical value 
at the beginning of the Description field, as shown in the table below. For example, to number the 
channels for 2 bearings down a machine train, you could append the highlighted numbers: 

Bearing Channel  Description Field 

Driver Outboard 1 1.1 Driver OB RV X 

2 1.2 Driver OB RV Y 

Driver Inboard 3 2.1 Driver IB RV X 

4 2.2 Driver IB RV Y 

 

Adding the highlighted numbers in the Description field as shown will cause these points to be 
ordered from outboard bearing to inboard, X then Y. If two channels have the same number 
appended, these two channels will be ordered alphabetically using the text following the numbers. 

A good scheme to follow is to number in a hierarchy from highest to lowest level separating each level 
with dot. For example: 

1. Machine 

1.1 Case 

1.1.1 Bearing 1 

1.1.1.1 X Probe 

1.1.1.2 Y Probe 

1.1.2 Bearing 2 

1.1.2.1 X Probe 

1.1.2.2 Y Probe 
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NOTE! 
You will need to reload the database (e.g., by closing and reopening SETPOINT CMS) 
to see the channel ordering change. 
 

  

Append numerical values to the 
Description field to order the channels 
from lowest number to highest. 
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11.3.15 Compensation 

Compensation allows you to remove unwanted noise content from the signal you are analyzing. 
Removing mechanical and electrical runout, scratches, or shaft bow enhances the clarity the dynamic 
shaft information. This section discusses the supported types of compensation, and the steps to 
configure and use them. 

SETPOINT CMS cam perform three types of compensation: Slow Roll, Waveform, and Gap 
compensation. 

The basic steps to using compensation are: 

• Creating one or more reference data samples 
• Select the sample to use for compensation 
• Turn on/off compensation 

11.3.15.1 Slow Roll (Vector) Compensation 

Compensation applied to filtered Timebase, filtered Orbit, Polar, and Bode plots uses Slow Roll (or 
“vector”) compensation. Slow Roll compensation subtracts the selected reference vector from the 
vibration vector, and plots the data based on the resulting vectorial difference. 

11.3.15.2 Waveform Compensation 

You can apply Waveform compensation to any dynamic data plot collected synchronously. This 
includes the Orbit and Timebase (for synchronous waveforms), as well as Spectrum, Cascade, and 
Waterfall plots (that are in orders of running speed). 

Waveform compensation subtracts the reference waveform from the current waveform  
sample-by-sample and is very effective at removing unwanted frequency components up to ½ the 
sampling rate (Nyquist frequency). 

 

 

NOTE! 
Waveform compensation requires synchronous waveform data, which depends on a 
Phase Trigger association. 
 

11.3.15.3 Gap Compensation 

Gap compensation subtracts the selected reference gap voltage (e. g., taken in a stopped state) from 
the gap value readings before plotting. Gap compensation is used primarily with the Shaft Centerline 
plot. 
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11.3.16 Select a Compensation or Overlay Reference Sample 

Select the reference sample for compensation from the Reference Data pane. You can use different 
reference data samples for Slow Roll compensation, Waveform compensation, and Gap 
compensation. Note that only one reference sample can be active per compensation type at a time. 

 

 

Individual measurement values stored within a reference data table can be viewed and edited from 
the Reference Data Table. 

  

Highlighted options indicate that the 
given reference sample is selected to 
be used for a particular purpose (Slow 
Roll, Waveform, Gap, or Overlay 
Reference). 

Click a non-highlighted option to select 
a reference data sample for a particular 
purpose. 
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11.3.17 Pinning Plots 

Pinning a plot causes the plot to be displayed, regardless of which Plots are currently activated. Plot 
pinning is useful when you want to compare several specific plots, or for selecting plots for reporting. 

Pinned plots will change time range or time as the selected time or the dynamic cursor are changed, 
but they will retain the compensation and filtering settings that were active when the plot was pinned. 

To pin a plot, right-click the plot and click Pin Plot in the corresponding context menu: 

 
 

A pinned plot is displayed with pin icon in the upper right corner: 

 
 

To unpin (remove) a pinned plot, click pin icon. You can also use the Clear Pins button to clear all 
pinned plots with a single click. 
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11.3.18 Lock Time 

Right click and select Lock Time to freeze time for a given plot such that multiple plots for the same 
channel can be reviewed at different time instances. 

 
 
 

 

NOTE! 
The Lock Time function is applicable to Spectrum, Timebase and Orbit plots. 
 

 

In the following example, three graphs are locked at three different time instances, which are different 
from the fourth (unlocked): 

 
 

Click the Time Lock icon on a locked plot to unlock (remove) it. You can use the Clear Locks button 
to remove all locked plots with a single click. 
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11.3.19 Using Machine States and Manual States 

SETPOINT CMS can annotate plots with information about the state a machine was in when data 
sample was collected. Two types of states are supported: 

• Machine States determined by a VC-8000 rack during data collection 
• Manual States that can be added manually by the user 

 

 

NOTE! 
Machine States (or “rack-based states”) need to be licensed and configured from the 
VC-8000 Setup software. 
 

 

Both types of states are displayed in Small Trend and Large Trend plots when Data Annotations are 
activated. They are visualized in the States Bar at the top of the plot: 

 
 

Machine States and Manual States can be used simultaneously, for example to further annotate a 
data set that already contains Machine States. 

Some plot types can be colored based on the active state. 

States changes are listed on the Events Pane. This is useful for selecting a time range centered 
around an event of interest: 

  
 
  

Clicking on a Machine State or 
Manual State time centers the 
selected time range around the 
event time. 
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11.3.19.1 Machine States (Rack-Based States) 

Machine States are configured from the VC-8000 Setup software, including name and color. Unlike 
Manual States, they cannot be edited from within SETPOINT CMS. 

In the example below, the states “Stopped”, “Turning” “Running” have occurred sequentially on the 
same machine: 

 
 

If assets from more than one machine are selected, up to 2 rows of states can be displayed 
simultaneously. 

Measurements can have different alarm limits per machine state. When trending the alarm limits of a 
corresponding measurement, SETPOINT CMS will visualize these limits as a step function of the 
active Machine State: 
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11.3.19.2 Adding Manual States 

Manual States are useful for annotating relevant events during analysis. 

To add a Manual State, open the Small Trend plot and set the dynamic cursor time to the relevant 
time location. Then right click the Small Trend plot and click Add State from the plot context menu. 
 

  
 

In the corresponding dialog, you can define the desired Name, Description and Color associated 
with the Manual State can be defined. 

  
 

 

NOTE! 
A state marker can only be added to one selected asset (asset path defined with *).  
If there are more assets selected while adding, an error message will be shown. 
 

 
 
Please deselect all the other assets and retry adding a Manual State. 
If there is no asset path defined in the hierarchy, the state will be added under root 
node by default. 

  

First the set cursor to the 
location where you want to 
add the Manual State. 

Right clicking the plot and 
selecting Add State from the 
context menu will open the 
dialog. 

The dynamic 
cursor time is 
automatically 
assigned to the 
Manual State.  It 
cannot be edited 
from the dialog. 
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11.3.19.3 Edit or Delete a Manual State 

An existing Manual State can be edited or removed from Small Trend and Large Trend plots by right 
clicking the corresponding entry in the States Bar. 
 

 
 

Select Edit State to modify the Name, Description, or Color of a Manual State from the 
corresponding dialog. Note that the Time cannot be edited. 

 
 

Select Delete State to remove a Manual State. Note that this operation cannot be undone. 

  

Right click the Manual State 
in the States Bar at the top 
of the Small Trend or Large 
Trend to open the context 
menu.  
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11.3.19.4 Plot Coloring using State Based Display 

Machine States and Manual States can be used to color plot data based on assigned states. This 
allows vibration data to be displayed in context of the state of the machine state, which simplifies 
diagnosis. 

Activate State Based to activate state-based coloring of plots. This feature is available on Orbit, 
Timebase, Bode, Polar, Spectrum, Waterfall, and Cascade plots. 

Consider the example of a Bode plot that shows data recorded during the startup and the coast down 
phase of machine operation: 

 
 

In the above plot, it is difficult to distinguish which part of the data represents which phase. After 
adding Manual States for “Startup” (dark blue) and “Coast Down” (olive green) and activating  
State Based, on the other hand, the coloring clearly indicates which data belongs to which phase of 
operation: 
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11.3.19.5 State Filtering based on Machine States 

Machine (rack-based) states can be used to filter for data being displayed on Small Trend and  
Large Trend plots. This is useful to observe long term trends in machine behavior in the presence of 
spurious or misleading data that may have been recorded during non-relevant states of machine 
operation. 

Use the State Filter combo box to activate this feature. It shows a list of all Machine States that are 
present in the currently selected database. Note that this list can thus only contain Machine States 
that have been configured in the VC-8000 rack. Below, an exemplary configuration is shown: 

 
 

Selecting a Machine State from the provided list will remove Small Trend and Large Trend plots that 
is not related to the selected state. That is, the presented data will be filtered such that only data from 
the selected Machine State is being displayed. If Auto Scale is active, the plot Y-Axis will be updated 
accordingly. 

 

To return to the standard display, select the empty state filter option. 
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11.3.20 Error Messages 

SETPOINT CMS will show a red “X” error indicator if there is a problem presenting a plot. Hover over 
the “X” to see a description of the problem. In the example below, 2X filtering and compensation were 
turned on, but no reference sample had been selected for compensation: 

 
 

The following table lists common error messages and solutions: 

Error Description Action 

No Data There is no data in the database in the 
selected time range. 

Increase the selected time range. 

No Compensation The plot cannot be compensated because 
reference data is not set. 

Set a reference sample. 

The plot cannot be compensated because 
the data time and reference time are the 
same resulting in a null waveform. 

Move the dynamic cursor to a time 
different from the reference sample. 

Y and X Probes are 
not orthogonal 

The X and Y probes are not 90 degrees 
apart (less than 80 degrees or more than 
100 degrees) 

Adjust the probe orientation if possible. 
SETPOINT CMS software will 
automatically adjust the data for non-
orthogonal probes. However, errors 
increase the farther the probes are from 
90 degrees. 

  

Hover over the red X to see a 
description of the plot error. 
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11.4 Documenting 

SETPOINT® CMS has several ways to document the results of your analysis: 

• Copy and paste plots into another program 
• Export Trend data to a CSV file 
• Export all plots to a Microsoft Word document 

11.4.1 Copying and Pasting Plots 

Move the mouse pointer over a plot to activate the three-point symbol in the upper right corner. 
Click on the symbol to open a selection of further symbols. By clicking on the camera icon, a 
screenshot of the plot is created and copied to the clipboard. This function can be used, for example, 
to create reports. 

Alternatively, you can right-click anywhere to open the submenu with the selection of icons. 

 

 
 

Use the paste command (Ctrl-V) to paste the plot into another document. 
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11.4.2 Export Trend Data to .CSV File 

You can quickly export the trend data for the selected points and selected time range to a comma 
separated file for further processing or sharing using a program such as Microsoft Excel. 

From the File Tab, click Export and Export CSV Data: 
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When opened in Microsoft Excel, the path lists the point name. The timestamps, data values, data 
status, and speed values for each sample are shown in the following columns. 

 
 

 

NOTE! 
The default Excel time formatting does not show the hour. Click on the cell to see the 
full date/time or change the Excel cell format to “time”. 
 

  



 

Page 238 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

11.4.3 Exporting all Plots to Microsoft Word 

You can export all the currently open plots to Microsoft Word in one quick process. You can choose 
between one plot per page (landscape orientation) or two plots per page (portrait orientation). 

From the File Tab, select Export and Create Document: 

 
 

Set the document type to Word Document (.docx) and type in a file name. SETPOINT CMS will 
create the document with all the currently open plots. 

 

 

NOTE! 
If the export lists that errors occurred during the export, check your plots in SETPOINT 
CMS for error indications. 
 

 

 

NOTE! 
Limit the Large Trend plot to less than 10 traces for best export presentation. 
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12 Using the Removable SD card Media (VC-8000) 

When enabled, the eSAM can collect steady-state (static and dynamic) and transient data and store 
the data in files on the SAM SD card. You can open the .cmssd file and view the data using the 
SETPOINT® CMS display software without any networks or servers. 

 
The SD card is located at the top of the SAM module installed in slot 2 as shown below: 

 

 

IMPORTANT! 
To use the SD card functionality, the SAM must be enabled for the SD card, UMMs and 
TMMs must be CMS enabled, and the SD card function enabled in the VC-8000 
configuration. Refer to the VC-8000 Operation and Maintenance manual for information 
on enabling the SAM SD card functionality. 

 

  

SD Card 
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12.1 Card Types and Sizes 

SD 2.0 suitable to 32 GB. SETPOINT® recommend using 32 GB cards. 

Class 10 Speed rating, 10 MB/s or higher 

The SD card should be rated to the VC-8000 environmental ratings. SD cards should be Industrial 
Temperature Rated for -20 to +85 °C unless your rack is in a climate-controlled environment. 

 

 

IMPORTANT! 
Scan the card for viruses before inserting into the SAM. 

 

Industrial temperature SD cards are available in both SLC (Single Level Cell) and MLC (Multiple Level 
Cell) technology. SLC technology cards support more erase/write cycles than MLC cards but are 
considerably more expensive. For most applications, MLC cards will work fine. However, if you 
configure the rack to save waveforms at a high rate during steady state conditions then you should 
consider upgrading to SLC cards. 

12.2 Data Storage 

The amount of data stored and the time duration before the card fills and starts over-writing (FIFO) 
depends on several key factors: 

• The number of channels 
• Dynamic channels vs. position and temperature channels 
• The number of transient events 
• Boost mode 

While data storage can vary, the system will adapt (i-Factor ®) to the machine operating conditions to 
optimize the amount of stored data. 

12.2.1 Data Organization 

Data is stored in 50 MB blocks (before compression) in intervals no longer than 5 minutes. If the 
system records 50 MB of data in less than 5 minutes, the files will be closer together. 

12.2.2 Compression 

There are multiple levels of compression used to maximize the data storage on the SD card. 

12.2.2.1 Static Data Compression 

Using patented techniques, Setpoint adjusts compression levels according to the how the machine 
operation is changing and how much data has previously been stored under similar operating 
conditions.  
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12.2.2.2 Dynamic Data Compression 

Dynamic Data is compressed using the various techniques listed in this section. 

i-Factor 
If the UMM detects that the signal has not changed since the last waveform sample stored it will 
discard the waveform. Waveforms are stored based on a calculated “interestingness” in comparison 
to the last stored waveform. CMS will automatically adjust the i-Factor data collection rate during 
steady state conditions to optimize the data storage. 

Boost Mode 
Boost mode data is collected and stored continuously and is not compressed. Boost mode should be 
limited to infrequent, short transient intervals such as fast startups and coast downs. If the speed 
stops changing while still in the transient range the UMM will exit boost mode until it begins changing 
again. If the buffer in the UMM fills up it will exit boost mode and resume normal collection until the 
data are transferred to the SAM and a certain percent of the buffer empties out. 

Delta RPM 
For machines that startup or coast down slowly, delta rpm waveform sampling allows a waveform to 
be published at set speed changes.  If no other waveforms (> I-ness) have been published during the 
configured periodic interval, the most interesting waveform (to the defined speed changes) for that 
interval is published. 

Delta Time 
The Delta Time set in the UMM configuration sets a maximum amount of time that expires between 
saving waveforms. If no other waveforms have been saved during the configured periodic interval, the 
most interesting waveform for that interval is saved. Note that since the most interesting waveform is 
saved, the interval between saved waveforms can be double the configured interval if the first 
waveform of one interval is saved and the last waveform of the next interval is saved. Set the  
Delta Time to a longer time to extend the SD card storage time. 

12.2.3 Overwriting 

When the SD card fills the system will overwrite the data (FIFO), overwriting the oldest data first in  
50 MB blocks. The SAM OK LED will blink green on/off when the card is full. Only cms files are 
overwritten. The system will not overwrite other files stored on the card. 

 

 

NOTE! 
To maximize data storage, remove any non-CMS files stored on the card. These files 
will not be overwritten and will reduce the available storage. 

12.3 Enabling 

The SD card data collection and storage requires CMS enabled UMMs or TMMs to collect the data 
and an SD card enabled SAM. Order enabler keys at the time of purchase or contact  
Brüel & Kjær Vibro Services to upgrade existing racks. 
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12.4 SD card Status 

You can verify correct SD card operation from the front panel display, from the SAM LEDs, or from 
Modbus status registers. 

12.4.1 SD card Status on Display and LEDs 

The SD card status is shown using the SAM OK LED. You can use the LED indications to see the SD 
card status if your system does not have a display. The display indication and OK LED patterns below 
will only occur when the SAM is enabled for SD card data storage. 

Display 
Indication 

OK LED 
Color Pattern 

Indication 

SD OK Solid Green 
 

The card is installed, the system is correctly collecting data, and the 
card is currently not being written to. It is safe to remove the card. 

SD Full Blinking Green 
 

The card is installed, the system is correctly collecting data, but the 
card is full, and the oldest data is being overwritten. The card is 
currently not being written to. It is safe to remove the card. 

SD Busy Blinking Green/Amber 
 

The card is installed, the system is correctly collecting data, the card 
is currently being written to. Wait until the blink pattern returns to 
solid or blinking green before ejecting the card. 
 
The LED will also blink this pattern when the UMMs have buffered 
Boost Mode data and is spooling this data to the SAM for writing to 
the SD card. 
 
The SD Busy indication on the display shows a progress bar for data 
moving from the UMM to the SD card. If the background is showing 
partially blue, there is data still in the UMMs waiting to be written to 
the card. 

No SD Solid Amber 
 

There is no card installed or the system is rebooting, and the system 
cannot detect the card. Wait for the system to finish booting and 
verify a card is inserted.  

SD Fail Blinking Red 
 

The system cannot write to the SD card. This may be because the 
SD card is corrupted, unformatted, or has write-protection on. 
Replace the card with a valid card. 
 
The LED will also blink red if a front panel firmware upgrade from the 
SD card fails. Remove the card and replace with a card with a good 
firmware file or no firmware file to abort the upgrade. 

N/A Solid Red 
 

They system has failed and is not collecting or storing data. 
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12.4.2 SD Card Status via Modbus 

The SD card statuses are located in the Modbus Map at registers 12445 and 112445. Refer to the 
VC-8000 Operation and Maintenance Manual S1079330 for more information on Modbus. 

In addition to the statuses shown on the display, Modbus also provides a SD Card Locked status 
which indicates if the card write enable switch is on or off. 

12.5 Removing the Card 

The SAM processor periodically writes data to the SD card. Removing the card while the processor is 
writing data can cause loss of the 50 MB (five minute) file currently being written. The write cycle 
typically lasts 20 seconds. When writing, the display shows the SD card as “SD Busy” and the  
SAM OK LED will be alternately blinking green and amber. When the write cycle is complete the 
display will show “SD OK” or “SD Full” and the SAM OK LED will return to either solid green or 
blinking green on/off. 
You can install an SD card at any time. 

 

 

IMPORTANT! 
Removing the SD card while the system is writing data can cause loss of the last 50 MB 
or 5 minutes of data. Wait until the SD card is not busy before ejecting. 

 

 

WARNING! 
In hazardous locations do not eject or insert the SD Card unless the environment has 
first been proven safe. 

12.6 Copying Card Data 

You can copy the files and folders from the SD card directly to a computer hard drive. There will be a 
file named <RACK NAME>.cmssd and a folder <RACK NAME>. Copy both of these. Log files or 
other information on the card is not required. You can merge new data into the same folders with data 
previously collected on the same rack as long as the rack configuration has not changed. 

 

 

NOTE! 
If the rack configuration has changed, copy new data into a different location. Do not 
merge the data folders. 

 

 

NOTE! 
Depending on your computer and the amount of data on the SD card, it can take a long 
time to copy to a computer. Best practice is to replace the card when it is removed so 
that data collection continues. 
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12.7 Viewing Card Data 

To view the data on the SD card, insert the card into a computer. You can view the files directly from 
the SD card or copy the files to a local folder. When opening the files, the CMS Display will 
automatically find and concatenate all of the 50 MB (5 minute) .cms files in the folder. You can use 
CMS to analyze the full range of time saved. 

Open the SD card data from the File Tab, Open File, with the file type CMSSD. 

The file will open with the selected time range set to the last hour on the card. 

12.8 Configuration Changes 

The SD card data only supports one configuration. If you are changing your VC-8000 configuration, 
eject the SD card and copy all the files before changing the configuration. Insert an empty SD card 
after downloading the configuration changes to the VC-8000 rack.  

12.9 Using the SD card for Data Collection Redundancy 

When enabled, the SAM can store data to the SD card simultaneously while spooling the data to a  
PI Server. This provides a level of redundancy in the event of a network failure in that critical data is 
still available on the SD card. 

12.10 Backfilling SD Card Data into a PI Server 

Refer to Section 15 for information on backfilling data stored on an SD card into a PI Server. 
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13 CMS-XC Data Storage on a Local Computer 

The SETPOINT® CMS-XC option spools CMS data files to the storage drive on a computer without 
requiring a local PI Server. This feature is useful for: 

• Applications where a local PI Server is not practical. 
• Backing up the data sent to the PI Server. 
• Portable or temporary data acquisition. 

 

Figure 48 shows a CMS-XC installation where a PI Server local to the machine is not practical. The 
CMS-XC computer provides a large data storage drive and the necessary security software required 
for connection to the Wide Area Network (WAN). 

 

 
Figure 48:  CMS XC on a WAN 

 

The CMS Display can connect to the CMX-XC computer and view the data files in the same way as 
connecting to a PI Server. 
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Figure 49 shows a CMS-XC computer serving as a backup to the local PI Server. CMS-XC stores all 
data from the VC-8000 rack on a local drive. If there is a fault on the either the Local PI Server or a 
remote Main PI Server, the CMS Display PC can still view the SETPOINT® data stored on the  
CMS-XC computer. 

 

 
Figure 49:  CMS-XC Backing up a PI Server 

 

 

NOTE! 
CMS-XC only backs up data collected by the VC-8000 racks and does not back up 
process data in the PI Server collected from other instrumentation. 

 

13.1 Configuring a CMS-XC Computer 

Configure the CMS-XC computer using the SETPOINT® Connector Setup software. 
See Section 8.1.2 for information on configuring the XC computer storage locations and folder 
names. 
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13.2 Configure Windows Remote User Access 

You must give remote users Windows security access to the CMS-XC data. Follow the instructions in 
this section to configure CMS-XC access for individuals or groups of users. 

 

 

NOTE! 
Install SETPOINT® Connector before performing this step. SETPOINT® Connector will 
automatically create the “Setpoint Remote Users” group. 

 

Configure the users from the Windows Computer Management. 

 
Alternatively, you can open the Computer Management dialog from Control Panel by selecting 
Administrative Tools and then Computer Management. 
The Computer Management dialog will open: 

 
  

Open the Computer Management 
dialog from the Windows Start menu 
by right clicking on Computer and 
then selecting Manage. 

In the Computer Management dialog, click  
Local Users and Groups, and then Groups in the Name Pane. 
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Add user names under object names and click OK. You will need to enter each user that will access 
the XC database. Alternatively, you can give access to all domain users for a specific location using 
the Domain Users object as shown in the following picture: 

 

13.3 Configuring the Network Firewall for CMS-XC 

To allow remote access to the CMS-XC data (see Figure 48 and Figure 49), you will need to have 
Firewall ports 8001 and 8002 open. 

13.4 Backing Up CMS-XC Data 

Brüel & Kjær Vibro recommends backing up CMS-XC data folders. There are many ways to do this. 
Contact your Information Technology department or Brüel & Kjær Vibro Services for backup solutions. 

  

Right click the Setpoint Remote 
Users group and select  
Add to Group. 



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 249 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

13.5 Viewing Old CMS-XC Data Files 

When you connect to a computer running CMS-XC the open database view will only show racks that 
are currently configured in SETPOINT® Connector. If you have changed the rack name or removed a 
rack from SETPOINT® Connector, you can still view the data in the CMS Display. CMS-XC data uses 
the same format as CMS-SD data, and you can open the cmssd files from the File Tab. 
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14 CMS-HD Data Storage in the Rack 

CMS-HD uses an internal solid-state drive (SSD) to store static and dynamic data. Depending on the 
SSD size purchased and the configured data collection rate the SSD can store months or even years 
of data. 

You can connect a computer Ethernet cable directly to the CMS port on the front of the SAM module 
or you can access the HD data via a network as shown in Figure 50. 

When connecting a computer directly, you do not need a crossover cable or switch. The SAM will 
automatically detect the cable and adjust accordingly. You will need to verify that your computer  
IP Address is configured for the same subnet as the CMS port. 

 
Figure 50:  CMS HD Network 

 

IMPORTANT! 
The SETPOINT® rack CMS port is not designed to be placed on an exposed network. 
If the network is accessible externally use the CMS-XC solution. 

 

 

NOTE! 
The CMS HD feature requires the SAM to have a password configured. 
Refer to the VC-8000 Operation and Maintenance Manual S1079330. 

 

 

IMPORTANT! 
The CMS-HD storage drive will overwrite old data when it is full. Periodically copy the 
HD database to a computer or save important reference data in a .cms file. 
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14.1 Configuring HD Storage 

SETPOINT® HD does not require configuration. HD enabled hardware will automatically store 
condition monitoring data from CMS enabled monitoring modules. 

14.2 Monitoring HD Storage 

The SETPOINT® CMS system can create a very large amount of data. Eventually the HD storage will 
fill and automatically begin to overwrite the old data (FIFO). To prevent loss of important data, 
periodically save the HD database on a further storage medium or view and save important data from 
SETPOINT® CMS. 

The SETPOINT® control panel display on the rack (or the Software Setpoint Maintenance) provides 
basic information on the HD storage which you can use to determine when to upload and save data. 

Refer to Section 16.5 for information on verifying data storage rates. 

14.3 Copying HD database to a Local Drive 

Refer to Section 15.2. 
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14.4 Automatically Backfilling HD Data into a PI Server 

You can configure SETPOINT® Connector to automatically backfill data from SETPOINT® HD into 
your PI Server in the event of network communication failure (see Section 8.2 to enable or disable). 

When the backfilling option is active, SETPOINT® Connector checks for SETPOINT® HD data not 
already in the PI Server when: 

• The SETPOINT® Connector Service is first started 
• When communication to the VC-8000 rack is restored after being lost. 

 

 

NOTE! 
Backfilling does not apply PI Compression for points that already contain data in the  
PI database. Backfilled data may store more samples than when online. 

 
 

 

IMPORTANT! 
Backfilling large amounts of data can severely stress a PI Server. If your PI Server also 
performs critical plant operations that cannot be interrupted, consider disabling the 
backfilling option and backfill manually (See Section 15) at a convenient time. 

 
 

 

NOTE! 
Backfilling does not import data prior to when the rack was added in the  
SETPOINT® Connector. Follow the instructions for importing a dataset  
(See Section 15) for migrating SETPOINT® HD data stored in the rack prior to 
connection to a PI Server. 
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15 Uploading SD, XC, or HD Data into the PI System 

You can upload machine data stored on the SD card, stored in an XC database, or stored on the 
internal solid-state drive into a PI System. This feature is useful for: 

 

• Racks that cannot be connected to the network. 
• Data collection from portable racks 
• Racks collecting data before the PI System was installed. 
• Data stored during network outages 

 

SETPOINT® Connector will automatically create any points that exist in the SD, XC, or  
HD database but do not already exist in the PI database and allocate PI Tags as required. 

 

 

NOTE! 
If the rack name already exists in the PI-AF database, SETPOINT® Connector will 
merge the uploaded points under the existing rack. Set a unique rack name for each 
SD, XC, or HD rack if you need the data separated. 

 
Uploading data to the PI System involves these steps: 

1. Create new PI Archives (if required) 
2. Export XC or HD data to be uploaded to a local drive. 
3. Upload the data into the PI System. 
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15.1 Creating PI Archives 

If the data stored on the SD card, XC database, or HD database predates the PI System, you will 
need to create PI archives in which to store the data. Follow the steps in this section to create  
PI archives.  

To create an archive:  

In PI System Management Tools, open the Archives plug-in. 

 
The Create New Historic Archive dialog will open: 

 

3. Select Create a New Archive. 
(or right-click and select Create 
New). 
  

1. Chose the Server  

2. Navigate to Operation, Archives 
  

Select Create archive with 
fixed start and end time. 
 
For Start Time, enter a time 
equal to or earlier than the oldest 
timestamp for data to be 
backfilled. 
 
For End Time, enter the start 
time of the oldest current 
archive. 
 
Select Dynamic as the archive 
type.  
 
Click OK to create and register 
the archive. 
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15.2 Exporting an HD or XC CMS Database 

If the data is stored in CMS-XC or CMS-HD files, you need to export the data to a local database file 
before uploading into the PI System. 

 

 

NOTE! 
The Export CMS Database option will only be active if you are currently connected to a 
CMS HD or CMS XC database. 

 

 

NOTE! 
The Export CMS Database option will export data only for the currently selected points 
and time range. Be sure to select the points and set the time range before exporting. 

 

 

 
The export process will require you to specify a location to store the database. 
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15.3 Uploading XC or HD data in the PI System 

 
 
  

Set the location of the CMS SD 
database or location where CMS XC 
or HD data was exported. 
 
PI Server, AF Server, and  
AF Database fields will auto-fill 
according to the PI System Settings. 
 
Click OK to upload the data into the 
PI System. 
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16 Verification 

This section lists ways to verify the data flow between the VC-8000 rack and the database  
(PI System, XC, SD, or HD). 

16.1 Verifying Connection to SETPOINT® Connector 

To verify that the VC-8000 rack is properly connected to SETPOINT® Connector and the system is 
collecting data, open the SETPOINT® Connector Setup program and verify that the rack status is 
“Collecting”. 

 

16.2 Verifying Data in the PI System Database 

PI System Explorer provides tools for verifying the data stored in the PI System Database. Follow 
these steps to verify SETPOINT® data in the PI System Database. 

Open PI System Explorer. PI System Explorer will be listed under the PI System folder: 

 
  

Verify that SETPOINT® Connector is 
collecting data from the rack. 
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2)  Click the Database button.  A window 
will open where you can select your  
AF Server and AF Database.  

3) Expand the Elements to get to the 
measurement you want.  

 4) Select the Attributes tab. 

5) Right click the data value and 
select Time Series Data. 
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The Time Series Data window will open. Setting the End Time to “*” causes the time range to end at 
the current time. Setting the Start Time to “*-8h” sets the range to start 8 hours earlier than the 
current time. Click the Refresh button. The Time Series Data window shows the number of samples 
stored in the PI System in the time range and a plot of the data values. 

 

 
 

  

Set the Start Time and End Time and 
click the Refresh button. 

View the number of samples stored in 
the PI System database and a plot of the 
samples. 
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16.3 Forcing a Waveform Sample 

Under normal operating conditions, SETPOINT® will automatically collect waveforms on detected 
changes in machine state. There may be times, such as when you are verifying system operation, 
when you need to force the system to record a waveform and store it in the database for immediate 
viewing. 

To force a waveform, open the VC-8000 Maintenance application and navigate to the  
Firmware Upgrade view (see Manual S1079330 VC-8000 Operation and Maintenance Manual).  
In the Firmware Upgrade view, click the Boost button as shown. 

 

 

16.4 Data Annotations 

The Data Annotation function provides information about when SETPOINT® collected waveforms and 
how interesting the machine data is. Data Annotations are useful when troubleshooting waveform 
collection. Activate Data Annotations from the View Tab. 

  

Clicking the Boost button causes the 
SETPOINT rack to collect and store a 10 
seconds of boost mode waveforms for 
the selected channel. 
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16.5 Verifying Data Storage Rates (VC-8000) 

You can verify the rate at which the system is currently sending data to the database. 

 

From the front panel display or the 
Setpoint Maintenance software open the 
rack view.  Click the SD, HD, or CMS 
buttons on the SAM to see information 
on data collection rates and storage.  

For SD and HD, the details view 
shows this information: 
 
Storage write rate.  This is the 
amount of data being written to 
the storage device per second 
and is also displayed on the bar 
graph.   
 
The Data Start is the oldest data 
stored since the last export. 
 
The Data End is date of the most 
recent data stored. 
 
Capacity:  The installed storage 
device size. 

For networked connections to a 
PI System or Setpoint-XC view the 
CMS details. 
 
Data rate indicates the network 
data bandwidth usage. 
 
Adapter shows the status of the 
SETPOINT® Connector. 
 
Link shows green if there is a valid 
Ethernet connection to a 
SETPOINT® Connector. 
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IMPORTANT! 
Data storage rates will vary greatly depending on whether the machine is in steady-state 
or transient conditions. 

 

Click the More button on the details view to see more storage statistics. For SD and HD, the view 
below will show: 

 
These values show: 

HD Write Rate:  The rate at which data is being written to the HD storage device. 

HD Available Free Space:  The unused space on the HD storage device. 

 

 

NOTE! 
The HD storage device is not erased when data is exported. Old data will remain on the 
HD storage device until it is filled at which time the old data will be overwritten. When 
the HD Available Free Space is 0, new data is still being stored but old data not 
previously exported is being lost. 

 
HD Read Rate:  The rate that data is being read from the HD storage device. In most cases this will 
be very low unless a user is connected to the HD device with the SETPOINT® CMS display software. 
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For CMS connections to a PI System or CMS-XC system the following view will show: 

 
 

These values show: 

Ethernet Send Rate:  This value indicates the amount of network bandwidth being consumed by 
outgoing messages. Since this value is measured before data compression done by the PI System it 
is not necessarily indicative of the amount of data being stored on the PI Server. 

Ethernet Received Rate. This value indicates the amount of network bandwidth being consumed by 
incoming messages. The Ethernet Received Rate will increase when a user is requesting data from 
the HD through the SETPOINT® CMS software. 

Adapter Status:  The overall SETPOINT® Connector status. When green, SETPOINT® Connector is 
operating correctly. If yellow, one or more SETPOINT® Connector connections (PI System or CMS-
XC) have failed. 

Link Status:  When green the rack is correctly communicating with the SETPOINT® Connector. 
When yellow, the rack cannot communicate with SETPOINT® Connector. This may be due to physical 
network problems or problems with the SETPOINT® Connector. 
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17 Maintenance 

In general, SETPOINT® CMS database maintenance is similar to maintaining any other  
AVEVA™ PI database. Refer to AVEVA™ PI System™ manuals and videos. This section lists 
maintenance specific to SETPOINT® CMS. 

17.1 Monitoring the Database Size 

Use PI System Management Tools for viewing and managing the database. Go to Operation, 
Archives to see a list of the archive files the PI system created. 

 

 
 

From the list, you can see that from October 19th 2013, to November 19th 2013 server DEMONET_PI 
stored 31 archive files of 256 MB each. Total storage rate for this system is approximately 8 GB per 
month. Since this system has 1.74 TB of available storage, under similar operating conditions this 
system would take approximately 18 years to fill the hard drive. In this case, no action is required. 

 

 

NOTE! 
SETPOINT® CMS collects much more data during transient machine conditions than 
steady state. Monitor your database more often when machines are changing states. 
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17.2 Archive Backup 

Refer to AVEVA™ documentation for best practices on backing up your data archives. 

17.3 Adjusting Compression 

You can adjust the PI Server data compression to increase or decrease the amount of stored data. 
The default compression settings are set to the typical noise floor of the sensor type and resolution of 
the signal processing. 

If your machine frequently changes operational conditions with a process that results in frequent 
starts and stops, you may want to increase the compression levels to avoid collecting excessive data. 

CMS automatically reduces compression during transient speed conditions. AVEVA™ has several 
excellent videos on the Internet explaining how to adjust the compression settings and how PI data 
compression works. 

Brüel & Kjær Vibro Services also can help with adjusting compression settings. 
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18 Troubleshooting 

18.1 Plot Messages 

SETPOINT® CMS will print a message across the plot if there are problems with the data. The 
following table gives a description of the problem and suggested corrective action. 

 
Table 15: Plot Error Messages 

Error 
Message 

Description Corrective Action 

No Data Data necessary for the plot type does not exist in the 
selected time range. 

Change the time range to 
include data. 

Invalid Data 
The data is invalid. This may be caused by a range check 
error, a speed error, or the speed or amplitude are too large 
or small to calculate the value. 

Verify that the synchronous 
sample rates were set 
according to Table 9. Check 
transducer wiring. 

Y and X probes 
are non-
orthogonal 

The probe orientations are not configured with X following Y 
by 90 degrees in a clockwise direction. 

Fix the probe orientation 
configuration so that the 
probes are 90 degrees apart. 

No 
Compensation 

Compensation is active but no valid compensation vector or 
waveform is set for the point. Note that for plots using 
waveform data, the compensation waveform must not be 
identical to the compensated waveform. 

Select a reference data 
sample for compensation. 

Too many 
waveforms in 
range 

Waveform ticks are activated and the currently selected 
time range contains more than 500 collected waveforms 
(per channel and per waveform type). The number of 
displayed ticks has been limited because extremely large 
numbers of waveform ticks can significantly affect 
performance. 

Deactivate waveform ticks 
during regular operation. 
Only activate waveform ticks 
for diagnostic purposes.  

18.2 Data Collection Problems 

There are a variety of installation and configuration problems that can affect data collection. This 
section lists some of the most common problems and solutions. Contact Brüel & Kjær Vibro Service 
for additional troubleshooting information. 
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Table 16:  Troubleshooting Data Collection Problems 

Problem Possible Causes Actions 

SETPOINT® Connector 
fails to connect to rack 
 

Ethernet Wiring Problem Verify the link and activity lights at the rack and 
server. 

Incorrect Firmware Revisions 
Verify that all firmware revisions are new enough 
to support CMS. See Table 4:  SAM Firmware 
Revision for Function. 

Network IP Address Incorrect 

Verify that the SAM IP Address is on the same 
subnet as the computer running SETPOINT® 
Connector (see Section 7.1). Use Ping 
command to verify communication. 

SETPOINT® Connector 
does not show “PI 
System” tab 

AVEVA™ AF Client is not 
installed. 

Verify that PI AF Client is installed with version at 
least PI AF Client 2012 (2.5.0). Recommended 
version is latest release from AVEVA™. 

SETPOINT® Connector 
does not show option to 
backfill data 

AVEVA™ AF Client is not 
supported 

Verify that PI AF Client version is at least PI AF 
Client 2017 R2 (2.9.2). Recommended version is 
latest release from AVEVA™. 

SETPOINT® Connector 
does not show option to 
enable Spectral Bands 

AVEVA™ AF Client is not 
supported 

Verify that PI AF Client version is at least PI AF 
Client 2018 R2 (2.10.5). Recommended version 
is latest release from AVEVA™. 

SETPOINT® Connector 
cannot connect to PI 
server 

Server not running 
Restart the PI server. 

SETPOINT® Connector 
fails to build AF hierarchy 

Not enough PI Tag licenses 
available 

Verify that you have enough PI Tag licenses 
(Refer to AVEVA™ documentation). 

No PI Tags allocated 

Asset Path not filled in Assign asset paths to the channels. 

Channels are not on. Verify the channels are turned on. 
 

No data collected 

SETPOINT® Connector service 
not running 

Verify SETPOINT® Connector service is running 
and collecting. 

Module is not enabled. Verify that the monitor module is CM-Enabled. 
See Section 3 

 Incorrect Rack Time 

Verify the rack time and time zone are set 
correctly (see Manual S1079330). If the rack time 
is incorrect, the rack may be trying to store data 
in the future or distant past in relation to the set 
server time. 

Cannot connect to server 
from the CMS Display 
software 

Server not connected to 
network 

Verify that the server computer is connected to 
the same network as the client computers and 
configured with a valid network IP address. 
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Problem Possible Causes Actions 

No Orbit, Time-base, or 
Spectrum data in selected 
time range 

Machine is not changing, or 
Delta Time set too long. 

Adjust the Delta Time. 

Machine is running very slow. 
Wait for the waveform collection to finish. A 
waveform at 3 rpm can take over 5 minutes to 
collect. 

No Spectrum Data Spectrum set for Full Spectrum, 
but a single channel selected. 

Change to half spectrum or ensure that the 
selected level includes channel pairs. 

No Orbit or Time-base 
Data 

Phase Trigger not assigned 
Phase Trigger not triggering 

Verify the phase trigger configuration. 

No new data collected The client is connected to an 
old database. 

Verify SETPOINT® Connector and the Client are 
using the same PI Database. See Sections 
10.1.1 and 8.1 
Verify the system is time synchronized. 

Cannot save reference 
data. 

Insufficient permissions to the 
database. 

See Section 6 for information on setting 
database permissions. 

Excessive data collected 

Loose sensor wire or failing 
sensor. 

Fix the sensor or temporarily Increase 
measurement I-Factor %. (See Section 7.3.2) 
until the sensor is fixed. Turn on Adaptive I-
Factor. 

Machine continually changing 
measurement levels 

Increase measurement I-Factor %.  
See Section 7.3.2. 
Turn on Adaptive I-Factor 

 

Figure 51: Verifying Channel is Active  

Verify Channel On checkbox is checked. 

Verify the Channel is associated with a 
Phase Trigger if applicable. 

Verify the configuration was sent. 
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18.3 Display Problems 

Table 17: Troubleshooting Display Problems 

Problem Possible Causes Actions 

3-D Plots display as black 
rectangles 

Computer graphics card does not 
support the 3-D graphics. 

Upgrade graphics card. Contact 
Brüel & Kjær Vibro Services for 
information. 

Add Database is grayed out on the 
Open Database screen. 

PI AF Client software is not 
installed. 

Install a compatible version of 
AVEVA™ PI AF Client software. 

Data sources are missing after a 
software upgrade. 

Preferences not migrated from 
legacy “Metrix” folder to 
“Setpoint” folder. 

Copy files from C:\Users\<User 
Name>\AppData\Roaming\Metrix\ 
Setpoint\CMS to 
C:\Users\<UserName> 
\AppData\Roaming\Setpoint\CMS 

Plots take a long time to display 

Insufficient memory available. Close other applications that may be 
using large amounts of memory. 

Very large number of waveforms 
is slowing the system when 
showing data annotations.  

Turn off Data Annotations and 
Waveform Tick marks. 

Cannot set reference data. User does not have proper 
database permissions. 

Assign permissions per Section 6. 

Spectrum plot is (not) displayed in 
orders of running speed 

Spectrum set for Orders of 
Running Speed but no 
synchronous waveform 
configured, or vice versa. 

Add synchronous waveform or add 
asynchronous waveform to channel 
configuration. 

Plot appears blank Manual scaling set too small or 
large. 

Try auto-scale, if plot appears, adjust 
the manual scale. 

All plots are blank Bookmark opened for a server 
you are not connected to. 

Return to the Home screen and log 
into the server which has the 
bookmarked data. 

 
  



 

Page 270 of 278 © Brüel & Kjær Vibro ● S1176125.002 / V15 
  

EN  
 

  

UNRESTRICTED DOCUMENT 

19 Additional Functions 

AVEVA™ PI supports many additional functions such as: 

 

• Notification 
• Rules 
• ERP 
• CMMS 
• Exporting 
• OPC 

 

Contact AVEVA™ for more information. 

  



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 271 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

20 Appendix 

20.1 PI Vision Integration 

20.1.1 Launching SETPOINT CMS Display from PI Vision 

You can add a symbol to your PI Vision to launch the SETPOINT CMS Display Application and open 
with data for the selected and specific plots. 

• (CMS-Button is missing – See here to install) 
• Go to a PI Vision display.  
• Open the Asset-Toolbar and select the corresponding plant. 
• Navigation to an Asset and <Quick View> Attribute is presented under <Attributes> section. 
• Set the Component to the usage of CMS-Button. 
• Then drag the Attribute <Quick View> to the Display and drop the CMS-Button. 

 
 

Now when the link is selected it will navigate to the previously created CMS quick view display. 
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20.2 Using SETPOINT CMS in Parallel with an Existing Rack 

You can use the VC-8000 rack in parallel with an existing rack in order to collect condition monitoring 
data into SETPOINT® CMS while leaving the existing machine protection system in place. Refer to 
the VC-8000 Operation and Maintenance Manual (S1079330) for information on how to set the 
channel inputs for connection to buffered outputs from another rack. 

20.3 Using CMS with one VC-8000 Rack and Different Assets 

Test stand and portable diagnostic applications may require using the same VC-8000 rack for data 
collection on different machine assets. SETPOINT® CMS has tools for managing your data and racks 
when collecting data for test runs on different assets or for different jobs. When using test runs, CMS 
starts and stops multiple VC-8000 racks synchronous and also allows you to assign security 
permissions to the various test run datasets to control access. 

20.3.1 Enabling Test Runs 

Open the SETPOINT® Connector Setup utility. From the File menu, select Options and check 
Enable Test Runs to enable test run data collection. The play and pause buttons will move to the 
header and apply to all racks. 
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20.3.2 Set the Root Path 

CMS prefixes the machine asset hierarchy with the Root Path providing an easy way to find data 
collected for a specific machine using the same rack. For example, you can categorize data by 
customer name or machine serial number by changing the root name. 

 

  
 

The syntax is the same as for the machine asset hierarchy. 

 

 

NOTE! 
It is easier to find test runs if the name appears on the CMS home screen. When 
configuring the machine asset hierarchy, it is generally better not to place an asterisk in 
the VC-8000 hierarchy. Instead, place an asterisk in the Root Path node. 

 

  

With recording stopped, change the 
Root Path, then toggle the Record 
button to start recording data with the 
new path.  
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20.3.3 Starting and Stopping the Data Collection 

Each time you start data collection, CMS will record a new test run event. 

 

 
 
 

 

NOTE! 
You must place an asterisk in the Root Path name and start data collection for the new 
Root Path to show up on the CMS home screen. 
 

 
 

 

NOTE! 
If you are already collecting data and change the Root Path, CMS will immediately start 
collecting data under the new name after you click Record. 
 

 
  
  

Click the Record button to 
toggle between recording and 
stopped modes.  The mode 
applies to all listed racks.  
 



 

© Brüel & Kjær Vibro ● S1176125.002 / V15 Page 275 of 278 
 

Brüel & Kjær Vibro │ Instructions 
 SETPOINT Condition Monitoring Software  EN 
   

UNRESTRICTED DOCUMENT 

20.3.4 Navigating to Test Run Data 

You can navigate to test runs from the File Tab. If test runs are enabled and there are test runs 
completed, the Open Database view will show a test run column. Click on the test run icon to open 
data for that test run. 

 

 
  

Click a test run to open the analysis view 
with data from that test run. 
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20.4 File Extensions 

Table 18:  SETPOINT® File Extensions 

File extension Description 
.set SETPOINT® 

VC-8000 Configuration + diagnostic in a single file type but can be opened by either VC-
8000 maintenance or VC-8000 setup SW. If you open a file containing only configuration 
information, the maintenance software will indicate that no diagnostic information is 
available, such as when creating a configuration on your laptop before connecting to a 
physical rack – or a legacy configuration file where diagnostic information was not saved. 

.setk SETPOINT® KEY 
VC-8000 CM-Enabler key(s) 

.cms Condition Monitoring Software  
A single file containing CMS-formatted data.  Cannot contain more than 7 days. Saves 
data only for the selected channels or assets. 

.cmssd CMS Storage Directory  
Used with CMS-SD, CMS-HD, and CMS-XC to point to directory containing unformatted 
CMS data.  Individual unformatted files use a variety of extensions and cannot be opened 
and read by CMS Display directly.  They are meant to be opened as groups of files via the 
.cmssd extension.  Unlike 7-day limit on .cms files, .cmssd has no limit on number of days 
spanned. 

.cmsdb CMS Data Base 
Same as .cmssd. The extension was changed to show that these files are not limited to 
CMS-SD but are also used for CMS-HD and CMS-XC. Cmsdb files include all channels 
and assets in the database regardless of the currently selected channels or assets. 

.met METRIX 
Tied to Metrix heritage. This same .met extension was used for configuration and 
diagnostic files. Configuration files can only be opened using the VC-8000 Setup 
software, diagnostic files can only be opened from the VC-8000 maintenance software. 
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21 Glossary 

Term Definition 

Asset Path The hierarchy from the point up though the asset tree. For example: 
PLANT\TRAIN\CASE\BEARING\CHANNEL 
Configure the asset path in the VC-8000 Setup software. 

Asynchronous 
Waveform 

Dynamic waveforms samples collected at a fixed sample rate regardless of machine 
speed. 

Attribute 
 

An attribute is a PI AF component that describes a property of the parent element. 
For example, a measurement may have a danger set point attribute. Attributes can 
be assigned to any level in the asset path hierarchy. Attributes are not trended by the 
PI System unless they are mapped to tags so will only show the current value when 
they are read. SETPOINT® CMS reads the attributes when opened. If attributes are 
changed in PI AF, you must close and reopen SETPOINT® CMS. 

Boost Mode 
 

An operational mode which causes CMS to collect data continuously during transient 
events. Enable or Disable Boost mode from the VC-8000 Setup software. 

Dynamic Data Dynamic data includes synchronously and asynchronously sampled data streams 
used for plotting Orbit, Timebase, and Spectrum plots. 

Full Spectrum Plots the complex spectrum using signals from a pair of orthogonal transducers. The 
full spectrum shows the signal amplitudes of the forward and reverse precessing 
components as a function of frequency and is essentially the spectrum of an orbit. 

Half Spectrum Plots the signal amplitude as a function of frequency from a single transducer. 

Precession Precession is a change in the orientation of the rotational axis of a rotating body. For 
machinery, this is the motion of the rotor geometric center in the plane perpendicular 
to the rotor axis. Precession can be in the direction or rotation (forward precession) 
or against the direction of rotation (reverse precession). 

Static Data Static data includes filtered and processed samples used for Trend, Bode, Polar, 
Shaft Centerline, and Data Table plots. 

Synchronous Waveform A dynamic waveform sample collected in fixed intervals of phase over each machine 
revolution. For example, a synchronous waveform collected at 128 samples/rev will 
take a sample every 2.8125 degrees of rotation. 

Vector A machine vibration component having both a magnitude and a phase angle. The 
phase angle is the measured phase lag from a Phase Trigger event to the magnitude 
peak. Vectors are typically described in relation to the machine running speed: 1X = 
synchronous to the machine running speed, 2X = synchronous to twice the machine 
running speed, nX where n is a variable value. Vector data is used to for Bode, 
Polar, Filtered Orbits and Timebase plots. 

XY Pair Two transducers mounted 90 degrees apart (orthogonal) at the same machine 
location measuring the vibration in two planes. SETPOINT® will treat UMM channels 
1, 2 and 3, 4 as channel pairs for Orbit, Full Spectrum, and Shaft Centerline plots 
when they are both configured as Radial Vibration. 
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